
USER GUIDE  

MADCAP FLARE 2023 r2

Navigation Links



Copyright © 2023 MadCap Software. All rights reserved.

Information in this document is subject to change without notice. The software described in this document is furnished
under a license agreement or nondisclosure agreement. The software may be used or copied only in accordance with the
terms of those agreements. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in
any form or any means electronic or mechanical, including photocopying and recording for any purpose other than the
purchaser's personal use without the written permission of MadCap Software.

MadCap Software
9171 Towne Center Drive, Suite 335
San Diego, California 92122
858-320-0387
www.madcapsoftware.com

THIS PDF WAS CREATED USING MADCAP FLARE.



CONTENTS

CHAPTER 1

Introduction 8

CHAPTER 2

Bookmarks 10
Inserting Bookmarks 11
Renaming Bookmarks 13
Deleting Bookmarks 14
Hiding and Showing Bookmark Names 15
Viewing Broken Bookmarks 16
Viewing Broken Links 17

CHAPTER 3

Concepts 19
Concept Link Example 20
Adding Concepts 25
Assigning Topics to Concepts 26
Inserting Concepts 29
Inserting Concept Links 35
Editing Concepts 38
Editing Concept Links 40
Creating a List of Concepts 47

CONTENTS iii



Editing the Look of a List of Concepts 49
Deleting Concepts 52
Deleting Concept Links 53

CHAPTER 4

Cross-References 54
General Information for Cross-References 56
Main Activities for Cross-References 63
Other Activities for Cross-References 82

CHAPTER 5

Drop-Downs 88
Inserting Drop-Down Text 89
Creating Drop-Down Effects in FrameMaker Source
Documents 92
Editing Drop-Down Effects 93
Removing/Unbinding Drop-Down Text 99
Deleting Drop-Down Text 99

CHAPTER 6

Expanding Text 100
Inserting Expanding Text 101
Editing Expanding Text 104
Removing/Unbinding Expanding Text 108
Deleting Expanding Text 108

CHAPTER 7

External Links—HTML, PDF, Microsoft Office 109
How to Insert a Link to an External File 110

CONTENTS iv



CHAPTER 8

Image Hyperlinks 115
Inserting Image Hyperlinks 116
Editing Image Hyperlinks 121
Creating Image Maps 128

CHAPTER 9

Keyword Links 142
Inserting Keyword Links 143
Editing Keyword Links 145
Deleting Keyword Links 149

CHAPTER 10

Links to Web Topics 150
Creating Links to HTML5 Topics 151
Creating Links to WebHelp and WebHelp Plus Topics 153

CHAPTER 11

Named Destinations 155
How to Generate Named Destinations Automatically 161
How to Generate a Named Destination Manually 162
How to Create a Link to a Named Destination 163

CHAPTER 12

Related Topics Links 166
Inserting Related Topics Links 167
Editing Related Topics Links 176
Deleting Related Topics Links 183

CONTENTS v



CHAPTER 13

Relationship Tables and Links 184
General Information for Relationship Links 185
Process for Relationship Links 197

CHAPTER 14

Shortcut Controls 225
Inserting Shortcut Controls 226
Editing Shortcut Controls 227

CHAPTER 15

Text Hyperlinks 229
Inserting Text Hyperlinks 230
Editing Text Hyperlinks 237

CHAPTER 16

Text Popups 246
Inserting Text Popups 247
Editing Text Popups 248

CHAPTER 17

Togglers 250
Inserting Togglers 252
Editing Togglers 254
Deleting Togglers 257

CHAPTER 18

Toolbars 258
Toolbars and Skins 259
Topic Toolbars 260

CONTENTS vi



Web Toolbars 325
eLearning Toolbars 349

CHAPTER 19

Topic Popups 353
Inserting Topic Popups 354
Editing Topic Popups 358
Customizing the Size of Topic Popups 365

CHAPTER 20

Hotspots and Dynamic Effects 367

CHAPTER 21

Viewing and Fixing Links 368
Incoming Links From Other Files 370
Outgoing Links to Other Files 371
Targets Linked to a File 372
Lock Window Pane 373
Refresh 373
Go to Previous and Next 373
View Broken Links 374
Viewing Broken Links 375
Viewing Broken Bookmarks 377

APPENDIX

PDFs 378
Tutorials 378
Cheat Sheets 379
User Guides 380

CONTENTS vii



CHAPTER 1

Introduction
A link is a feature that points to additional information from a specific area in a topic. The link may
open information in the same topic, a different topic, or even a file outside of the project altogether.
With print-based output the link can electronically open the destination if the user is viewing the
manual online, depending on the type of output you create (e.g., PDF, Word). In addition, cross-
reference links can be customized to refer to specific content and page numbers in the printed
manual (e.g., See "My Topic" on page 32).

Types of Navigation Links

n "Bookmarks" on page 10

n "Concepts" on page 19

n "Cross-References" on page 54

n "Drop-Downs" on page 88

n "Expanding Text" on page 100

n "External Links—HTML, PDF, Microsoft Office" on page 109

n "Inserting Image Hyperlinks" on page 116

n "Inserting Keyword Links" on page 143

n "Links to Web Topics" on page 150

n "Named Destinations" on page 155

n "Related Topics Links" on page 166

n "Relationship Tables and Links" on page 184

n "Inserting Shortcut Controls" on page 226
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n "Text Hyperlinks" on page 229

n "Inserting Text Popups" on page 247

n "Togglers" on page 250

n "Toolbars" on page 258

n "Inserting Topic Popups" on page 354

WARNING It is recommended that you avoid creating links to snippets.This is primarily
due to the nature of snippets, which are designed to be inserted into multiple files. Let's say
you have a heading style in a snippet and that snippet is then inserted into 12 different
topics. In another topic, you might decide to create a cross-reference that points to the
heading in that snippet. But which of those 12 topics is it supposed to point to in the
output? There is no way for Flare to know this, so you could end up with some very
undesirable results. For this reason, it's a good idea not to link to any content in a snippet.
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CHAPTER 2

Bookmarks
A bookmark is a marker, or flag, that lets you create hyperlinks to specific locations within topics
(rather than to another topic file in general). You can insert a bookmark at a specific location in your
topic (e.g., at a subheading) and then insert a hyperlink that "connects" to that bookmark. This is a
useful feature, for example, if you have a somewhat lengthy topic and want the user to be able to
locate a specific place in the topic quickly.

This chapter discusses the following:

Inserting Bookmarks 11

Renaming Bookmarks 13

Deleting Bookmarks 14

Hiding and Showing Bookmark Names 15

Viewing Broken Bookmarks 16

Viewing Broken Links 17
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Inserting Bookmarks
Supported In:

The main task involved with bookmarks is inserting them.

How to Insert a Bookmark
1. Click in the topic where you want to insert a bookmark (e.g., in front of a subheading or a

specific paragraph).

2. Select Insert > Bookmark.

3. In the New bookmark field, type a name for your bookmark (do not use spaces).

EXAMPLE If the bookmark is being placed at the beginning of a bulleted list of
product features, you might type ProductFeatures as the bookmark name.

4. Click Add. A bookmark icon and the name of the bookmark are displayed at the
appropriate location in the topic (as long as your markers are turned on). You can hide the
bookmark name if you want.

5. Click to save your work.

6. Now you can insert a cross-reference or another kind of hyperlink elsewhere in this topic or in
another topic that links to this bookmark.

NOTE You can also move an existing bookmark to a new location in the topic. To do this,
place your cursor in the topic where you want the bookmark to be moved. Select Insert >
Bookmark. In the Manage Bookmarks dialog, select the existing bookmark that you want to
move (instead of typing the name of a new bookmark). Then click Move.
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NOTE When you insert anchor tags (i.e., bookmarks) in your project, the name attribute is
used in those locations. There is an option in the Advanced tab of the Target Editor for
HTML5 to use IDs on anchor tags such as these. This option copies existing anchor name
attributes to ID attributes.
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Renaming Bookmarks
If you want to rename one of the bookmarks that you have inserted in a content file (e.g., topic,
snippet), you can easily change the name.

How to Rename a Bookmark
1. Open the content file.

2. Right-click the bookmark, and from the context menu select Rename Bookmark. The Manage
Bookmarks dialog opens, with the bookmarks in that topic listed.

3. Select the bookmark that you want to rename.

4. In the New bookmark field, type a new name for the bookmark.

5. Click Rename. This changes the bookmark name in the topic.

6. Click to save your work.
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Deleting Bookmarks
If you inserted a bookmark and no longer need it, you can permanently remove it.

How to Delete a Bookmark
1. Open the content file.

2. Right-click the bookmark to remove and select Delete from the context menu.

3. Click to save your work.
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Hiding and Showing Bookmark Names
When you insert a bookmark into a content file (e.g., topic, snippet), both the bookmark icon and
the bookmark name display on screen. You can show or hide the bookmark name from your screen
display. When hidden, the screen displays shows only the bookmark icon at the insertion point.

How to Hide or Show Bookmark Names
1. Open the content file.

2. On the local toolbar of the XML Editor, click the down arrow of the Show tags button .
Then select Show Bookmark Names to add or remove the check mark next to it.
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Viewing Broken Bookmarks
You can view a list of files with broken bookmarks, including the bookmark destination that the link
is trying to find, the link text, the link tag, and other information. Also, you can open the file where
the broken link is located so that you can fix it. 

How to View and Fix Broken Bookmarks
1. Open a content file (e.g., topic).

2. Select Analysis > Links > Broken Bookmarks.

The Broken Bookmarks window pane opens. The area at the bottom of the window pane
displays all files that contain bookmark links to the open file that are broken.

3. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

n File Displays the name of the file where the broken link occurs.

n Folder Displays the folder where the file is found.

n Link Displays the link that is broken (e.g., the path and name of the topic in question).

n Type Displays the type of broken link (e.g., missing file).

n Link Text Displays the text in the source topic that is being used as the link.

n Link Tag Displays the style used for the link. For example, if a regular text hyperlink is
used, you will see "a" in this column.

n Extension Displays the file extension that the link is not finding (e.g., .htm, .jpg).

4. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.

5. Double-click the row that you want to correct. The file opens in the appropriate editor or
dialog. For example, if the link appears in a topic, the XML Editor opens with the broken link
highlighted.

6. Redirect the link as necessary (e.g., right-click on the link and select Edit Hyperlink or Edit
Cross-Reference).
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Viewing Broken Links
You can view a list of files in your project where a broken link is located, including which file it is
trying to find, the link text, the link tag, and other information. Also, you can open the file where the
broken link is located. The broken link is highlighted so that you can easily fix it. 

How to View and Fix Broken Links
1. From the Analysis ribbon, click the Summary button.

2. If you see a row indicating broken links in red, double-click it.

3. In the grid listing all broken links, double-click one.

4. In the file that opens, the broken link is highlighted.

5. Edit the broken link or remove it.

6. Click to save your work.
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How to Fix Links Directly in the Broken Links
Window Pane

1. In the Broken Links window pane, click the row that you want to correct, then click . The Fix
Broken Links dialog opens.

2. In the Fix Broken Links dialog, do one of the following.

n Click or right-click a file and from the context menu, select Select file for linking. This
option opens a dialog, from which you can select a new link.

n Click or right-click a file and from the context menu, select Scan for Potential Links.
This option scans the project for potential matches to the broken link. When this option
is selected, the Search for Similar Files dialog opens, which lists the similar files that
the analysis tool has found. You can then select a file from that list.

The name of the file you select to fix the broken link will be displayed in the File field at the
bottom of the Fix Broken Links dialog.

3. Click Apply.
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CHAPTER 3

Concepts
Supported In:

A concept is a marker that you can insert into related topic files in order to “tie them together.”

This chapter discusses the following:

Concept Link Example 20

Adding Concepts 25

Assigning Topics to Concepts 26

Inserting Concepts 29

Inserting Concept Links 35

Editing Concepts 38

Editing Concept Links 40

Creating a List of Concepts 47

Editing the Look of a List of Concepts 49

Deleting Concepts 52

Deleting Concept Links 53
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Concept Link Example
The following example is designed to help make the idea of concept links clearer and guide you
through the steps for creating your own concept links.

Scenario
Let's say we have a Flare project called "Pets." In this project, we have dozens of topics about all
kinds of animals (cats, dogs, parrots, hamsters, and so on). We have written five topics about dogs.

n Choosing a Dog

n Feeding a Dog

n Training a Dog

n Grooming a Dog

n Walking a Dog

Because these five topics all have something in common (i.e., they're all about dogs), we want to
include a link at the bottom of each of those five topics that lets users quickly jump to any of the
other "dog" topics.
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Step 1—Create and Insert a Concept
First, we need to create a concept to tie these five topics together. We can create a concept with
any name that we want, but it helps to name the keyword something that is obvious and all topics
have in common. Therefore, we'll give our concept the name "dogs."

1. Open any of the five topics. In this example, we'll open the topic "Choosing a Dog."

2. Click in the location in the topic where you want to insert the concept. Typically, you'll insert
the concept somewhere near the top of the topic. In our example, we will click right before our
topic title "Choosing a Dog."

3. Select View > Concept Window or press SHIFT+F9 on your keyboard. The Concept window
pane opens.

4. The cursor should already be placed in the Terms cell. If not, click in that cell. Type Dogs and
press ENTER. A concept marker labeled "Dogs" is added before the topic title. If you cannot
see the marker, turn your markers on by clicking the down arrow next to the Show tags button

in the XML Editor. Then select Show Markers.

CHAPTER 3  21



Step 2—Copy and Paste the Concept Marker
Into All Relevant Topics
Next, we need to place the same concept in our other four "dog" topics. We could repeat the same
steps above for each topic, but we'll copy and paste our first concept marker instead.

1. In the "Choosing a Dog" topic, right-click on the concept marker and choose Copy.

2. Open another "dog" topic ("Feeding a Dog," "Training a Dog," etc.). Click in front of the topic
title (or somewhere near the top of the topic), and press CTRL+V on your keyboard.

Repeat this until you've pasted the concept marker into all five of the "dog" topics.

3. Click to save all files.
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Step 3—Insert a Concept Link
Now that we have the concepts in place, we can insert a concept link into each of the five "dog"
topics. This is the link that users will see and click in the output. They will not see the concepts that
we created at the top of each topic (those are simply markers).

1. In one of the "dog" topics, place your cursor at the end of the last piece of content (e.g., after
the final paragraph). Then press ENTER to create a new paragraph.

2. Select Insert > Concept Link (A-link). The Insert Concept Link Control dialog opens. The
"Dogs" concept that we inserted is listed on the right side of the dialog.

3. In the All Concepts section, double-click Dogs. This concept is now listed in the "Selected
Concepts" section on the left.

4. Click OK. The concept link is added to the topic.
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Step 4—Copy and Paste the Concept Link Into
All Relevant Topics
Finally, we need to place the same concept link in our other four "dog" topics. We could repeat the
same steps above for each topic, but we'll copy and paste our first concept link instead.

1. In the topic where the first link has been inserted, right-click on the concept link and choose
Copy.

2. Open another "dog" topic ("Feeding a Dog," "Training a Dog," etc.). Place your cursor at the end
of the last piece of content (e.g., after the final paragraph). Then press ENTER to create a new
paragraph.

3. Press CTRL+V on your keyboard.

Repeat this until you've pasted the concept link into all five of the "dog" topics.

4. Click to save all files.
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Adding Concepts
You can use the bottom area of the Concept window pane to add concepts and assign topics to
them. The major benefit of this method is that it is an easy and quick way to place the same
concept marker at the beginning of multiple topics and maintain better consistency.

How to Add a Concept
1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter between them and drag it up or down.

2. In the explorer area at the bottom of the window pane, right-click on Concepts and from the
context menu select Add Concept.

3. Type the concept keyword and press ENTER.
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Assigning Topics to Concepts
After you add concepts in the Concept window pane, you can assign topics to them. There are two
methods for doing this.

How to Assign Topics to a Concept—Context
Menu in Concept Window Pane

1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter between them and drag it up or down.
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2. Right-click on the concept and from the context menu select Assign Topic.

3. In the dialog that opens, find and select the topic(s). If you want to select multiple items, click
the Show Files button then hold the SHIFT key to select a range or hold the CTRL key to
select individual items.

4. In the dialog, click Close.

Paths to the selected topics are displayed in the Concept window pane after the keyword.
And a concept marker is added at the beginning of each topic.
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How to Assign Topics to a Concept—Drag From
Content Explorer

1. Open the Content Explorer.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter between them and drag it up or down.

3. In the local toolbar of the Content Explorer, click the Show Files button . The window
pane splits into left and right halves.

4. In the left half of the Content Explorer, click the folder holding the topics that you want to
assign to a concept.

5. In the right half of the Content Explorer, select the topics. You can hold the SHIFT key to
select a range, or you can hold the CTRL key to select individual items.

6. Drag the selected topics and drop them on the concept keyword that is displayed the bottom
(explorer) portion of the Concept window pane.

Paths to the selected topics are displayed in the Concept window pane after the keyword.
And a concept marker is added at the beginning of each topic.
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Inserting Concepts
You can open a topic and use the top area of the Concept window pane to insert concepts into that
file.

Drag-and-Drop Method
Use this method to quickly insert a concept that already exists in your project.

n Advantage It is extremely fast.

n Disadvantage The concept that you want to insert must already exist in the project. This
means you must first insert the concept into a topic using one of the other methods.
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How to Insert a Concept Using the Drag-and-Drop
Method

1. Open the content file.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter between them and drag it up or down.

3. In the bottom (explorer) area of the Concept window pane, click the concept and drag it to the
location in the topic where you want to insert it. As you drag the concept into the topic, a
vertical red bar acts as a guide to help you place the concept in the topic. The concept is
displayed within a marker in front of the word where you added it (as long as markers are
turned on). A marker can hold multiple concepts, but most times you only need one concept
per marker.

4. Click to save your work.
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Concept Window Pane Method
Use this method to insert a concept in the Concept window pane.

n Advantage It lets you continue to perform other tasks in the topic without having to "switch
modes."

n Disadvantage It is not quite as fast as the other methods.

How to Insert a Concept Using the Concept Window
Pane Method

1. Open the content file.

2. Click at the location where you want to insert a concept.

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens.

4. Click in an empty field in the Terms column.
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5. Type the concept as you want it to appear.

6. Press ENTER. The concept is displayed within a marker in front of the word where you added
it (as long as markers are turned on). A marker can hold multiple concepts, but most times
you only need one keyword per topic.

7. Click to save your work.
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Concept Entry Mode Method
Use this method to accomplish the same thing as the Concept window pane method. The
difference is that, with this method, you do not need to move your cursor from the topic to the
Concept window pane. You simply click at the spot in the text where you want to insert the keyword
and start typing. The words you type are added directly into the Concept window pane. This is a
good method to use if you plan to create concepts in a lot of topics all at once, without performing
any other tasks in the topic.

n Advantage It is extremely fast.

n Disadvantage If you are adding a concept as you work on a topic, you need to remember to
switch off the Concept Entry Mode so that you can return to editing your topic.

How to Insert a Concept Using the Concept Entry Mode
Method

1. Open the content file.

2. In the local toolbar of the XML Editor click .

3. Click at the place in your topic where you want to add a concept.

4. Type the phrase that you want to add as the concept.

As you start typing, the Concept window pane opens (if it was not previously opened), and the
phrase is added to the first empty field under the Terms column.
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NOTE As you type in the Concept window pane, notice that the cursor does not lose
focus in the XML Editor. It merely turns gray so that you know for certain where you
are adding the concept. When you return to the XML Editor, the cursor returns to its
previous state.

5. Press ENTER. The concept is displayed within a marker in front of the word where you added
it (as long as markers are turned on). A marker can hold multiple concepts, but most times
you only need one keyword per topic.

6. If you want to add more concepts in the topic, repeat steps 3-5.

7. Click to save your work.

To turn off the Concept Entry Mode and return to regular editing, you can click again.

What’s Noteworthy?

NOTE If you want to see all of the concepts that you have inserted in your project, they are
displayed in the bottom portion of the Concept window pane.
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Inserting Concept Links
After you create concepts keywords, you can insert concept (or See Also) links.

A concept link is a Help control that lets users open topics that you've determined are related to the
current topic. It is similar to the related topics link. However, whereas you associate a related topics
link with specific individual topics (usually for a one-time use), you associate a concept link with a
group of topics (to be reused in different topics). One great benefit of this type of link is that, if you
later want to add or delete topics from the group, you only need to do so in one place and the
changes are applied to every topic containing that concept link.

How to Insert a Concept Link
1. Insert concepts into the appropriate topics.

2. Open the content file.

3. In the XML Editor, click in the topic where you want to insert the link (usually at the bottom of
the topic).

4. Select Insert > Concept Link (A-link). The Insert Concept Link Control dialog opens. The
concepts that you have inserted into topics are listed on the left side of the dialog.

5. Do one of the following:

n In the All Concepts section, double-click a concept that you want to add to the concept
link.

n In the All Concepts section, click on a concept that you want to add to the concept link.
Then click .

6. The concept is added to the "Selected Concepts" section on the right side of the dialog. Do
this for each concept that you want to add to the link. However, a concept link usually has
only one keyword associated with it (or just a few at the most). Remember, every topic
containing any of those concepts will show up in the concept link in the output. A good
practice is to limit the number of topics per concept link. Otherwise, the link tends to lose its
significance.
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7. (Optional) If you want to specify other options for the control, click and in the Concept
Link Options dialog select any of the following. Click OK to close the dialog when you are
finished.

n Style Class You can select the style class to be used for the control.

n Label You can change the text shown on the control.

n Display topics in You can specify that the links should be displayed in a popup menu
(same as default) or as a simple list.

NOTE For projects that are merged, the list option is supported for standard
merging (e.g., linking to an FLPRJ file in the table of contents). However, it is
not supported for automerging in WebHelp Plus output.

n Target Frame You can choose the type of frame used when a link is clicked.

l Page Default The destination file opens in the same window as the output window.

l Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

l New Window The destination file opens in a new browser window.

l Same Frame The destination file opens in the same window frame as the current
topic.

l Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its
own frameset.

l Popup Window The destination file opens in a popup box on top of the current topic.
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8. Click OK. The concept link is added to the topic.

9. Click to save your work.

NOTE Another type of automated link that can be added to topics is a relationship link,
which has a similar result but works a bit differently than Help controls. One benefit of a
relationship link is that you can create all of your link information in one place, in a single
relationship table. Another benefit is that you can have multiple types of links at the bottom
of topics (e.g., one for "Related Information," one for "Related Tasks," and one for
"Reference Materials"). See "Relationship Tables and Links" on page 184.

NOTE When people click a link like this in the output, the text shown for each of the topics
depends on whether the topic in question has a title or heading. The title set in the
Properties dialog has the highest level of precedence. If there is no topic title specified in
the Properties dialog, Flare uses text associated with h1 through h6 heading styles. If there
is no topic title or headings in a topic, Flare uses the topic file name.
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Editing Concepts
After you insert a concept, you might decide later that the concept keyword needs to be altered.
You can modify a concept simultaneously for all topics where that keyword is located, or you can
modify it in a specific topic.

How to Edit a Concept in All Topics Where It is
Located

1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter between them and drag it up or down.

2. In the explorer area at the bottom of the window pane, right-click on the concept that you
want to rename. From the context menu select Rename Keyword. The concept is renamed in
all topics where it had been inserted
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How to Edit a Concept in a Specific Topic
1. Open the content file.

2. In the XML Editor, right-click on the marker holding the concept that you want to modify.
From the context menu, select Edit the Concept Association.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter between them and drag it up or down.

3. In the Terms column of the Concept window pane, click in the cell containing the keyword
that you want to change.

4. Type the concept and press ENTER. The concept is modified.

5. Click to save your work.

What’s Noteworthy?

NOTE If you want to change how concepts look when they're inserted in the XML Editor,
you can change the MadCap|concept style in the Stylesheet Editor.This does not affect the
output.
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Editing Concept Links
You can edit a concept link that you have inserted into a topic.

How to Change the Concepts Associated With a
Concept Link
The first way to edit a concept link is to change the concepts associated with the link, as well as
specify various other optional settings.

EXAMPLE You have a concept link that has two concepts ("Projects" and "Systems")
associated with it. You might want to remove the "Projects" keyword from the link so that it
only contains the "Systems" keyword. The steps below show you how to do this.

1. Open the content file.

2. In the XML Editor, right-click the concept link.

3. In the context menu, select Edit Concept Link. The Insert Concept Link Control dialog opens.

The concepts currently associated with the link are listed on the right side of the dialog. The
concepts that you have inserted into all other topics are listed on the left side of the dialog.

4. If you want to add a concept to the link, click on that keyword on the left (All Concepts) side of
the dialog. Then click . If you want to remove a concept from the link, click on that keyword
on the right (Selected Concepts) side of the dialog. Then click .

Repeat this for each keyword that you want to add to or remove from the link. When you are
finished, the keywords associated with the link should be in the Selected Concepts section,
and the keywords not associated with the link should be in the All Concepts section. However,
a concept link usually has only one keyword associated with it (or just a few at the most).
Remember, every topic containing any of those concepts will show up in the concept link in
the output.
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5. (Optional) If you want to specify other options for the control, click and in the Concept
Link Options dialog select any of the following. Click OK to close the dialog when you are
finished.

n Style Class You can select the style class to be used for the control.

n Label You can change the text shown on the control.

n Display topics in You can specify that the links should be displayed in a popup menu
(same as default) or as a simple list.

NOTE For projects that are merged, the list option is supported for standard
merging (e.g., linking to an FLPRJ file in the table of contents). However, it is
not supported for automerging in WebHelp Plus output.

n Target Frame You can choose the type of frame used when a link is clicked.

l Page Default The destination file opens in the same window as the output window.

l Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

l New Window The destination file opens in a new browser window.

l Same Frame The destination file opens in the same window frame as the current
topic.

l Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its
own frameset.

l Popup Window The destination file opens in a popup box on top of the current topic.

6. Click OK. The Insert Concept Link Control dialog closes, and the link is now changed.

7. Click to save your work.
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How to Edit the Style of a Concept Link
You can edit the style of a concept link. When you do this, the style changes for all concept links in
any topics in your project. Also, keep in mind the various rules that pertain to concept links.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the Show Styles field
and select Show Link Styles or Show Dynamic Effects Styles. Different styles are displayed
with each filter.

4. On the left side of the editor, find and select one of the following styles, depending on what
you want to accomplish. You can use a general style (which starts with "helpControl") if you
want to modify all types of Help control links (concept, keyword, and related topic links).
Alternatively, you can use a specific style (which starts with "conceptLink") if you want to
modify only concept links in your project.

n MadCap|helpControlList Edit this style to change the look of the entire list (<ul>
element) when links are displayed in a list, rather than in a popup.

n MadCap|helpControlListItem Edit this style to change the look of individual items in the
list (<li> elements) when links are displayed in a list, rather than in a popup.

n MadCap|helpControlListItemLink Edit this style to change the look of links in the list
(<a> elements) when links are displayed in a list, rather than in a popup.

n MadCap|helpControlMenu Edit this style to change the look of links (i.e., menu items)
when links are displayed in a popup, rather than in a list. This particular style controls
the entire list.

n MadCap|helpControlMenuItem Edit this style to change the look of links (i.e., menu
items) when links are displayed in a popup, rather than in a list. This particular style
controls the individual list items.

n MadCap|conceptLink Edit this style to change the look of the heading for concept links.
The following three concept link styles inherit properties from this style.
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n MadCap|conceptLinkControlList Edit this style to change the look of the entire list (<ul>
element) when concept links are displayed in a list, rather than in a popup.

n MadCap|conceptLinkControlListItem Edit this style to change the look of individual
items in the list (<li> elements) when concept links are displayed in a list, rather than in
a popup.

n MadCap|conceptLinkControlListItemLink Edit this style to change the look of links in
the list (<a> elements) when concept links are displayed in a list, rather than in a popup.

NOTE You can also change a pseudo class of a link style (e.g.,
MadCap|conceptLink.focus or MadCap|conceptLink.hover) if you want to modify the
look of the concept link when it is in a certain state (e.g., when it has focus or when
the cursor is hovering over it).

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

9. Click to save your work.
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Rules
Keep in mind the following rules when working with these types of styles.

Font Color on Link Styles Only
You can set many different properties on Help controls. However, font color can be set only on
styles that deal specifically with links (e.g., a, helpControlListItemLink,
conceptLinkControlListItemLink).

EXAMPLE You want to use red on concept links. You can set that color on
MadCap|conceptLinkControlListItemLink, because it controls the links specifically. But if
you set the color on MadCap|conceptLinkControlList or
MadCap|conceptLinkControlListItem, the color setting will have no effect because those
styles deal with lists and list items, not links.

Inheritance From Main List and Link Styles
Because these Help control styles are based on the main styles for unnumbered lists (ul), list items
(li), and hyperlinks (a), they inherit properties from those standard styles.

EXAMPLE You set a purple font on the "a" style. If you do not make any changes to your
Help control styles, all of the links will use a purple font. But suppose you want concept
links to use a green font instead. In that case, you can set the
MadCap|conceptLinkControlListItemLink style to green. If you do that, regular text
hyperlinks, keyword links, and related topic links will all display in purple, but concept links
will display in green.

NOTE If setting a property on the "a" style does not seem to have an effect on the Help
control links, check the heading style. For example, if you set purple on the "a" style but
MadCap|conceptLink has blue, then MadCap|conceptLinkControlListItemLink will use blue.
That's because MadCap|conceptLink overrules "a."
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Inheritance From General Help Control Styles
Because the general "helpControl" styles (helpControlList, helpControlListItem,
helpControlListItemLink) are used to determine the look of all three types of Help control links, the
more specific styles (e.g., conceptLinkControl, keywordlinkControl, relatedTopicsConrol) inherit
properties from them.

EXAMPLE You set a 12-pt font on the MadCap|helpControlListItem style. If you do not
make changes to any of the more specific styles (MadCap|conceptLinkControlListItem,
MadCap|keywordLinkControlListItem, MadCap|relatedTopicsControlListItem), all of them
will use a 12-pt font. But suppose you want concept links to use a 14-pt font instead. In
that case, you can set the MadCap|conceptLinkControlListItem style to 14 pt. If you do that,
keyword links and related topic links will display in 12 pt, but concept links will display in 14
pt.

No Inheritance Between Specific Styles
As shown, there is inheritance from main styles (e.g., a, li) and from the general "helpControl" styles.
That's because the main styles are at a higher level than all of the Help control link styles, and the
general "helpControl" styles are at a higher level than the more specific styles. But all of the specific
Help control styles are at the same level; therefore, none of them inherit properties from any of the
others.

EXAMPLE You set a 10-pt font on the MadCap|keywordLinkControlList style (which
controls entire lists for keyword links). Neither the MadCap|keywordLinkControlListItem
style nor the MadCap|keywordLinkControlListItemLink style will inherit that font size.
Instead, the MadCap|keywordLinkControlListItem style (which controls list items for
keyword links) will either inherit from li or MadCap|helpControlListItem. And
MadCap|keywordLinkControlListItemLink (which controls the actual links for keywords) will
either inherit from "a" or MadCap|helpControlListItemLink. Or you can set different colors
on those styles specifically.
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The following diagram shows how inheritance and precedence works with Help control styles. In
this example, concept link styles are shown. But the same type of structure applies to keyword and
related topic links as well. The arrows show inheritance. The numbers show precedence; in other
words, if multiple styles have different settings for the same property, the style with a lower number
has precedence over those with higher numbers.
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Creating a List of Concepts
You can use the Concepts proxy to generate a list of all of the concepts in your project, with links to
the corresponding content. When you generate the output, the proxy is replaced with a list of the
paragraph text found wherever a concept has been inserted.
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How to Create a List of Concepts
1. Create concepts in the project. See "Adding Concepts" on page 25 and "Inserting Concepts"

on page 29.

2. Add a new topic as you normally would.

3. At the top of the topic, enter a title for your list (e.g., "List of Concepts").

4. Select Insert > Proxy > Insert Concepts Proxy. The Concepts Proxy dialog opens.

5. (Optional) In the Stylesheet class for proxy field, you can select a class to affect the look of
the entire list.

You might create and use a proxy style class, for example, if you want to add a border around
the generated list. If you do not select a class from this field, the generated list will use the
style settings from the parent MadCap|conceptsProxy style. You have the option of creating a
class for this proxy style in the Stylesheet Editor. To do this, select the
MadCap|conceptsProxy style and in the local toolbar click Add Selector to create a class. The
class will then be available from this field. For more information see the online Help or the
Flare Styles Guide.

6. Click OK. The proxy is added to the topic.

7. Click to save your work.

CHAPTER 3  48



Editing the Look of a List of Concepts
After you use the Concepts proxy to create a list of concepts, you can change the look of that list by
using styles. You can modify the look of individual entries in the list, as well as the entire container.

How to Edit the Look of a List of Concepts
(Entire Container)

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. In the upper-left of the editor, make sure the drop-down field is set to
.

4. On the left side of the editor, scroll down and select the MadCap|ConceptsProxy style or a
class that you have created under it (e.g., MadCap|ConceptsProxy.myclass).

5. From the Show drop-down list on the upper-right side of the editor, select .

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

For example, if you want to change the width of the entire list of concepts, you would first
expand the Box property group. Then to the right of width, click , and in the popup set the
value.

Another example would involve adding headings to a list of concepts. You would expand the
Unclassified property group and select an option next to the the mc-concepts-list-headings
property to enable or disable concept list headings.

9. Click to save your work.
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How to Edit the Look of a List of Concepts
(Individual Entries)

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. In the upper-left of the editor, make sure the drop-down field is set to
.

4. On the left side of the editor, select a style class, depending on what you want to change.

TO EDIT CONCEPT TERMS AND TEXT

Expand the p style, and select either of the following classes under it:

n Concept Select this class to control the look of the concept terms displayed in the
generated list.

n ConceptContext Select this class to control the look of the text associated with each
concept term in the generated list.

TO EDIT PAGE NUMBERS FOR PRINT OUTPUT

Expand MadCap|xref and select the ConceptPageNumber style class.

5. From the Show drop-down list on the upper-right side of the editor, select .

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

Following are some of the more common properties that you might change for concept
terms and text. (If changing the look of the actual page numbers, you might use other
properties, such as font color.)
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n Alignment of Page Number (Print Output) To change the alignment (left, right, center)
of the page number, expand the Unclassified property group. Then to the right of mc-
leader-align, click , and select one of the alignment options.

n Font Family To change the font family (e.g., Arial, Verdana), expand the Font property
group. To the right of font-family, click , and select the font or a font set you want to
use.

n Font Size To change the font size (e.g., 10 pt, 11 pt), expand the Font property group.
To the right of font-size, click , and set the font size.

n Leader Format (Print Output) To change the format of the area between the item in the
list and the page number, expand the Unclassified property group. To the right of mc-
leader-format, click , and type the character to use. For example, if you want a series
of dots, type a period. If you do not want to use a leader format, leave this field blank.

NOTE You can enter one character only (period, hyphen, or underscore).
Spaces are also supported, and if you use a character that is not supported, a
space will automatically be used.

n Leader Space Before/After (Print Output) Expand the Unclassified property group. To
change the distance from the end of the list entry to the start of the leader, click to
the right of mc-leader-indent, and set the margin value. To change the distance between
the end of the leader and the page number, click to the right of mc-leader-offset, and
set the margin value.

n Padding Above To change the amount of empty space (padding) above the item in the
list, expand the Box property group. To the right of padding-top, click , and set the
padding value. You can also use the other cells in this property group to add padding
below, to the left, or to the right.

n Space in Front (Indentation) To change the distance from the left page margin to the
beginning of the item in the list, expand the Box property group. To the right of margin-
left, click , and set the margin value. You can specify additional indentation for
headings that wrap to more than one line. To do this, expand the Unclassified property
group. To the right of mc-multiline-indent, click , and set the margin value.

9. Click to save your work.
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Deleting Concepts
If necessary, you can delete concepts that you have inserted into a content file (e.g., topic, snippet).
You can do this from the Concept window pane or from a specific file. The advantage of using the
Concept window pane is that you can delete concept keywords from all topics in one step.

How to Delete a Concept From the Concept
Window Pane

1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select View > Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter between them and drag it up or down.

2. In the explorer area at the bottom of the window pane, right-click on the concept keyword that
you want to delete. From the context menu select Remove Keyword.The keyword is removed
from all topics where it had been inserted.

NOTE If you want to delete a keyword from the Terms area of the Concept window pane,
click on the rectangular area to the left of the concept keyword (on the area with the arrow
) and press Delete on your keyboard.

How to Delete a Concept From a Specific File
1. Open the content file.

2. In the editor right-click the concept marker that you want to delete.

3. From the context menu, select Delete. The concept marker is removed from the topic.

4. Click to save your work.
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Deleting Concept Links
There are two parts to a concept link—(1) the concept link itself and (2) the concepts inserted into
topics that associate the topic with a particular concept link. The following steps show you how to
delete the concept link.

How to Delete a Concept Link
If you no longer need a concept link that you have previously inserted into a topic, you can easily
delete it from a topic.

1. Open the content file.

2. Right-click the concept link that you want to delete.

3. From the context menu, select Delete. The concept link is removed from the topic.

4. Click to save your work.
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CHAPTER 4

Cross-References
Supported In:

A cross-reference is a dynamic navigation link that lets you connect one topic to another (or a
bookmark within a topic). 
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This chapter discusses the following:

General Information for Cross-References 56

Main Activities for Cross-References 63

Other Activities for Cross-References 82
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General Information for Cross-
References

There are various pieces of general information you should know if you plan to use this feature.

Cross-References vs. Text Hyperlinks
Use the following to help determine when to use a cross-reference and when to use a hyperlink.

Cross-References Text Hyperlinks

Use for linking to other topics within the
project, because the link text will
automatically update if changes are made to
the destination topic heading, file name, etc.

Not designed for linking to content outside of
the same project

Use for linking to websites and external files
(e.g., PDFs), as well as to content in other
projects (see "External Links—HTML, PDF,
Microsoft Office" on page 109)

Use for linking to other topics within the
project when you want specific link text that
doesn't necessarily match the destination
heading, file name, etc.

Uses MadCap-specific style (MadCap|xref) Uses standard CSS style (a), which is also
used for image hyperlinks and popup links

Can be context-sensitive in print output (e.g.,
displays "next page," "below," or specific page
number)

Not context-sensitive
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Automating Links Based on Commands
Cross-references are somewhat similar to text hyperlinks. However, cross-references differ from
hyperlinks in a few ways. (1) They are based on format commands that help you keep the look of
links consistent, using the MadCap|xref style. Commands are contained in brackets (e.g.,
{paratext}). (2) They are especially useful for print output because they let you automatically refer to
specific areas and/or page numbers in the output. (3) Both the source and destination files must be
part of the same target output within the same project.

EXAMPLE You have a topic with the title "About Things," and there are several other topics
in your project that you want to link to that topic. Furthermore, let's say that each one of
those links needs to have the same text (e.g., "For more information see 'About Things.'")

Now, you could use a text hyperlink in each of those topics; this would be a good option if
the text in each of the links needed to be different. But instead you create a cross-reference
using the MadCap|xref style. In this style you specify the exact text mentioned above, along
with the {paratext} command, which displays the text of the first paragraph it finds (such as
a topic heading). You can use that cross-reference style anywhere that you'd like to create
a link using that configuration. When you insert the cross-reference it includes the text you
provided (e.g., "For more information see"), and it uses the {paratext} command to display
the heading text for the destination topic (e.g., "About Things"). When you put it all together,
you have "For more information see 'About Things.'"

Later, if you decide to change the heading text of the destination topic to "About
Whatchamacallits," the cross-references will be updated automatically when you generate
the output. The new heading will automatically be reflected in all of the links using that
cross-reference style (i.e., "For more information see 'About Whatchamacallits'"). If you had
used text hyperlinks in a situation like this, you would need to find and replace the text in all
of the pertinent links manually.
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EXAMPLE Here is an example of a cross-reference format, using a combination of text and
commands:

See {b}"{paratext}"{/b} on page {page}.

A format such as this might be translated in the output as something like this:

See "Dogs and Cats" on page 93.

If you are using autonumbers in your content (e.g., for figure or table numbers), you can create
cross-reference formats that include the autonumbers.

EXAMPLE You have created autonumbers in order to number all of your figures. Perhaps
your autonumber format is set up to show the word "Figure" followed by an incremented
number and a colon (e.g., Figure 4:, Figure 5:, Figure 6:). In addition, wherever you apply
autonumbering in a topic, you might manually type a short description of the image (e.g.,
Properties Dialog). So in the output under the graphic, the user might see something like
this:

Figure 4: Properties Dialog

Now let's say that you want to insert a cross-reference in another topic that points the user
to the Figure 4 graphic. To do this, first of all you would probably want to insert a bookmark
at that autonumber location so that you can point directly to that paragraph when you
insert the cross-reference. Then you can create a special cross-reference format that
includes the autonumber portion of that paragraph. The following two autonumber
commands can be used:

{paranum} This command displays all of the content in the autonumber format, including
any text before an autonumber, the autonumber itself, and any text after the autonumber.
Using the example provided above, this command would display something like this in the
cross-reference:

Figure 4:

{paranumonly} This command displays any text before an autonumber and the
autonumber itself. However, it does not show any text after the autonumber (such as a
colon). Using the example provided above, this command would display something like this
in the cross-reference:

Figure 4
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In addition, if you want to include any text that you manually add in the topic after the
autonumber format, you can add the {paratext} command to the cross-reference format.
Using the example provided above, this command would display something like this in the
cross-reference:

Properties Dialog

Therefore, suppose your entire cross-reference format is this:

See "{paranum} {paratext}"

In that case, the output would display something like this:

See "Figure 4: Properties Dialog"

On the other hand, suppose your entire cross-reference format is this:

See "{paranumonly} {paratext}"

In that case, the output would display something like this (without the colon):

See Figure 4 Properties Dialog

Again, when you insert the cross-reference in a topic, make sure you select the format that
you created, and also remember to link to the bookmarked paragraph where the
autonumber appears.

TIP If you insert a cross-reference into a topic and it initially does not look the way you
expected, try updating the cross-references in the topic. See "Updating Cross-References"
on page 82.
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Cross-Reference Commands
Following is a list of the available cross-reference commands in Flare.

b Start bold text

/b End bold text

bg Start new background color

/bg End background color

color Start new text color

/color End text color

default Reset all font changes

ext File extension

family Start new font family

/family End font family

file File name, including extension

filename File name, without extension

h1 Text of first heading 1 paragraph

h2 Text of first heading 2 paragraph

h3 Text of first heading 3 paragraph

h4 Text of first heading 4 paragraph

h5 Text of first heading 5 paragraph
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h6 Text of first heading 6 paragraph

i Start italic text

/i End italic text

page Page number

pagecount Page count

pageref Context-sensitive page reference

paranum The autonumber text of bookmarked paragraph.

paranumonly The autonumber only of bookmarked paragraph

paratext Text of bookmarked paragraph

paraxml Text and markup of bookmarked paragraph

path File path

size Start new font size

/size End font size

sub Start subscript text

/sub End subscript text

sup Start superscript text

/sup End superscript text

title Title of document

u Start underlined text
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/u End underlined text

url File path, URL syntax

[variable] Available variables can be entered in the cross-reference format.
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Main Activities for Cross-References
Some activities are particularly common and important when it comes to this feature.

Inserting Cross-References
The following steps show you how to insert cross-references into content files.

How to Insert a Cross-Reference—Standard Method
1. Open the content file.

2. In the XML Editor place your cursor where you want to insert the cross-reference.

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select the Insert > Cross-Reference.

n Keyboard Shortcut Press CTRL+SHIFT+R.

n Local Toolbar In the local toolbar of the XML Editor, click .

n Right-Click Right-click in the editor and select Insert > Cross-Reference. This context
menu option is available only when your cursor is located in certain places in the editor
(e.g., not in a drop-down effect).

The Insert Cross-Reference dialog opens.

4. From the Link to drop-down field, select a way to identify the topic or bookmark to which you
want to link. Based on the option you choose, the section below gives you a list of selections
or additional fields to complete.
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TOPIC IN PROJECT 

This option lets you search for a topic within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare will insert a new bookmark at that
destination in the file.
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5. In the Cross-Reference Properties section, select the MadCap|xref style that you want to use
for the cross-reference.

Initially, you may see only the parent MadCap|xref style in the list. In the XRef Format area to
the right, you can see the current format associated with that tag. Initially this format is as
follows for the different mediums:

n Default Medium {paratext}

n Print Medium "{paratext}" {pageref}

The command {paratext} means that the text of the paragraphed bookmark—or the text of
the first paragraph found in the topic—will be displayed at that spot. The {pageref} command
in the print medium format allows for context-sensitivity (see "Creating Context-Sensitive
Cross-References" on page 73).

You can: (1) use the parent MadCap|xref style with its current format, (2) use the parent
MadCap|xref style and change the format to something else, (3) create a new class of the
MadCap|xref style and provide a custom format for it, or (4) use a class that you have already
created previously.

It is a good idea to create classes because you may eventually want to use multiple kinds of
cross-references in your project. Each class that you create can be used to display cross-
references in a different format. For more information about using styles, including steps, see
the online Help or the Flare Styles Guide.

6. If you want to use the parent MadCap|xref style with its current format, or a class that you
have created previously, click MadCap:xref or the name of the class, respectively. Then
continue with Step 13.

7. If you want to use the parent MadCap|xref style but change the format, click MadCap:xref and
then Edit. The Edit Cross-Reference Style Class dialog opens. Continue with Step 10.

8. If you want to create a new class of the parent MadCap|xref style, click New. The New Cross-
Reference Style Class dialog opens.

9. In the XRef Class field, give your new class a name.

10. In the Stylesheet to modify field, select the appropriate stylesheet (if different from the one
shown). If you are using a primary stylesheet (recommended), only that stylesheet is shown
in this field. If you are not using a primary stylesheet, the stylesheet that you select needs to
be applied to the topic in which you are inserting the cross-reference.
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11. In the Enter format field, provide the format for the style. This format can be a combination of
text that you type and automated commands that you select. You can select commands from
the list by double-clicking them. They are then added to the "Enter format" field.

b Start bold text

/b End bold text

bg Start new background color

/bg End background color

color Start new text color

/color End text color

default Reset all font changes

ext File extension

family Start new font family

/family End font family

file File name, including extension

filename File name, without extension

h1 Text of first heading 1 paragraph

h2 Text of first heading 2 paragraph

h3 Text of first heading 3 paragraph

h4 Text of first heading 4 paragraph
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h5 Text of first heading 5 paragraph

h6 Text of first heading 6 paragraph

i Start italic text

/i End italic text

page Page number

pagecount Page count

pageref Context-sensitive page reference

paranum The autonumber text of bookmarked paragraph.

paranumonly The autonumber only of bookmarked paragraph

paratext Text of bookmarked paragraph

paraxml Text and markup of bookmarked paragraph

path File path

size Start new font size

/size End font size

sub Start subscript text

/sub End subscript text

sup Start superscript text

/sup End superscript text
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title Title of document

u Start underlined text

/u End underlined text

url File path, URL syntax

[variable] Available variables can be entered in the cross-reference format.

EXAMPLE If you want the cross-reference to include text (such as "For more
information see"), simply type it in this field. You can also double-click any of the
commands to add them to this field. For example, you might want to add the text of
the first paragraph in the destination file to the cross-reference format. The
command for this is {paratext}. Descriptions for each command are displayed in the
list.

Some commands include a start tag and an end tag. For example, if you want a
portion of the cross-reference to be displayed in bold, you would place your cursor in
the "Enter format" field where want to start the bold font and double-click b in the list
below. Then place your cursor where you want the bold font to end and double-click
/b from the list.

So in the end, your cross-reference format might include a combination of text and
multiple commands, such as:

For more information see {b}{paratext}{/b}

A format such as this one might display a link in the output like this:

For more information see My Destination Topic
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12. Click OK.

13. (Optional) In the Target Frame field of the Insert Cross-Reference dialog, click the drop-down
arrow to select the way the linked destination will open. This option can be used to open the
destination topic or file in a popup.

n Page Default The destination file opens in the same window as the output window.

n Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current topic.

n Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

n Popup Window The destination file opens in a popup box on top of the current topic.

14. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the cross-reference in the output. When you enter a screen tip, it is added as a
<title> tag in the markup.

For more information see the online Help.

15. (Optional) In the Alternate Text field, type a phrase that describes what the element is about.
This option should be used to increase accessibility for users who are unable to view an
element.

16. Click OK. The cross-reference is added to the topic. You can change the appearance of the
link (e.g., color, underline) by modifying the style (e.g., MadCap|xref or MadCap|xref.MyStyle)
in the Stylesheet Editor.

17. Click to save your work.
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How to Insert a Cross-Reference—Drag-and-drop
Method

1. Open the content file.

2. Open the Content Explorer, File List window pane, or TOC Editor. If necessary, float and
position the window pane or editor so you can see both it and the XML Editor at the same
time.

3. From the Content Explorer, File List window pane, or TOC Editor, click and drag the topic you
want to link. The cross-reference is added to the topic.

4. Click to save your work.

NOTE You can change the default drag-and-drop behavior to insert a hyperlink rather than
a cross-reference.

CHAPTER 4  71



How to Insert a Cross-Reference—Quick Cross-
Reference Method

1. Open the content file.

2. In the XML Editor right-click at the location where you want to insert the cross-reference.

3. From the context menu select Insert > Quick Cross-Reference.

4. Select the appropriate submenu, depending on the option that helps you find the destination
the fastest.

n Bookmarks Lets you select any bookmarks that you have already inserted into the
current file.

n Same Folder Lets you select any files that are contained in the same folder in the
Content Explorer.

n Open Documents Lets you select any other files that are also currently open in the
workspace.

5. From the next submenu choose the bookmark or file. The cross-reference is added to the
topic. You can change the appearance of the link (e.g., color, underline) by modifying the style
(e.g., MadCap|xref or MadCap|xref.MyStyle) in the Stylesheet Editor.

6. Click to save your work.
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Creating Context-Sensitive Cross-References
Supported In:

For print-based and EPUB output you can create context-sensitive cross-references, which
automatically change the text in the link based on the relationship of the cross-reference and the
target location.

Using context-sensitive cross-references is simply a matter of using the correct command. In other
words, instead of using the simple {page} command, you can use the {pageref} command.

EXAMPLE You use the plain {page} command. Perhaps the complete format that you
create for a cross-reference style is this:

See "{paratext}" on page {page}.

When you generate the output, this cross-reference will be converted to something like the
following, regardless of where the link falls in relation to its destination:

See "My Information" on page 42.

However, let's say that you use a slightly different format, something like this:

See "{paratext}" {pageref}.

When you generate the output, what you see in place of {pageref} depends on the relative
closeness of the link and the destination. It might be translated as any of these:

See "My Information" below.

See "My Information" above.

See "My Information" on previous page.

See "My Information" on page 42.
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How to Create Context-Sensitive Cross-References
1. Go through the process of inserting or editing a cross-reference. See "Inserting Cross-

References" on page 63.

2. In the Insert Cross-Reference dialog, select either New or Edit, depending on whether you
want to create a new cross-reference style or edit an existing one.

3. Provide a format in the Enter format field. This format can be a combination of text and
automated commands.

When creating this format, make sure you include the {pageref} command in it. You can find
the command by selecting either Show All or Show Page Commands. When you find the
{pageref} command in the list, double-click it to add it to the format. Here is an example of a
format that contains a context-sensitive cross-reference command: See "{paratext}"
{pageref}.

4. Click OK.
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Editing Cross-References
After you insert cross-references into topics, you can edit them in the following ways.

Editing Cross-Reference Destinations
After you insert cross-references into topics, you can change the file to which the cross-reference is
pointing.

How to Edit a Cross-Reference Destination

1. Open the content file.

2. In the XML Editor, right-click on the cross-reference and select Edit Cross-Reference. The
Insert Cross-Reference dialog opens.

3. From the Link to drop-down field, select a way to identify the topic or bookmark to which you
want to link. Based on the option you choose, the section below gives you a list of selections
or additional fields to complete.

TOPIC IN PROJECT 

This option lets you search for a topic within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.
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Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare will insert a new bookmark at that
destination in the file.

4. (Optional) In the Target Frame field of the Insert Cross-Reference dialog, click the drop-down
arrow to select the way the linked destination will open. This option can be used to open the
destination topic or file in a popup.

n Page Default The destination file opens in the same window as the output window.

n Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current topic.

n Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

n Popup Window The destination file opens in a popup box on top of the current topic.
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5. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the cross-reference in the output.

When you enter a screen tip, it is added as a <title> tag in the markup.

For more information see the online Help.

6. (Optional) In the Alternate Text field, type a phrase that describes what the element is about.
This option should be used to increase accessibility for users who are unable to view an
element.

7. Click OK.

8. Click to save your work.
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Editing Cross-Reference Style Formats
You can change the style format used for cross-references. For example, instead of "See My Topic,"
you might want cross-references to display "For more information see My Topic." You can edit
cross-reference style formats at the point where a cross-reference is inserted, or from a stylesheet.

How to Edit a Cross-Reference Style Format at the Point of Insertion

1. Open the content file.

2. In the XML Editor, click inside the link.

3. At the top of the XML Editor, right-click the span bar representing the link. For example,
hyperlink span bars have an "a" label, and cross-reference span bars have a "MadCap:xref"
label. When you click on the link in the topic, the appropriate span bar at the top of the XML
Editor will change color to indicate that it goes with the link. If your span bars are not turned
on, click in the local toolbar of the XML Editor.

4. Select Edit Cross-Reference. The Insert Cross-Reference dialog opens.

5. In the Cross-Reference Properties section, select the MadCap:xref style you want to edit.

MadCap:xref is the parent style and default selection, but in the Stylesheet Editor you can
create classes under that style if you want a variety of looks for cross-references.

6. Click Edit. The Edit Cross-Reference Style Class dialog opens.

7. (Optional) In the Stylesheet to modify field, you can select the appropriate stylesheet (if
different from the one shown). If you are using a primary stylesheet (recommended), only
that stylesheet is shown in this field. If you are not using a primary stylesheet, the stylesheet
that you select needs to be applied to the topic in which you are inserting the cross-reference.
For more information see the online Help or the Flare Styles Guide.

8. In the Enter format field, provide the format for the class. This format can be a combination
of text that you type and automated commands that you select. You can select commands
from the list by double-clicking them. They are then added to the "Enter format" field.

9. Click OK.

10. Click to save your work.
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11. (Optional) To make sure other cross-references display the new format, you can update the
cross-references in a topic (Tools > Update Cross-References). However, all of the cross-
references will be updated automatically when you generate the output, so this is not a
mandatory task.

How to Edit a Cross-Reference Style Format From a Stylesheet

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. On the left side of the Stylesheet Editor, select the MadCap|xref tag (or a class of it) that you
want to edit.

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. If you are using the group view, expand the Unclassified group.

8. To the right of mc-format, click . The Cross-Reference Format dialog opens.

9. In the Enter format field, provide the format for the class. This format can be a combination
of text that you type and automated commands that you select. You can select commands
from the list by double-clicking them. They are then added to the "Enter format" field.

10. Click OK.

11. Click to save your work.

12. (Optional) To make sure other cross-references display the new format, you can update the
cross-references in a topic (Tools > Update Cross-References). However, all of the cross-
references will be updated automatically when you generate the output, so this is not a
mandatory task.
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Editing Text for Context-Sensitive Cross-References
You can use language skins to localize the text used in your cross-references. In addition, even if
you plan to create output in only one language, you can use a language skin to change the autotext
that is displayed for context-sensitive cross-references. For example, instead of the text displaying
"on next page," it can be customized to display "on the following page." See "Creating Context-
Sensitive Cross-References" on page 73.

Flare provides skins for many different languages. If Flare does not provide a skin for a language
that you would like to use, or if you want to edit the default translation, you can create a user-
defined language skin.

How to Edit Text for Context-Sensitive Cross-References

1. Open the Project Organizer.

2. Double-click the Advanced folder.

3. Double-click a language skin to open it.

4. From the list, select a language in bold or italic font.

5. On the right side of the editor, select Print and Online.

6. If necessary, on the left side of the editor, expand the Print and Online group.

7. Scroll down to the Formats rows and locate the cross-reference properties. These are the
translations you will want to edit.

8. Double-click in any of the Value fields and change the text as necessary.

NOTE The Value fields not only contain text, but they also contain format commands
in brackets—for example, {paratext} and {page}. For a list of commands that you can
use, see "Editing Cross-Reference Style Formats" on page 79.

9. Click to save your work.
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Other Activities for Cross-References
In addition to the main activities, there are some other tasks you might perform regarding this
feature.

Updating Cross-References
If you insert cross-references and then later make changes (e.g., rename the destination heading,
edit the cross-reference format), you can update (i.e., refresh) the cross-references in the open
content file.

Updating cross-references is not mandatory. When you generate output, all of the cross-references
will be updated automatically in the output. However, the cross-references in the source files will
remain as they were. You can update the cross-references in a source file as reassurance that the
links are correct.

How to Update Cross-References
1. Open a content file (e.g., topic).

2. Select Tools > Update Cross-References. The Update Cross-Reference dialog opens,
displaying the destination topics of your cross-references.

3. Click Update.
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Viewing Cross-Reference Suggestions
The Cross-Reference Suggestions window pane displays links in a project that you might want to
convert to cross-references. This window pane also provides you with the option to convert the
selected links to cross-references.

For example, if you have regular text hyperlinks (<a> tags), you might want to convert them,
because cross-references change dynamically and are therefore usually preferred over text
hyperlinks.

How to View Cross-Reference Suggestions
1. Open a project.

2. Select Analysis > Suggestions > Cross-Reference Suggestions.

The Cross-Reference Suggestions window pane opens.

3. Double-click a file to open it in the XML Editor. The file opens and highlights the cross-
reference suggestion.

How to Convert Cross-Reference Suggestions
1. Open a project.

2. Select Analysis > Suggestions > Cross-Reference Suggestions.

The Cross-Reference Suggestions window pane opens.

3. Do one of the following:

n Click the Convert to Cross-References button in the local toolbar.

OR

n Right-click any file in the Cross-References Suggestions window pane and from the
context menu, select Convert to Cross-References.

The Convert to Cross-Reference dialog opens.

4. In the Convert to Cross-References dialog, you can make selections from the following
options.
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TARGET OPTIONS

In the Target Option field, select one of the following to indicate how you want the destination
file to open when the link is clicked.

n Link Target This uses the target that is set in the original link.

n Target Frame This enables the Target Frame field (immediately below), which you can
use to select one of the following target frame options.

l Page Default The destination file opens in the same window as the output window.

l Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

l New Window The destination file opens in a new browser window.

l Same Frame The destination file opens in the same window frame as the current
topic.

l Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its
own frameset.

l Popup Window The destination file opens in a popup box on top of the current topic.
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SCREEN TIP OPTIONS

In the Screen Tip Option field, select one of the following to add a screen tip to the link. This is
useful when it comes to accessibility.

n Link Alt Text This uses the screen tip text that is set in the original link.

n Screen Tip This uses the screen tip text that you enter in the Screen Tip field
(immediately below).
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CROSS-REFERENCE STYLE CLASS

In the XRef Class field, you can set the cross-reference's style class and format . The style
class is previewed to the right.

n Edit You can click Edit to change the selected cross-reference style class. This opens
the Edit Cross-Reference Style Class Dialog.

n New You can click New to create a new cross-reference style. This opens the New
Cross-Reference Style Class Dialog.

5. Click OK. A message indicates how many files have been updated.
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How to Include Cross-Reference Suggestions in a
Report

1. Open a report.

2. In the Report Editor, click the General tab.

3. In the Tables field, scroll down to the Links section.

4. Click the Cross-Reference Suggestions check box.

5. Click Generate. The generated report will include cross-reference suggestions.
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CHAPTER 5

Drop-Downs
Supported In:

Drop-down text is a feature that lets you click a hotspot to expand and collapse specified content
below it.

This chapter discusses the following:

Inserting Drop-Down Text 89

Creating Drop-Down Effects in FrameMaker Source Documents 92

Editing Drop-Down Effects 93

Removing/Unbinding Drop-Down Text 99

Deleting Drop-Down Text 99
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Inserting Drop-Down Text
The following steps show you how to create a new drop-down effect.

How to Insert Drop-Down Text
1. Open the content file.

2. In the XML Editor type and format the content that will become the drop-down hotspot and
the drop-down body.

3. Highlight all of the paragraphs that you want to be part of the drop-down effect, including the
first paragraph, which will contain the hotspot.
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4. Select Insert > Drop-Down Text.

The selected content is converted to a drop-down effect, and it now has brackets around it in
the XML Editor (if markers are turned on). The hotspot has a blue down arrow to the left of it.

NOTE If you only selected one paragraph when creating a drop-down, Flare adds
some generic text after the heading for you to replace.

5. (Optional) If you want to designate a specific portion of the first paragraph to serve as the
hotspot, first highlight that text.
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Then in the Insert ribbon, click the down arrow in the Drop-Down Text field and select Drop-
Down Hotspot. (Alternatively you can select the same option from the right-click menu.)

6. Click to save your work.
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Creating Drop-Down Effects in
FrameMaker Source Documents

The following steps show you how to create a new drop-down effect in a FrameMaker source
document (if you plan to import that document into Flare). After you import the document, the drop-
down effect will automatically be created in the XML Editor.

How to Create a Drop-Down Effect in a
FrameMaker Source Document
The following steps may vary in different versions of FrameMaker.

1. Open the FrameMaker document.

2. In FrameMaker, create the two drop-down paragraph styles that are required for producing
this effect. This is a one-time step in the document. Afterwards, you can simply select the
newly created styles when specifying drop-down text. To create the two styles, do the
following.

a. In FrameMaker, select Format > Paragraphs > Designer. The Paragraph Designer
opens.

b. From the Commands field, click the down arrow and select New Format. The New
Format dialog opens.

c. In the Tag field, type PullDownButton.

d. Make sure that the Store in Catalog check box has a check mark.

e. Make sure that the Apply to Selection check box does NOT have a check mark in it
(unless you want the style to immediately be applied to the paragraph where your
cursor is placed).

f. Click Create.

g. Follow these same steps to create a paragraph style called PullDownBody.

h. Close the Paragraph Designer.

3. In the FrameMaker document, place your cursor in the paragraph that you want to serve as
the drop-down hotspot in the online output (i.e., when the user clicks that hotspot, the text
below that is identified as the drop-down body will be shown or hidden).
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4. From the styles drop-down menu or from the paragraph catalog, select PullDownButton.

5. Highlight the paragraph(s) that you want to serve as the drop-down body in the online output.

6. From the styles drop-down menu or from the paragraph catalog, select PullDownBody.

7. Save the FrameMaker document.

Editing Drop-Down Effects
You can edit drop-down text that you have inserted into a topic in at least three different ways: (1)
edit the content in the drop-down text, (2) edit the style of drop-down text, and (3) unbind (or
remove) the drop-down effect. Following are steps to edit drop-down content and styles.

How to Edit Drop-Down Content
1. In the XML Editor, click in the area containing the drop-down hotspot or drop-down body.

Then add, remove, or replace the content as necessary.

2. Click to save your work.
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EXAMPLE You have drop-down text in a topic that contains the words "click here" as the
hotspot, then one paragraph and an image in the drop-down body.

If you want to change the text of the hotspot to "see this," you would simply replace the
hotspot text between the small brackets in the topic.

If you want to add another paragraph in the drop-down body, you would simply click
somewhere in the drop-down body, press ENTER, and type the additional paragraph.

And if you want to edit an image in the drop-down body, you would simply edit the image
just as you would if it were not contained in a drop-down (e.g., right-click the image and
select Edit With MadCap Capture.
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How to Edit the Style of a Drop-Down Effect
You can edit the style (e.g., font, color) of a drop-down hotspot or body. When you do this, the style
changes for all drop-down text in any topics in your project.

EXAMPLE You want to change the font for your drop-down hotspots to red and italic. The
following steps show you how to accomplish this.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Complete one of the following sets of steps, depending on whether you want to use the
Simplified view or Advanced view in the Stylesheet Editor.

n Simplified The Simplified view displays styles in a grid view and is often best for brand
new users.

This view provides an easy way to apply properties to styles, with format options
available from a toolbar and dialogs (similar to the way one would use an interface
such as Microsoft Word). In some cases, only the most common property options are
available in the Simplified view (e.g., font, letter/word spacing, paragraph
alignment/indentation, autonumbering format, borders, background). One advantage of
the Simplified view is that you can apply a property to multiple styles at the same time.
You can also click a check box to hide the properties in the editor, allowing you to see
only the styles.

n Advanced The Advanced view displays styles in a tree structure, and despite the name,
is user friendly for authors of all levels.

For the properties, you can toggle between a grouped display and an alphabetical
display. The Advanced view of the Stylesheet Editor lets you edit more settings than are
available in the Simplified view. In addition, the Advanced view lets you see and apply
settings to multiple mediums and media queries at the same time.

IF USING SIMPLIFIED VIEW

a. In the local toolbar, make sure the first button displays (which means
that the Simplified view is currently shown in the editor). If the button displays

instead, then click it.

b. In the upper-left corner of the editor, click in the drop-down field and select
.
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c. From the grid in the bottom portion of the editor, find and select the appropriate style,
depending on what you want to change.

n MadCap|dropDown This style affects the entire container holding a drop-down
effect, including the image that is shown when a drop-down effect is open or
closed.

n MadCap|dropDownBody This style affects the content that is shown when users
open the drop-down effect.

n MadCap|dropDownHead This style affects the entire container holding a drop-
down hotspot (i.e., the paragraph where the drop-down link is located).

n MadCap|dropDownHotSpot This style affects the text in the first paragraph of a
drop-down effect that serves as the link for opening the drop-down body.

d. In the local toolbar of the editor, click . The Properties dialog opens.
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e. Use the tabs and fields in the Properties dialog to change values for any of the style's
properties.

f. In the Properties dialog, click OK.

IF USING ADVANCED VIEW

a. In the local toolbar, make sure the first button displays . If the button
displays instead, then click it.

b. In the upper-left corner of the editor, click in the drop-down field and select
.

c. On the left side of the editor, find and select the appropriate style, depending on what
you want to change.

n MadCap|dropDown This style affects the entire container holding a drop-down
effect, including the image that is shown when a drop-down effect is open or
closed.

n MadCap|dropDownBody This style affects the content that is shown when users
open the drop-down effect.

n MadCap|dropDownHead This style affects the entire container holding a drop-
down hotspot (i.e., the paragraph where the drop-down link is located).

n MadCap|dropDownHotSpot This style affects the text in the first paragraph of a
drop-down effect that serves as the link for opening the drop-down body.
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d. From the Show drop-down list on the upper-right side of the editor, select

. The most relevant properties for that style are shown on the
right side of the editor.

e. (Optional) You can use the toggle button in the local toolbar to show properties below
in a group view or an alphabetical view .

f. Locate the property you want to change.

g. The area to the right of the property is used for selecting and entering values. If you
know how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on
the type of property, the appropriate controls and options display, allowing you to
choose or enter values (e.g., select from a drop-down list, click a button, complete
fields in a dialog or popup). If you completed values in a popup, click OK at the bottom
of the box.

Following are some of the more common properties that you might change:

n mc-closed-image This style, located in the Unclassified property group, lets you
select an image to be shown next to the drop-down effect when it is in a closed
state. To use this property, first select the MadCap|dropDown style.

n mc-closed-image-alt-text This style, located in the Unclassified property group,
lets you set alternate text for the drop-down effect when it is in a closed state.

n mc-open-image This style, located in the Unclassified property group, lets you
select an image to be shown next to the drop-down effect when it is in an open
state. To use this property, first select the MadCap|dropDown style.

n mc-open-image-alt-text This style, located in the Unclassified property group, lets
you set alternate text for the drop-down effect when it is in an open state.

n mc-image-spacing This style, located in the Unclassified property group, lets you
set the spacing around the image next to the drop-down.

3. Click to save your work.
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Removing/Unbinding Drop-Down Text
If you have inserted drop-down text into a topic and want to keep the text but remove (or "unbind")
the drop-down effect so that it is displayed as normal text, use the following steps. If you want to
delete the drop-down text, therefore removing all of its text from the topic, see "Deleting Drop-Down
Text" below.

How to Remove/Unbind Drop-Down Text
1. Open the content file.

2. Right-click the down arrow at the beginning of the drop-down text.

3. From the drop-down menu, select Unbind Drop-Down Text. The drop-down effect is removed,
converting the section to normal text.

4. Click to save your work.

Deleting Drop-Down Text
If you have inserted drop-down text into a content file (e.g., topic, snippet) and want to delete it,
therefore removing all of its text from the topic, use the following steps. If you want to keep the text
but remove the drop-down effect so that it is displayed as normal text, see "Removing/Unbinding
Drop-Down Text" above.

How to Delete Drop-Down Text
1. Open the content file.

2. Right-click the down arrow at the beginning of the drop-down text.

3. From the drop-down menu, select Delete. The drop-down text is removed from the topic.

4. Click to save your work.
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CHAPTER 6

Expanding Text
Supported In:

Expanding text is a feature that lets you click a hotspot to expand and collapse content that
appears after it in the same paragraph or other block element.

This chapter discusses the following:

Inserting Expanding Text 101

Editing Expanding Text 104

Removing/Unbinding Expanding Text 108

Deleting Expanding Text 108
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Inserting Expanding Text
Creating an expanding text feature requires only a few simple steps.

How to Insert Expanding Text
1. Open the content file.

2. In the XML Editor type and format the content that will become the expanding text.

3. Highlight the portion of the paragraph that you want to be used as the hotspot. If you do not
select any text in the paragraph, it will all become the hotspot.

NOTE Although this feature is called "expanding text," the content does not have to
be strictly text only. For example, you can use a small image for the hotspot.
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4. Select Insert > Expanding Text.

The selection is now surrounded by brackets in the XML Editor (if markers are turned on). The
hotspot appears with an icon next to it. A second set of empty brackets follows the
hotspot.

NOTE The font used in the expanding text depends on the settings specified for the
MadCap|expandingHead and MadCap|expandingBody styles in your stylesheet.

5. In the empty bracket, type the body text for the expanding effect.
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NOTE If you do not have markers enabled, you will not see the empty bracket. To

enable markers, click the down arrow next to in the local toolbar of the
XML Editor, then select Show Markers.

6. (Optional) If you want to adjust the text that serves as the hotspot, you can highlight the text
in the current hotspot area. Then in the Insert ribbon, click the down arrow in the Expanding
Text field and select Expanding Hotspot. This pushes any text after your selecting into the
second set of brackets.

7. Click to save your work.
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Editing Expanding Text
You can edit expanding text that you have inserted into a topic in at least three different ways: (1)
edit the content in the expanding text, (2) edit the style of expanding text, and (3) unbind (or
remove) the expanding text effect. Following are steps to edit expanding text content and styles.
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How to Edit the Content in Expanding Text
The first way to edit expanding text is to change the actual content in the expanding text heading
(or hotspot) or in the expanding text body.

1. Open the content file.

2. In the XML Editor, click in the area containing the expanding text hotspot or body. Then add,
remove, or replace the content as necessary.

3. Click to save your work.

EXAMPLE You have expanding text in a topic that contains the words "click here" as the
hotspot, and the rest of the sentence after the hotspot is the expanding text body. If you
want to change the text of the hotspot to "see this," you would simply replace the hotspot
text (which is the text between the first set of brackets). And if you want to add another
sentence to the expanding text body, you would simply click at the end of the current
expanding text body (within the second set of brackets) and type the additional sentence.
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How to Edit the Style in Expanding Text
You can edit the style (e.g., font, color) of an expanding text hotspot or body. When you do this, the
style changes for all expanding text in any topics in your project.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. On the left side of the editor, find and select one of the expanding text styles:

n MadCap|expanding This style affects the entire container holding an expanding text
effect, including the image that is shown when an expanding text effect is open or
closed.

n MadCap|expandingBody This style affects the expanded text portion of an expanding
text effect (i.e., the area that is displayed or hidden when users click the hotspot link).

n MadCap|expandingHead This style affects the hotspot portion of an expanding text
effect.

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.
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Following are some of the more common properties that you might change:

n mc-closed-image This style, located in the Unclassified property group, lets you select
an image to be shown next to the expanding text effect when it is in a closed state. To
use this property, first select the MadCap|expanding style mentioned above.

n mc-closed-image-alt-text This style, located in the Unclassified property group, lets you
set alternate text for the expanding text effect when it is in a closed state.

n mc-open-image This style, located in the Unclassified property group, lets you select an
image to be shown next to the expanding text effect when it is in an open state. To use
this property, first select the MadCap|expanding style mentioned above.

n mc-open-image-alt-text This style, located in the Unclassified property group, lets you
set alternate text for the expanding text effect when it is in an open state.

n mc-image-spacing This style, located in the Unclassified property group, lets you set
the spacing around the image next to the expanding text effect.

9. Click to save your work.
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Removing/Unbinding Expanding Text
If you have inserted expanding text into a topic and want to keep the text but remove (or "unbind")
the expanding text effect so that it is displayed as normal text, use the following steps. If you want
to delete the expanding text, therefore removing all of its text from the topic, see "Deleting
Expanding Text" below.

How to Remove/Unbind Expanding Text
1. Open the content file.

2. Hover over the expanding text icon until the cursor becomes an arrow, then right-click it.

3. From the drop-down menu, select Unbind Expanding Text. The expanding text effect is
removed, converting the section to normal text.

4. Click to save your work.

Deleting Expanding Text
If you have inserted expanding text into a topic and want to delete it, therefore removing all of its
text from the topic, use the following steps. If you want to keep the text but remove the expanding
text effect so that it is displayed as normal text, see "Removing/Unbinding Drop-Down Text" on
page 99.

How to Delete Expanding Text
1. Open the content file.

2. Hover over the expanding text icon until the cursor becomes an arrow, then right-click it.

3. From the drop-down menu, select Delete. The expanding text is removed from the topic.

4. Click to save your work.
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CHAPTER 7

External Links—HTML, PDF,
Microsoft Office
Supported In:

An external link is an "a" link (not a cross-reference) that lets you connect to another file (e.g., HTM,
HTML, XML, PDF, Microsoft Office files) outside of your output. These steps involve a little planning
ahead. You need to know the location where your files will be published, as well as the names of
your output files.
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How to Insert a Link to an External File
1. (Optional) If you need to link to a specific place in the destination file that you are creating

(e.g., a subheading in a PDF file), insert a named destination or a bookmark at that location.
Named destinations are used in PDFs.

2. In the source topic where you want to insert the link, use the normal steps for inserting the
type of navigation link that you want to create (text hyperlinks, topic popups, image
hyperlinks).

n "Inserting Text Hyperlinks" on page 230

n "Inserting Topic Popups" on page 354

n "Inserting Image Hyperlinks" on page 116

3. From the Link to drop-down field, select External File.

NOTE If you want to link to a file that you've placed on a web server, instead of
selecting "External File," you can select "Website" instead, and then enter the URL
pointing to that file.

4. In the External File field, enter the path for the link, depending on the output type you are
using.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the External File field.

MOST OUTPUT TYPES (E.G., PDF, HTML)

Enter the relative path from the source output topic to the destination topic, using a pair of
periods to represent each folder level.
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EXAMPLE — PDF Outputs

From your project you are creating one PDF file called "Main-PDF" and another called
"Second-PDF." Suppose that you plan to publish these outputs in the same folder on
a server.

In the Main PDF, you want to create a link that opens the second PDF, and
immediately goes to a specific heading within it (where a topic from your project
begins).

First of all, you open the destination topic (the one that will be in the Second PDF) in
your project and add a named destination before the first heading. Let's say you call
it "TopicSecondDestination."

In that case, when you create the link in the other topic (the one that will be in the
Main PDF), you would enter the following in the External File field:

../../Second-PDF.pdf

And in the Named Destination field, you enter the following:

TopicSecond Destination
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EXAMPLE — HTML5 Outputs

From your project you are creating one HTML5 output called "Main" and another
HTML5 output called "Second." Suppose that you plan to publish these outputs in
adjacent folders on a server. The first output will be stored in a folder named "Main,"
and the other output will be placed in a folder named "Second."

In the Main output, you want to create a link in a topic that opens a different topic in
the Second output. The destination topic is located within that HTML5 output in a
folder named "C-Second-Outputs" and it is named "Topic-Online-Second-Output.htm."

In that case, you would enter the following in the External File field:

../../../Second/Content/C-Second-Outputs/Topic-Online-Second-
Output.htm
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HTML HELP (CHM FILES)

Use one of the following:

n NameOfOutput.chm::/NameOfTopic.htm

n mk:@MSITStore:PathToOutput\NameOfOutput.chm::/NameOfTopic.htm

Use the first method if you plan to publish your CHM files to the same folder (recommended).
Use the second method if you plan to publish your CHM files in different folders.

EXAMPLE — CHM Outputs

You have a project called "FirstHelp" and another called "SecondHelp." Also, let's
assume that the first project will generate a CHM file named "First.chm," and the
second will generate a CHM file named "Second.chm." (The names of the CHM files
can be specified on the General tab of the Target Editor. Enter the desired name in
the Output File field. If you plan to publish the files to the same folder, they need to
have different names.)

Suppose you want to create a text hyperlink in a topic called "Welcome," which is
located within the FirstHelp project. When a user clicks on this link, you want it to
open a topic called "About the Company," which is located within the SecondHelp
project. Therefore, you open the Welcome topic in the FirstHelp project. Then you
highlight the text to be used in the hyperlink, and you select Insert > Hyperlink. The
Insert Hyperlink dialog opens. Next, from the drop-down field you select External File.
What do you enter in the External File field?

We will take a look at two different situations. First, let's say that you plan to publish
both CHM files to the same folder (perhaps on your company's intranet). In that case,
you would enter the following:

SecondHelp.chm::/About the Company.htm

On the other hand, let's say that you plan to publish First.chm to one folder, and you
plan to publish Second.chm to a separate folder, such as the following:
C:\Documentation\More Help. In that case, you would enter the following:

mk:@MSITStore:C:\Documentation\More
Help\SecondHelp.chm::/About the Company.htm
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NOTE If you want to link content to an external CHM file, an alternative is to use the
"HTML Help File" option from the "Link to" field, instead of the "External File" option.

5. (Optional) You can click to select any bookmarks within the destination file, or if you
need to select a named destination in a PDF file. See "Inserting Bookmarks" on page 11 and
"Named Destinations" on page 155.

6. In the link dialog, click OK.

7. Click to save your work.

8. Generate the output for the projects and publish the files to the appropriate location(s).

NOTE With Mark of the web enabled in your target, some links to external files may not
work properly in some versions of Internet Explorer when pages are viewed locally (file://).
This is not an issue if pages are viewed online (http://). For more information about MOTW,
see Microsoft's MSDN website.

NOTE The Eclipse Viewer cannot display PDFs opened from links.
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CHAPTER 8

Image Hyperlinks
Supported In:

After you insert an image, you can turn that picture into a hyperlink, connecting it to another topic, a
topic in an imported HTML Help file, an external file (such as a website), or an email.After you insert
an image, you can turn that picture into a hyperlink.

This chapter discusses the following:

Inserting Image Hyperlinks 116

Editing Image Hyperlinks 121

Creating Image Maps 128
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Inserting Image Hyperlinks
Use the following steps to create an image hyperlink.

How to Insert an Image Hyperlink
1. Open the content file.

2. In the XML Editor, right-click the image that you want to use as a hyperlink.

3. In the context menu, select Hyperlink Image. The Insert Hyperlink dialog opens.

4. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based on the option you choose, the section below gives you a list of
selections or additional fields to complete.

FILE IN PROJECT 

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.
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Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 11.

You can also select if you have selected a PDF file. See "Named Destinations" on page
155.

PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare will insert a new bookmark at that
destination in the file.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click to display and select any bookmarks within the destination file, or if
you have selected a PDF file. See "Inserting Bookmarks" on page 11 and "Named
Destinations" on page 155.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 109.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.
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WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).

EMAIL

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list
below).
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

n Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show Folders
button is selected, the area splits into two. The folder is shown on
the left side, and the files and subfolders within it are shown on the right.

n Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

5. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output. This is added not only a "title" attribute, but as an "alt"
(alternate text) attribute as well.

6. (Optional) Next to the Style Class field, click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles (a.NameOfStyleClass) from
your stylesheet to the link. After you select a style class in the dialog, click OK. The Style Class
field displays the selected style. (If you do not specify a style class, Flare uses the parent "a"
style.)
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7. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open. This option can be used to open the destination topic or file in a popup.

n Page Default The destination file opens in the same window as the output window.

n Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current topic.

n Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

n Popup Window The destination file opens in a popup box on top of the current topic.

8. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through links. So when a user presses the TAB key the first time, the hyperlink with an
index value of 1 will be selected first, the link with a value of 2 will be selected next, and so on.
If you want to skip a link, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTML5, Clean XHTML,
WebHelp, WebHelp Plus.

9. Click OK. The hyperlink is added to the image in the topic. When a user hovers the cursor over
the image in the output, the cursor changes to a hand.

10. Click to save your work.

WARNING It is recommended that you avoid creating links to snippets.This is primarily
due to the nature of snippets, which are designed to be inserted into multiple files. Let's say
you have a heading style in a snippet and that snippet is then inserted into 12 different
topics. In another topic, you might decide to create a cross-reference that points to the
heading in that snippet. But which of those 12 topics is it supposed to point to in the
output? There is no way for Flare to know this, so you could end up with some very
undesirable results. For this reason, it's a good idea not to link to any content in a snippet.
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Editing Image Hyperlinks
You can edit image hyperlinks that you have inserted into a topic in the following ways: (1) edit the
destination and properties of the hyperlink, and (2) remove the hyperlink from the image.

The first way to edit image hyperlinks is to change the destination and other properties (target
frame, screen tip).

EXAMPLE You test the topic containing the image hyperlink and you notice that the wrong
destination topic is opening when you click the hyperlink. So you use the steps below to
associate the correct destination topic with the hyperlink.

How to Edit the Destination and Properties of an
Image Hyperlink

1. Open the content file.

2. In the XML Editor, right-click the image.

3. In the context menu, select Hyperlink Image. The Insert Hyperlink dialog opens.

4. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based the option you choose, the section below gives you a list of selections
or additional fields to complete.
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FILE IN PROJECT 

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 11.

You can also select if you have selected a PDF file. See "Named Destinations" on page
155.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare will insert a new bookmark at that
destination in the file.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click to display and select any bookmarks within the destination file, or if
you have selected a PDF file. See "Inserting Bookmarks" on page 11 and "Named
Destinations" on page 155.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 109.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).

CHAPTER 8  123



EMAIL

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list
below).
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

n Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show Folders
button is selected, the area splits into two. The folder is shown on
the left side, and the files and subfolders within it are shown on the right.

n Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

5. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output.

6. (Optional) Next to the Style Class field, click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles (a.NameOfStyleClass) from
your stylesheet to the link. After you select a style class in the dialog, click OK. The Style Class
field displays the selected style. (If you do not specify a style class, Flare uses the parent "a"
style.)

7. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open. This option can be used to open the destination topic or file in a popup.
The other options are typically used by advanced users.

n Page Default The destination file opens in the same window as the output window.

n Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

n New Window The destination file opens in a new browser window.

CHAPTER 8  125



n Same Frame The destination file opens in the same window frame as the current topic.

n Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

n Popup Window The destination file opens in a popup box on top of the current topic.

8. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through links. So when a user presses the TAB key the first time, the hyperlink with an
index value of 1 will be selected first, the link with a value of 2 will be selected next, and so on.
If you want to skip a link, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTML5, Clean XHTML,
WebHelp, WebHelp Plus.

9. Click OK. The hyperlink is changed in the topic.

10. Click to save your work.
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How to Remove the Hyperlink From the Image
Another way to edit an image hyperlink is to remove the hyperlink effect. If you decide that you no
longer want the image to serve as a hyperlink, you can use the steps below to remove the hyperlink.
When you are finished, the image will remain in the topic, but the hyperlink effect will be removed.

1. Open the content file.

2. In the XML Editor, right-click the image.

3. In the context menu, select Hyperlink Image. The Insert Hyperlink dialog opens.

4. In the bottom-left section of the dialog, click the Remove Link button. The hyperlink effect is
removed.

5. Click to save your work.
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Creating Image Maps
After you insert an image, you can create multiple hyperlinks for specific sections of the image.
This is called an "image map." Image maps engage online users to click linked parts of an image
that reveal more information.

The image map contains a “hotspot,” which is the part of the image that contains the link as you
hover the mouse on it (e.g., text, icon). It also contains a target frame property that determines how
the link opens (e.g., popup, tab, window).

The foundation of an image map can take on several forms, such as a graphic, photo, or map. The
image map is anything with identifiable clickable areas.

CHAPTER 8  128



How to Create an Image Map
1. Open the topic.

2. In the XML Editor, right-click the image on which you want to create an image map.

3. In the context menu, select Image Map. The Image Map Editor opens, with the image
displayed.

4. In the Standard toolbar of the Image Map Editor, click one of the shape drawing buttons,
depending on the area of the image that you want to use as a hyperlink.

Click this button if you want to draw an odd shape over a section of the image.

Click this button if you want to draw a rectangle over a section of the image.

Click this button if you want to draw a circle over a section of the image.
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5. In the image, click and drag your mouse over the area to be used as a hyperlink. Release the
mouse button when you are satisfied with the size and location of the shape. You should now
see the shape on top of the image, connected by a series of points.

The Image Map Editor only draws clickable areas for the hyperlink (or hotspot). It does not
draw shapes and objects on the image. You will have to use another tool, such as MadCap
Capture, if you want to annotate the image itself.
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6. In the toolbar, click . The Area Properties displays.
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7. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based the option you choose, the section below gives you a list of selections
or additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 11.

You can also select if you have selected a PDF file. See "Named Destinations" on page
155.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare will insert a new bookmark at that
destination in the file.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click to display and select any bookmarks within the destination file, or if
you have selected a PDF file. See "Inserting Bookmarks" on page 11 and "Named
Destinations" on page 155.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 109.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).
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EMAIL

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list
below).
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

n Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show Folders
button is selected, the area splits into two. The folder is shown on
the left side, and the files and subfolders within it are shown on the right.

n Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

8. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output. This is added not only as a "title" attribute, but as an
"alt" (alternate text) attribute as well.
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9. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open.

n Page Default The destination file opens in the same window as the output window.

n Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current topic.

n Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

n Popup Window The destination file opens in a popup box on top of the current topic.

NOTE The Popup Window option is not supported in HTML5 online output formats
with Side Navigation and Top Navigation skin types. Either select an output format
that supports it, or in the Target Editor’s Skin tab, set the skin type to none.

10. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through hyperlinks in the image. So when a user presses the TAB key the first time in a
topic, the hyperlink with an index value of 1 will be selected first, the hyperlink with a value of
2 will be selected next, and so on. If you want to skip a hyperlink, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTML5, Clean XHTML,
WebHelp, WebHelp Plus.

11. Click OK.

12. If you want to add more hyperlinks to the image, select a shape button again and repeat the
steps above.

13. When you are finished creating hyperlinks on the image, click OK in the Image Map Editor.

Notice that when the object is selected in the Image Map Editor, the link property fields at the
bottom are populated with the information you provided.

14. Click to save your work.
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How to Make Image Maps Responsive
Image maps are not natively responsive; meaning the image and its clickable area do not
automatically adjust depending on the user’s device and screen size. Because of this, it is a best
practice to set the image max width style property to 100%.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Using the Advanced view, select the img style.

3. From the local toolbar, select Show: All Properties.

4. Expand Unclassified, and set the max-width property to 100%.

5. Click to save your work.

NOTE This process makes the image itself responsive in the output. If you want the
clickable areas of the map to be responsive as well, you’ll have to download a Responsive
Image Maps jQuery Plugin from a GitHub repository.

If you would rather not download the jQuery plugin, you can remove the max-width
property. This would keep the image map and clickable areas in sync as users adjust the
output, but the image map and the clickables areas would not be responsive.
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Buttons and Sections in the Image Map Editor
Following are descriptions of buttons and sections found in the Image Map Editor.

Edit Use this menu to select basic editing options (such as undo, redo, cut, copy, and
paste). You can also open the properties for an object or apply conditions to it.

Click this button to toggle between seeing a clear image of the picture and a faded
image. This is only for your internal use; it will not affect the output.

Click this button to hide the shapes that you draw over areas of the image. This is
only for your internal use; it will not affect the output.

Click this button to fill the shapes that you draw over areas of the image. This is
only for your internal use; it will not affect the output.

Click this button to open the Area Properties dialog, which lets you find and select
a destination file to link to a shape that you've drawn. You must select a shape
before this button is enabled.

Click this button to delete a selected point in the editor.

Click this button to enable "Select" mode so that you can click on shapes that you
have drawn in the editor.

Click this button to draw a polygon shape over an area of the image. You can then
select the shape and link it to a destination file.

Click this button to draw a rectangle shape over an area of the image. You can
then select the shape and link it to a destination file.

Click this button to draw a circle shape over an area of the image. You can then
select the shape and link it to a destination file.

Click this button to bring a shape up one layer (if it is overlapped by one or more
other shapes).
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Click this button to bring a shape up to the top layer (if it is overlapped by one or
more other shapes).

Click this button to move a shape down one layer (if it is overlapped by one or
more other shapes).

Click this button to move a shape down to the bottom layer (if it is overlapped by
one or more other shapes).

Opens the Condition tags dialog, which lets you apply condition tags to content.

Link Displays the path to the linked destination file for the selected object. This field is
automatically populated after you click to find and select a destination file.

Screen
Tip

Displays the screen tip (or "alt" text) for the selected object. An alt tag provides a
textual equivalent for the image. This code allows the page to be usable by
persons with graphics turned off or who are blind and using a screen reader. This
field is automatically populated after you click and enter the screen tip text.

Tab Index Displays the tab index value that you entered in the Area Properties dialog for the
selected object. The tab index is a value to specify the order in which users can tab
through links on an image. So when a user presses the TAB key the first time, the
link with an index value of 1 will be selected first, the link with a value of 2 will be
selected next, and so on. If you want to skip a link, enter -1 in that field. This
feature is supported only in web outputs—HTML5, Clean XHTML, WebHelp,
WebHelp Plus.
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Overlapping Objects and PDF Output
PDFs are limited to rectangular-shaped image map objects. Therefore, if you have an image map
with circle or polygon objects, those will be redrawn as rectangles in the PDF output. If this occurs,
Flare will include a compile warning. Also, keep in mind that if objects overlap one another, the one
on the top layer (usually the last one drawn) takes precedence.

EXAMPLE You have an image of the Olympic circles inserted into a topic:

You create an image map, drawing round objects around each of the five circles, and you
link each of these objects to a different website. For the purposes of this example, we're
showing dark green circles to represent each image map object:

Notice that the circles overlap in some places. In those locations, the circle object that is on
the top layer will win. Therefore, if the user clicks in that area, the website linked to the
object on top will be opened.
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Now, if you generate online output, such as HTML5, the circle shapes on the image map
will be retained, just as you see them above. But if you generate PDF output, each of the
circle objects will be converted to a rectangle, like this:

Therefore, the link areas (as well as the overlapping areas) are adjusted accordingly.
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CHAPTER 9

Keyword Links
Supported In:

A keyword link is a Help control that lets you open topics related to the current topic based on index
keywords that they share.

This chapter discusses the following:

Inserting Keyword Links 143

Editing Keyword Links 145

Deleting Keyword Links 149
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Inserting Keyword Links
Supported In:

Inserting keyword links requires only a few simple steps.

How to Insert a Keyword Link
1. Insert index keywords into the appropriate files.

2. Open the content file.

3. In the XML Editor, click in the topic where you want to insert the link (usually at the bottom of
the topic).

4. Select Insert > Keyword Link Control (K-link).

The Insert Keyword Link Control dialog opens. The index keywords that you have inserted into
topics are listed on the left side of the dialog.

5.

Do one of the following:

n In the All Keywords section, double-click an index keyword that you want to add to the
keyword link.

n In the All Keywords section, click on an index keyword that you want to add to the
keyword link. Then click .

The index keyword is added to the "All Keywords" section on the right side of the dialog.
Do this for each index keyword that you want to add to the link.
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6. (Optional) If you want to specify other options for the control, click and make your
selections. Click OK to close the dialog when you are finished.

n Style Class You can select the style class to be used for the control.

n Label You can change the text shown on the control.

n Display topics in You can specify that the links should be displayed in a popup menu
(same as default) or as a simple list.

NOTE For projects that are merged, the list option is supported for standard
merging (e.g., linking to an FLPRJ file in the table of contents). However, it is
not supported for automerging in WebHelp Plus output.

n Target Frame You can choose the type of frame used when a link is clicked.

l Page Default The destination file opens in the same window as the output window.

l Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

l New Window The destination file opens in a new browser window.

l Same Frame The destination file opens in the same window frame as the current
topic.

l Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its
own frameset.

l Popup Window The destination file opens in a popup box on top of the current topic.

7. Click OK. The keyword link is added to the topic.

8. Click to save your work.
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Editing Keyword Links
You can edit a keyword link that you have inserted into a topic.

How to Change the Keywords Associated With a
Keyword Link
The first way to edit a keyword link is to change the keyword(s) associated with the link, as well as
specify various other optional settings.

EXAMPLE You have a keyword link that has two keywords ("Projects" and "Systems")
associated with it. You might want to remove the "Projects" keyword from the link so that it
only contains the "Systems" keyword. The steps below show you how to do this.

1. Open the content file.

2. In the XML Editor, right-click the keyword link.

3. In the context menu, select Edit Keyword Link. The Insert Keyword Link Control dialog opens.
The keywords currently associated with the link are listed on the right side of the dialog. The
keywords that you have inserted into all other topics are listed on the left side of the dialog.

4. If you want to add a keyword to the link, click on that keyword on the left (All Keywords) side
of the dialog. Then click . If you want to remove a keyword from the link, click on that
keyword on the right (Selected Keywords) side of the dialog. Then click .

Repeat this for each keyword that you want to add to or remove from the link. When you are
finished, the keywords associated with the link should be in the Selected Keywords section,
and the keywords not associated with the link should be in the All Keywords section.
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5. (Optional) If you want to specify other options for the control, click and in the dialog
select any of the following. Click OK to close the dialog when you are finished:

n Style Class You can select the style class to be used for the control.

n Label You can change the text shown on the control.

n Display topics in You can specify that the links should be displayed in a popup menu
(same as default) or as a simple list.

NOTE For projects that are merged, the list option is supported for standard
merging (e.g., linking to an FLPRJ file in the table of contents). However, it is
not supported for automerging in WebHelp Plus output.

n Target Frame You can choose the type of frame used when a link is clicked:

l Page Default The destination file opens in the same window as the output window.

l Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

l New Window The destination file opens in a new browser window.

l Same Frame The destination file opens in the same window frame as the current
topic.

l Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its
own frameset.

l Popup Window The destination file opens in a popup box on top of the current topic.

6. Click OK. The Insert Keyword Link Control dialog closes, and the link is now changed.

7. Click to save your work.
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How to Edit the Style of a Keyword Link
You can edit the style of a keyword link. When you do this, the style changes for all keyword links in
any topics in your project. Also, keep in mind the various rules that pertain to keyword links.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the Show Styles field and select Show Link Styles
or Show Dynamic Effects Styles. Different styles are displayed with each filter.

4. On the left side of the editor, find and select one of the following styles, depending on what
you want to accomplish. You can use a general style (which starts with "helpControl") if you
want to modify all types of Help control links (concept, keyword, and related topic links).
Alternatively, you can use a specific style (which starts with "keywordLink") if you want to
modify only concept links in your project.

n MadCap|helpControlList Edit this style to change the look of the entire list (<ul>
element) when links are displayed in a list, rather than in a popup.

n MadCap|helpControlListItem Edit this style to change the look of individual items in the
list (<li> elements) when links are displayed in a list, rather than in a popup.

n MadCap|helpControlListItemLink Edit this style to change the look of links in the list
(<a> elements) when links are displayed in a list, rather than in a popup.

n MadCap|helpControlMenu Edit this style to change the look of links (i.e., menu items)
when links are displayed in a popup, rather than in a list. This particular style controls
the entire list.

n MadCap|helpControlMenuItem Edit this style to change the look of links (i.e., menu
items) when links are displayed in a popup, rather than in a list. This particular style
controls the individual list items.

n MadCap|keywordLink Edit this style to change the look of the heading for keyword
links. The following three keyword link styles inherit properties from this style.

n MadCap|keywordLinkControlList Edit this style to change the look of the entire list (<ul>
element) when keyword links are displayed in a list, rather than in a popup.
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n MadCap|keywordLinkControlListItem Edit this style to change the look of individual
items in the list (<li> elements) when keyword links are displayed in a list, rather than in
a popup.

n MadCap|keywordLinkControlListItemLink Edit this style to change the look of links in
the list (<a> elements) when keyword links are displayed in a list, rather than in a popup.

NOTE You can also change a pseudo class of a link style (e.g.,
MadCap|keywordLink.focus or MadCap|keywordLink.hover) if you want to modify the
look of the keyword link when it is in a certain state (e.g., when it has focus or when
the cursor is hovering over it).

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

For example, to change the link label, you would edit the mc-label property.

9. Click to save your work.
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Deleting Keyword Links
There are two parts to a keyword link—(1) the keyword link itself and (2) the index markers inserted
into topics that associate the topic with a particular keyword link. The following steps show you
how to delete both.

How to Delete a Keyword Link
If you no longer need a keyword link that you have previously inserted into a topic, you can delete it
from a topic.

1. Open the content file.

2. Right-click the keyword link that you want to delete.

3. From the context menu, select Delete. The keyword link is removed from the topic.

4. Click to save your work.

How to Delete an Index Marker
The following steps show you how to delete an index marker that you have previously inserted into
a topic so that the topic is no longer associated with a particular keyword link.

1. Open the content file.

2. Right-click the index marker that you want to delete.

3. From the context menu, select Delete. The index marker and its keywords are removed from
the topic.

4. Click to save your work.
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CHAPTER 10

Links to Web Topics
If you generate HTML5 or WebHelp, WebHelp Plus targets, you can create links to specific topics in
the output.

This chapter discusses the following:

Creating Links to HTML5 Topics 151

Creating Links to WebHelp and WebHelp Plus Topics 153
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Creating Links to HTML5 Topics
You can create links to specific topics in HTML5 output. You can also create links that incorporate
search strings and skin references.

How to Create Links to HTML5 Topics
1. Perform the steps for creating one of the following kinds of links:

n "Creating Image Maps" on page 128

n "Inserting Image Hyperlinks" on page 116

n "Inserting Text Hyperlinks" on page 230

n "Inserting Topic Popups" on page 354

2. In the dialog that opens for creating the link, click the Link to field and select Website.

3. Enter the path to the website. You can also include a specific topic, a search string, and/or
skin. When inserting the link, you can use the following structure.

http://[website]/[main entry file].htm#[path/name of topic]&searchQuery=[search
string]&firstPick=true&skinName=[skin name]

After the hash mark (#), you can specify any combination of the parameters (cshid,
searchQuery, firstPick, skinName), separated by ampersands (&). The order of the
parameters does not matter:

n Main entry file Provide the path to the main entry file for your output. The file name is
determined by whatever you enter into the Output File field in the General tab of the
Target Editor. If you do not provide a name in this field, the name "Default" will be used.

n searchQuery This is an optional element that automatically performs a search for a
specific string.

n firstPick This element can be used in conjunction with the search string. If you include
the first pick option, the first topic found with the specified search string will be opened
automatically. If you do not include this element, the search results will simply be
displayed; the first topic will not be opened automatically.

n skinName You can specify a skin directly in the link, which will override the skin
associated with that topic in the CSH alias file.
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EXAMPLES In the following examples, these values are used:

n Default.htm = main entry file name

n Soccer.htm = topic in the project, located in subfolder called "Sports"

n World Cup Standings = search term

n Green = skin name

<a href="http://my.mycompany.com/Default.htm#Sports/Soccer.htm">Click here to
open</a>

<a href="http://my.mycompany.com/Default.htm#searchQuery=World Cup
Standings&firstPick=true">Click here to open</a>

<a
href
="http://my.mycompany.com/Default.htm#Sports/Soccer.htm&skinName=Green">Click
here to open</a>
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Creating Links to WebHelp and
WebHelp Plus Topics

IMPORTANT WebHelp and WebHelp Plus are deprecated in Flare, which means that they
are slated to be removed in a future version.

You can create links to specific topics in WebHelp and WebHelp Plus output. You can also create
links that incorporate search strings and skin references.

How to Create Links to WebHelp and WebHelp
Plus Topics

1. Perform the steps for creating one of the following kinds of links:

n "Creating Image Maps" on page 128

n "Inserting Image Hyperlinks" on page 116

n "Inserting Text Hyperlinks" on page 230

n "Inserting Topic Popups" on page 354

2. In the dialog that opens for creating the link, click the Link to field and select Website.

3. Enter the path to the website. You can also include a specific topic, a search string, and/or
skin. When inserting the link, you can use the following structure.

http://[website]/[main entry file]_CSH.htm?[search string]|FirstPick#[path/name
of topic]|[skin name]

n Main entry file_CSH.htm This is the main entry file for your output. The file name is
determined by whatever you enter into the Output File field in the General tab of the
Target Editor. If you do not provide a name in this field, the name "Default" will be used.
After the file name, it is important that you add an underscore followed by "CSH."
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NOTE You do not need to include the "_CSH" portion in the file name of the
topic in Flare. You only need to add " _CSH" to the web page hyperlink
connecting to that topic.

n Search string This is an optional element that automatically performs a search for a
specific string.

n First pick This element can be used in conjunction with the search string. If you include
the first pick option, the first topic found with the specified search string will be opened
automatically. If you do not include this element, the search results will simply be
displayed; the first topic will not be opened automatically.

n Skin name You can specify a skin directly in the link, which will override the skin
associated with that topic in the CSH alias file.

In the following examples, these values are used:

n Default.htm = main entry file name

n Soccer.htm = topic in the project, located in subfolder called "Sports"

n World Cup Standings = search term

n Green = skin name

<a href="http://my.mycompany.com/Default_CSH.htm#Sports/Soccer.htm|Green">Click here to
open</a>

<a href="http://my.mycompany.com/Default_CSH.htm?World Cup Standings|FirstPick">Click
here to open</a>

NOTE You can complete similar URL link steps with context-sensitive Help (CSH)
identifiers.
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CHAPTER 11

Named Destinations
Supported In:

A named destination lets you point to a specific place in a PDF. In the Insert Hyperlink dialog, you
can create links to named destinations when using the "File in Project" option (if the PDF has been
added to your project) or "External File" option (if the PDF file exists outside of your project).

This process involves the following:

n Generate/Insert Named Destinations You can generate named destinations automatically in
a PDF everywhere a bookmark exists. Alternatively, you can insert named destinations into
content files manually.

n Create Links to Named Destinations You can insert hyperlinks to named destinations in a
PDF.

This chapter discusses the following:

How to Generate Named Destinations Automatically 161

How to Generate a Named Destination Manually 162

How to Create a Link to a Named Destination 163
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EXAMPLE You plan to generate a PDF file from Flare Project A. Once that is done, you plan
to add the PDF to Flare Project B. And in one of the topics of Flare Project B, you create a
hyperlink that points to a specific paragraph in the PDF.

First, you open the topic or snippet in Flare Project A where the destination paragraph will
eventually exist in the PDF, and you insert a named destination at that location:
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Next, you generate the output for the PDF.

Now you open Flare Project B. You could use a feature such as External Resources to add
the PDF to that project, or you could just copy and paste it in Windows.
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Now you open a topic in Flare Project B, and you create a hyperlink that points to the
named destination in the PDF. You follow the steps for inserting a link into a file, and you
select the PDF file. Then you click and select the named destination that you created:

CHAPTER 11  159



Now when you generate the output from Project B, you can click on the hyperlink in that
output, and the PDF will open to the specified paragraph.
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How to Generate Named Destinations
Automatically
1. Open the PDF target that will contain the named destinations (i.e., hyperlinks in another file

will point to these destinations).

2. Select the PDF Options tab.

3. In the Document Properties area, click Create named destinations for bookmarks.

NOTE This does not remove bookmarks. It simply creates named destinations next
to other bookmarks in the generated PDF if they exist.

4. Click to save your work.

5. Generate and publish the PDF.
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How to Generate a Named Destination
Manually
1. Open the topic where you want insert a named destination (i.e., hyperlinks in another file will

point to the PDF holding this destination).

2. Click in the topic where you want to insert a named destination (e.g., in front of a subheading
or a specific paragraph).

3. Select Insert > Named Destination.

The Named Destination dialog opens.

4. In the Name field, type a name for destination (do not use spaces).

5. Click OK. An icon is displayed at the appropriate location in the document (as long as your
markers are turned on).

6. Click to save your work.

7. Generate and publish the PDF containing that topic.
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How to Create a Link to a Named
Destination
1. Open the topic where you want the link to exist.

2. Highlight the text that you want to use as the link (or "hotspot").

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Insert > Hyperlink.

n Local Toolbar In the local toolbar of the XML Editor click .

n Keyboard Shortcut Press CTRL+K on your keyboard.

n Right-Click In the XML Editor, right-click and select Hyperlink.

4. From the Link to drop-down field select one of the following. Based on the option you choose,
the section below the field gives you a list of selections or additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the PDF file that you want to link to and select it. By using the
buttons in the local toolbar, you can view all files in a list, view files in their folder structure,
and use other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.
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If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

EXTERNAL FILE

This option lets you search for a file outside your project. After you select this option, enter
the path to the PDF file in the field next to the External File button.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 109.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

5. After selecting the PDF, click .

6. In the dialog that opens, select the named destination and click OK.

7. (Optional) The Link text field displays the text that you highlighted in the topic, which will be
used as the hyperlink. Leave the text as it is, unless you decide you would like to change it. If
you want to change the link text, type the new text in the field. It will replace the previously
selected text in the topic.

8. (Optional) In the Screen Tip field you can type a phrase that will appear when the end user
hovers over the hyperlink in the output.

When you enter a screen tip, it is added as a <title> tag in the markup. In addition, an <alt>
(alternate text) tag is added with the same text. This is useful when it comes to accessibility.

For more information see the online Help.

9. (Optional) Next to the Style Class field click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles from your stylesheet to the
link. You can change the appearance of the link in the Stylesheet Editor. After you select a
style class in the dialog, click OK. The Style Class field displays the selected style. (If you do
not specify a style class, Flare uses the parent "a" style.)
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10. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open (e.g., in another window, in a popup).

n Page Default The destination file opens in the same window as the output window.

n Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current topic.

n Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

n Popup Window The destination file opens in a popup box on top of the current topic.

11. Click OK. The hyperlink is added to the topic.

12. Click to save your work.
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CHAPTER 12

Related Topics Links
Supported In:

A related topics link is a Help control that provides users with list of links to topics that you've
specified as being related to the current topic. This is similar to a concept link. You might use a
related topics link if you are applying it to a topic that you want to associate with specific topics but
you do not plan to reuse the same link in other topics.

This chapter discusses the following:

Inserting Related Topics Links 167

Editing Related Topics Links 176

Deleting Related Topics Links 183
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Inserting Related Topics Links
There are a couple of methods to use for inserting related topics links. You can use the "drag-and-
drop" method or the "Insert ribbon" method.

How to Insert a Related Topics Link Using Drag-
and-Drop

1. Open the content file.

2. You can drag files from the Content Explorer or File List window pane:

n Content Explorer If you are using the Content Explorer, click the Show Files button .
The Content Explorer splits into two halves. Then on the left half of the Content
Explorer, locate and select the folder containing the topics to be included in the related
topics link.

n File List Window Pane If you want to choose files from the File List window pane, make
sure you float and position it so that you can see both the File List window pane and
XML Editor.

3. In the File List window pane or on the right half of the Content Explorer, select the topics to be
included in the link. You can hold down the CTRL or SHIFT key and click the topic file names
to select individual topics or a range of topics.

4. Drag the selected files to the appropriate location in the topic in the XML Editor. As you drag
the files, a colored vertical bar shows you where the link will be inserted when you release
mouse button.

5. Release the mouse button. The Insert Related Topics Control dialog opens. The folders and
topic files available in the project are shown on the left. The files that you selected are
automatically added to the section on the right.
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6. (Optional) You can customize the related topics link in any of the following ways.

BOOKMARK

If you want a link to point to a particular bookmark within a topic, do the following.

a. In the Selected Topics area on the right of the dialog, click on the relevant topic.

b. At the bottom of the dialog click .

c. In the Select Bookmark dialog, click on a heading or bookmark within the topic. If you
select a heading, a bookmark will be created at that spot in the topic.

NOTE If you want to remove a bookmark from the link, you can select the
bookmark in this dialog and click . This removes the bookmark from the link
only; it does not remove the bookmark from the destination topic.

d. Click OK.

STYLE CLASS

If you want to select the style class to be used for the control, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click on the style class you want to use. The main style is
"MadCap:relatedTopics," but if you create a class under that style in your stylesheet, it
will be available for selection as well.

c. Click OK.

LABEL 

If you want to change the text shown on the control, do the following.

a. At the bottom of the dialog click .

b. In the dialog, enter text in the Label field.

c. Click OK.
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POPUP MENU OR LIST 

If you want to specify that the links should be displayed in a popup menu (default) or as a
simple list, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click the down arrow in the Display topics in field and select Popup Menu
or List.

c. Click OK.

NOTE For projects that are merged, the list option is supported for standard merging
(e.g., linking to an FLPRJ file in the table of contents). However, it is not supported for
automerging in WebHelp Plus output.

TARGET FRAME

If you want to choose the type of frame used when the link is clicked, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click the down arrow in the Target Frame field and select any of the
following.

n Page Default The destination file opens in the same window as the output
window.

n Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current
topic.

n Top Frame The destination file opens in the same output window, removing all
other framesets. You might use this option, for example, if the destination topic
has its own frameset.

n Popup Window The destination file opens in a popup box on top of the current
topic.

c. Click OK.
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CUSTOM ORDER

If you want to specify that the links should be displayed in a custom order (rather than
alphabetically), do the following.

a. In the Selected Topics area on the right of the dialog, click on a topic that you want to
move up or down.

b. At the bottom of the dialog click or .

c. Click in the Use Custom Ordering field and select Yes.

7. Click OK. The related topics control is added to the topic.
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8. Click to save your work.
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How to Insert a Related Topics Link Using the
Insert Ribbon

1. Open the content file.

2. In the XML Editor, click in the topic where you want to insert the link (usually at the bottom of
the topic).

3. Select Insert > Related Topics Control.

The Insert Related Topics Control dialog opens. The folders and topic files available in the
project are shown on the left.

4. On the left side of the dialog, either double-click a topic that you want to add to the related
topics control, or select the topic and click . After doing this, the topic is added to the
Selected Topics area on the right side of the dialog.

You can use the "multi-view" to locate topics.
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Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

5. (Optional) You can customize the related topics link in any of the following ways.

BOOKMARK 

If you want a link to point to a particular bookmark within a topic, do the following.

a. In the Selected Topics area on the right of the dialog, click on the relevant topic.

b. At the bottom of the dialog click .

c. In the Select Bookmark dialog, click on a heading or bookmark within the topic. If you
select a heading, a bookmark will be created at that spot in the topic.

NOTE If you want to remove a bookmark from the link, you can select the
bookmark in this dialog and click . This removes the bookmark from the link
only; it does not remove the bookmark from the destination topic.

d. Click OK.
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STYLE CLASS 

If you want to select the style class to be used for the control, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click on the style class you want to use. The main style is
"MadCap:relatedTopics," but if you create a class under that style in your stylesheet, it
will be available for selection as well.

c. Click OK.

LABEL 

If you want to change the text shown on the control, do the following.

a. At the bottom of the dialog click .

b. In the dialog, enter text in the Label field.

c. Click OK.

POPUP MENU OR LIST 

If you want to specify that the links should be displayed in a popup menu (default) or as a
simple list, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click the down arrow in the Display topics in field and select Popup Menu
or List.

c. Click OK.

NOTE For projects that are merged, the list option is supported for standard merging
(e.g., linking to an FLPRJ file in the TOC). However, it is not supported for
automerging in WebHelp Plus output.
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TARGET FRAME

If you want to choose the type of frame used when the link is clicked, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click the down arrow in the Target Frame field and select any of the
following.

n Page Default The destination file opens in the same window as the output
window.

n Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current
topic.

n Top Frame The destination file opens in the same output window, removing all
other framesets. You might use this option, for example, if the destination topic
has its own frameset.

n Popup Window The destination file opens in a popup box on top of the current
topic.

c. Click OK.

CUSTOM ORDER 

If you want to specify that the links should be displayed in a custom order (rather than
alphabetically), do the following.

a. In the Selected Topics area on the right of the dialog, click on a topic that you want to
move up or down.

b. At the bottom of the dialog click or .

c. Click in the Use Custom Ordering field and select Yes.

6. Click OK. The related topics control is added to the topic.

7. Click to save your work.
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Editing Related Topics Links
You can edit a related topics link that you have inserted into a topic.

How to Change the Topics Associated With a
Related Topics Control
The first way to edit a related topics control is to change the topics associated with it.

EXAMPLE You have a related topics link that has five topics associated with it. You might
then create a new topic, which you decide should be included in the link as well. The steps
below show you how to edit the related topics link to add that new topic to the link.

1. Open the content file.

2. In the XML Editor, right-click the related topics link.

3. In the context menu, select Edit Related Topics Control. The Insert Related Topics Control
dialog opens. The topics currently associated with the link are listed on the right side of the
dialog. All of the content files and folders in your project can be viewed on the left side of the
dialog.
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4. On the left side of the dialog, either double-click a topic that you want to add to the related
topics control, or select the topic and click . After doing this, the topic is added to the
Selected Topics area on the right side of the dialog.

You can use the "multi-view" to locate topics.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

5. If you want to remove a topic from the link, click on that topic on the right side of the dialog.
Then click .

6. Click OK. The Insert Related Topics Control dialog closes, and the link is now changed.

7. Click to save your work.
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How to Change the Options for a Related Topics
Control
You can change the options for a related topics control, modifying elements such as the control
label or the way the links are presented (e.g., popup menu or list).

1. Open the content file.

2. In the XML Editor, right-click the related topics link.

3. In the context menu, select Edit Related Topics Control. The Insert Related Topics Control
dialog opens. The topics currently associated with the link are listed on the right side of the
dialog. All of the content files and folders in your project can be viewed on the left side of the
dialog.

4. You can customize the related topics link in any of the following ways.

ADD BOOKMARK

If you want a link to point to a particular bookmark within a topic, do the following.

a. In the Selected Topics area on the right of the dialog, click on the relevant topic.

b. At the bottom of the dialog click .

c. In the Select Bookmark dialog, click on a heading or bookmark within the topic. If you
select a heading, a bookmark will be created at that spot in the topic.

NOTE If you want to remove a bookmark from the link, you can select the
bookmark in this dialog and click . This removes the bookmark from the link
only; it does not remove the bookmark from the destination topic.

d. Click OK.
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STYLE CLASS

If you want to select the style class to be used for the control, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click on the style class you want to use. The main style is
"MadCap:relatedTopics," but if you create a class under that style in your stylesheet, it
will be available for selection as well.

c. Click OK.

If you want to edit the actual style in the stylesheet, see the set of steps below.

LABEL

If you want to change the text shown on the control, do the following.

a. At the bottom of the dialog click .

b. In the dialog, enter text in the Label field.

c. Click OK.

POPUP MENU OR LIST

If you want to specify that the links should be displayed in a popup menu (default) or as a
simple list, do the following.

a. At the bottom of the dialog click .

b. In the dialog, click the down arrow in the Display topics in field and select Popup Menu
or List.

c. Click OK.

NOTE For projects that are merged, the list option is supported for standard merging
(e.g., linking to an FLPRJ file in the table of contents). However, it is not supported for
automerging in WebHelp Plus output.
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TARGET FRAME

If you want to choose the type of frame used when the link is clicked, do the following.

a. At the bottom of the dialog click .

b. In the Related Topics Link Options dialog, click the down arrow in the Target Frame
field and select any of the following.

n Page Default The destination file opens in the same window as the output
window.

n Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current
topic.

n Top Frame The destination file opens in the same output window, removing all
other framesets. You might use this option, for example, if the destination topic
has its own frameset.

n Popup Window The destination file opens in a popup box on top of the current
topic.

c. Click OK.

CUSTOM ORDER

If you want to specify that the links should be displayed in a custom order (rather than
alphabetically), do the following.

a. In the Selected Topics area on the right of the dialog, click on a topic that you want to
move up or down.

b. At the bottom of the dialog click or .

c. Click in the Use Custom Ordering field and select Yes.

5. Click OK.

6. Click to save your work.
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How to Edit the Style of a Related Topics
Control
You can edit the style of a related topics link. When you do this, the style changes for all related
topics links in any topics in your project. Also, keep in mind the various rules that pertain to related
topic links.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the Show Styles field and select Show Link Styles
or Show Dynamic Effects Styles. Different styles are displayed with each filter.

4. On the left side of the editor, find and select one of the following styles, depending on what
you want to accomplish. You can use a general style (which starts with "helpControl") if you
want to modify all types of Help control links (concept, keyword, and related topic links).
Alternatively, you can use a specific style (which starts with "relatedTopics") if you want to
modify only concept links in your project.

n MadCap|helpControlList Edit this style to change the look of the entire list (<ul>
element) when links are displayed in a list, rather than in a popup.

n MadCap|helpControlListItem Edit this style to change the look of individual items in the
list (<li> elements) when links are displayed in a list, rather than in a popup.

n MadCap|helpControlListItemLink Edit this style to change the look of links in the list
(<a> elements) when links are displayed in a list, rather than in a popup.

n MadCap|helpControlMenu Edit this style to change the look of links (i.e., menu items)
when links are displayed in a popup, rather than in a list. This particular style controls
the entire list.

n MadCap|helpControlMenuItem Edit this style to change the look of links (i.e., menu
items) when links are displayed in a popup, rather than in a list. This particular style
controls the individual list items.
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n MadCap|relatedTopics Edit this style to change the look of the heading for related topic
links. The following three related topic link styles inherit properties from this style.

n MadCap|relatedTopicsControlList Edit this style to change the look of the entire list
(<ul> element) when related topics are displayed in a list, rather than in a popup.

n MadCap|relatedTopicsControlListItem Edit this style to change the look of individual
items in the list (<li> elements) when related topics are displayed in a list, rather than in
a popup.

n MadCap|relatedTopicsControlListItemLink Edit this style to change the look of links in
the list (<a> elements) when related topics are displayed in a list, rather than in a popup.

NOTE You can also change a pseudo class of a link style (e.g.,
MadCap|relatedTopics.focus or MadCap|relatedTopics.hover) if you want to modify
the look of the related topic link when it is in a certain state (e.g., when it has focus or
when the cursor is hovering over it).

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

9. Click to save your work.
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Deleting Related Topics Links
If you no longer need a related topics link that you have previously inserted into a topic, you can
delete it from a topic.

How to Delete a Related Topics Control
1. Open the content file.

2. Right-click the related topics link that you want to delete.

3. From the context menu, select Delete. The related topics link is removed from the topic.

4. Click to save your work.
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CHAPTER 13

Relationship Tables and Links
Supported In:

A relationship table is an element used to link related topics together. It is similar to concept links or
related topics links. Although a relationship table is a common feature in DITA, you do not need to
be using DITA or know anything about DITA in order to take advantage of relationship tables.

If you import content from DITA files that already contain relationship tables, those tables are
retained in Flare. You can also create new relationship tables in a Flare project and insert
relationship proxies into individual topics. In online output, the end result is one or more hyperlinks
that let users quickly open related topics. In print-based output, the end result is one or more
references to related topics with the appropriate page number(s).

This chapter discusses the following:

General Information for Relationship Links 185

Process for Relationship Links 197
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General Information for Relationship
Links

There are various pieces of general information you should know if you plan to use this feature.

Benefits of Relationship Tables
Following are some of the primary benefits of using relationship links, as opposed to related topic
links or concept links:

n You can create all of your link information in one place, in a single relationship table.

n You can have multiple types of links at the bottom of topics (e.g., one for "Related
Information," one for "Related Tasks," and one for "Reference Materials").

n In online output, the links are automatically represented as hyperlinks. In print-based output,
the links are automatically represented as a list of related topics with page number
references.
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Relationship Table Components
Following are the basic components of a relationship table.

Columns
By default, a relationship table has three columns, each named after three basic topic types—
Concept, Task, and Reference.

n Concept Topics that contain basic information and descriptions about a subject.

n Task Topics that provide step-by-step procedures for accomplishing something.

n Reference Topics that provide detailed reference material.

If necessary, you can add more columns to a relationship table, naming the other columns anything
you want.
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Rows
You can have many rows in a relationship table, with each cell containing one or more topic names,
placed in the appropriate column. The relationships between the different topics are defined across
each row.
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Relationship Links
When you insert topic references into a row in a relationship table, those topics will link to the other
topics in the row in some way.

Following are the types of links that you can create.

n Normal (default) This is a two-way link. In other words, a link will be displayed in each topic
involved, and that link will open the other topic.

n Source Only This is a link where the topic in question will have a link to other topics, but other
topics will not have a link back to it.

n Target Only This is a link where the topic in question will not have a link to other topics, but
other topics will have a link back to it.

n Use CONREF Target This uses the conref attribute to pull content. The conref attribute
references an ID on content that can be reused. For Flare outputs other than DITA, this option
is not supported. For more detailed information about DITA and the conref attribute, please
refer to: www.oasis-open.org/committees/dita/

Unless you leave the default link setting, relationship links are identified by a blue background when
you set them. To identify the exact kind of relationship link applied to an item, you can select the
item and then click the appropriate Properties button in the local toolbar.

You can specify links on individual topic items, on cells (which can contain multiple items), or on
entire columns.

n Links on Items Each topic item in a relationship table can use a different kind of link.

n Links on Cells If you apply a link type to a cell, all of the topic items in that cell will use that
same setting (unless you later override the setting on individual items).

n Links on Columns If you apply a link type to a column, all of the topic items in all cells will use
that same setting (unless you later override the setting on individual items or cells).
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Groups
You can group topics in the same cell so that they function as a unit or are related to one another.
When you group items together, you can choose a collection type to specify how the items within
the group behave.

Following are the collection types that you can use:

n Unordered (default) This displays the grouped links in the output, but the order in which they
are displayed is not important.

n Family This lets you display links not only to adjacent topics in the row, but to other topics
grouped within the same cell as well.

EXAMPLE You have a row that is populated like this:

Topic A is in the "concept" cell.

Topics B, C, and D are contained in a group in the "task" cell.

Topic E is in the "reference" cell.

Suppose you do not use the Family collection type. In that case, when a user opens
Topic A, he will see links to Topics B, C, D, and E. However, when the user opens
Topic C, he will see links to Topic A and Topic E, but not to Topics B and D.

Now suppose you do use the Family collection type. In that case, when a user opens
Topic C, he will see links not only to Topics A and E, but to Topics B and D as well.

n Sequence This displays links with significance given to how the links are ordered in the
output. For Flare outputs other than DITA, this option is not supported. For more detailed
information about DITA and the sequence option, please refer to:

www.oasis-open.org/committees/dita/
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n Choice This lets you specify which link should be "selected" or "highlighted" from the group of
links. For Flare outputs other than DITA, this option is not supported. For more detailed
information about DITA and the choice option, please refer to:

www.oasis-open.org/committees/dita/

n Use CONREF Target This uses the conref attribute to pull content. The conref attribute
references an ID on content that can be reused. For Flare outputs other than DITA, this option
is not supported. For more detailed information about DITA and the conref attribute, please
refer to:

www.oasis-open.org/committees/dita/

Unless you leave the default link setting, collection types are identified by a green background when
you set them. To identify the exact kind of group applied, you can select the item and then click the
appropriate Properties button in the local toolbar.

You can specify collection types on individual items in a group or on entire columns:

n Collection Types on Items in Groups Each group item in a relationship table can use a
different kind of collection type.

n Collection Types on Columns If you apply a collection type to a column, all of the groups in
that column will use that same setting (unless you later override the setting on individual
groups).
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Conditions
Like most everything else in Flare, you can apply condition tags to the elements within a
relationship table. That is why you see squares next to the elements. If you apply a condition tag to
something (e.g., topic reference, group), the square will display the color associated with that
condition tag. You can show or hide the condition tags if you want.
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Rules for Relationship Tables
Following are some basic rules when it comes to creating relationship tables:

n Relationships are expressed within individual rows only. Relationships do not exist between
rows in a table.

n Not every cell in a row needs to have a topic link.

n Multiple topic links can be added to a single cell.

n You can add the same topic link in many different rows.

Relationships Proxy
After you create at least one relationship table, you can insert a Relationships proxy into the topics
where you want the links to appear in the output. When you build the output, the proxy is replaced
by the generated links.
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Process for Relationship Links
Certain tasks must be completed in order when using this feature.

Adding Relationship Table Files
The first step in using a relationship table is to add a new file to the Advanced folder in the Project
Organizer. You can add as many relationship table files as you need. Depending on your project, you
may need just one relationship table or many. For example, you might want to use Relationship
Tables 1 and 2 when generating Target A, but you might want to use Relationship Table 3 when
generating Target B.

How to Add a Relationship Table File
1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Project > New > Advanced > Relationship Table.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Relationship Table.

The Add File dialog opens.

2. In the File Type field at the top, make sure Relationship Table is selected.

3. In the Source area, choose to create the new file based on a template or an existing file.

n New From Template Choose either a factory template file or one of your own custom
template files as a starting point. The new file will take on all of the settings contained
in the template. If you want to use the factory template provided by Flare, expand the
Factory Templates folder and click on a template file. If you want to use your own
custom template file, expand the appropriate folder and click on a file. For more
information about templates, see the online Help.

n New From Existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click , use the Open File dialog to find a file, and
double-click it.
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4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click and select the subfolder. Otherwise,
keep the default location.

5. In the File Name field, type a new name for the relationship table file.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

8. Click Add. The relationship table file is added to the Advanced folder in the Project Organizer.
The Relationship Table Editor opens to the right.
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Creating Relationship Tables
After adding a relationship table file, you can create the actual content for it, adding relationships
between the topic links in a row.

How to Create a Relationship Table
1. Open the relationship table that you want to work on. The Relationship Table Editor opens to

the right. If you do not yet have a relationship table, see "Adding Relationship Table Files" on
page 197.

2. Use the editor to perform any of the following tasks. Keep the following in mind as you work:

n Relationships are expressed within individual rows only. Relationships do not exist
between rows in a table.

n Not every cell in a row needs to have a topic link.

n Multiple topic links can be added to a single cell.

n You can add the same topic link in many different rows.

TO GIVE A ROW A NAME

This simply helps you distinguish one row from another.

a. Highlight a row.

b. In the local toolbar click .

c. In the Row Type field, enter a name.

d. Click OK.
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TO INSERT A ROW

n In the local toolbar click .

TO RENAME A COLUMN

a. Highlight any cell in the column you want to rename.

b. In the local toolbar click to run the Column Properties dialog.

c. In the Column Type field, enter a name.

d. Click OK.
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TO INSERT A COLUMN

In addition to the Row Name, a relationship table has three additional columns, each named
after three basic topic types—Concept, Task, and Reference. You can add more columns if
you want.

n In the local toolbar click .

TO ADD A TOPIC ITEM TO A CELL

a. Click a cell where you want to insert a topic reference.

b. In the local toolbar click .

c. In the Open dialog, locate and double-click the topic. The topic file name is added to
that cell. The square next to the file name is used to show any condition tags applied to
the link.

TO SELECT THE LINK TYPE FOR A TOPIC ITEM, CELL, OR COLUMN

When you insert topic items into a row in a relationship table, those topics will link to the
other topics in the row in some way. If you do not want to use the default type of link, you can
select another kind. You can do this for individual topic items, entire cells, or entire columns.

n Links on Items Each topic item in a relationship table can use a different kind of link.

n Links on Cells If you apply a link type to a cell, all of the topic items in that cell will use
that same setting (unless you later override the setting on individual items).
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n Links on Columns If you apply a link type to a column, all of the topic items in all cells
will use that same setting (unless you later override the setting on individual items or
cells).

Following are the steps for selecting link types.

a. Do one of the following:

n For Columns Click in a column. In the local toolbar click .

OR

n For Cells Click in a cell. In the local toolbar click .

OR

n For Topic Link Items Click a topic link item in a cell. In the local toolbar click .

b. Click in the Linking field and select one of the following.

n Source Only This is a link where the topic in question will have a link to other
topics, but other topics will not have a link back to it.

n Target Only This is a link where the topic in question will not have a link to other
topics, but other topics will have a link back to it.

n Normal (default) This is a two-way link. In other words, a link will be displayed in
each topic involved, and that link will open the other topic.

n None This option indicates that the topic reference does not have a link.

n Use CONREF Target This uses the conref attribute to pull content. The conref
attribute references an ID on content that can be reused. For Flare outputs other
than DITA, this option is not supported. For more detailed information about DITA
and the conref attribute, please refer to www.oasis-open.org/committees/dita/.

Unless you leave the default link setting, relationship links are identified by a blue
background when you set them. To identify the exact kind of relationship link applied to
an item, you can select the item and then click the appropriate Properties button in the
local toolbar.
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c. Click OK.
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TO GROUP SELECTED ITEMS

You can group topics in the same cell so that they function as a unit or are related to one
another. When you group items together, you can choose a collection type to specify how the
items within the group behave.

a. In a cell containing multiple items (topic references), hold your CTRL key and click the
items that you want to group.

b. In the local toolbar click . The word "Group" is added to the cell.
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TO SELECT THE COLLECTION TYPE FOR A COLUMN OR TOPIC LINK ITEM

When you put items into a group, you can specify how that group will function as a collection
(e.g., in the images above the group is using the "Family" collection type, which means that
those topic items will reference each other in the output). You can do this for entire columns
or for individual topic items in a cell that have been grouped. If you set a particular collection
type on a column, all groups in that column will use that collection type.

a. Do one of the following:

n For Columns Click in a column. In the local toolbar click .

n For Topic Link Items Click a topic link item in a cell. In the local toolbar click .

b. Click in the Collection Type field and select one of the following:

n Unordered (default) This displays the grouped links in the output, but the order in
which they are displayed is not important.

n Family This lets you display links not only to adjacent topics in the row, but to
other topics grouped within the same cell as well.

EXAMPLE You have a row that is populated like this:

Topic A is in the "concept" cell.

Topics, B, C, and D are contained in a group in the "task" cell.

Topic E is in the "reference" cell.

Suppose you DO NOT use the Family collection type. In that case, when a
user opens Topic A, he will see links to Topics B, C, D, and E. However,
when the user opens Topic C, he will see links to Topic A and Topic E, but
not to Topics B and D.

Now suppose you DO use the Family collection type. In that case, when a
user opens Topic C, he will see links not only to Topics A and E, but to
Topics B and D as well.

n Sequence This displays links with significance given to how the links are ordered
in the output. For Flare outputs other than DITA, this option is not supported.
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n Choice This lets you specify which link should be "selected" or "highlighted" from
the group of links. For Flare outputs other than DITA, this option is not supported.

n Use CONREF Target This uses the conref attribute to pull content. The conref
attribute references an ID on content that can be reused. For Flare outputs other
than DITA, this option is not supported.

NOTE For more detailed information about DITA and these options, please
refer to www.oasis-open.org/committees/dita/.

c. Click OK.

TO NEST ITEMS

After you add items to a cell, you can nest them by using the left and right arrows. If an item
is above and to the left of other items, it becomes the parent; the child items are below and to
the right of the parent. When this occurs, the child items inherit the settings from the parent
item (e.g., link type).

a. Click on a topic link in a cell that you want to move.

b. In the local toolbar, click to move it to the left, or click to move it to the right.

TO MOVE ITEMS UP OR DOWN

If you have multiple topic items in a cell, they are displayed in the output in the order they are
shown. You can use the up and down buttons to change the order.

a. Click the topic item that you want to move.

b. In the local toolbar click to move the item up or to move the item down.

TO DELETE A ROW

a. Click in the row you want to delete.

b. In the local toolbar click .

CHAPTER 13  207

http://www.oasis-open.org/committees/dita/


TO DELETE A COLUMN

a. Click in the column you want to delete.

b. In the local toolbar click .

TO SHOW OR HIDE CONDITIONAL INDICATORS

In a relationship table, condition tags are shown in the small squares next to topic file names.
This feature can be used to show or hide those squares.

n In the local toolbar click .

3. Click to save your work.

NOTE If there are any broken links in a relationship table, they will be identified by this icon:
. You can then open the properties for that item and fix the link.

NOTE The three relationship link style classes in your stylesheet are designed to work in
sync with the column headings in the Relationship Table Editor. Therefore, if you rename a
column or create a custom column, make sure that you create a corresponding style class
in the stylesheet to control that column. For example, if you create a custom column with a
link type called "other," you should create a style class in the stylesheet named
"MadCap|relationshipsHeading.other." If you do not create a unique style class for the
custom column, it will use the settings from the parent MadCap|relationshipsHeading style.
Therefore, the heading label will say "Related Information," instead of what you want it to
say.
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Opening Relationship Tables
After a relationship table file is added, you can open it at any time to work on it.

How to Open a Relationship Table From the Quick
Launch Bar
The Quick Launch bar lets you search for any Flare file or command. It is located in the upper-right
corner of the interface. You can press CTRL+Q on your keyboard to move focus to the Quick
Launch bar so you can begin typing.

1. In the Quick Launch bar, type a few letters of the name of the file you want to open. Any
available results appear in a drop-down list.

2. From the list, click the name of the file.

How to Open a Relationship Table From the Project
Organizer

1. Open the Project Organizer.

2. Double-click the Advanced folder.

3. Double-click the relationship table file. The Relationship Table Editor opens to the right.
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Inserting Relationship Links
You can insert a Relationships proxy in the topics where you want links to appear in the output,
using the information contained in your relationship table(s).

How to Insert a Relationship Link
1. Open the content file.

2. Place your cursor where you want to insert the link (usually at the bottom of the topic).

3. Select Insert > Proxy > Relationships Proxy.

The Relationships Proxy dialog opens.

4. (Optional) In the field labeled Stylesheet class for proxy, you can select a class to affect the
look of the relationship link.

You might create and use a proxy style class, for example, if you want to use a border special
border above the relationship links in the output. If you do not select a class from this field,
the generated link will use the style settings from the parent MadCap|relationshipsProxy
style. You have the option of creating a class for this proxy style in the Stylesheet Editor. To
do this, select the MadCap|relationshipsProxy style and in the local toolbar click Add Selector
to create a class. The class will then be available from this field.

5. Click OK. The proxy is added to the topic.

6. Click to save your work.
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Editing Relationship Link Styles
You can edit the look of relationship links by adjusting the appropriate styles in your stylesheet.
This might involve changing the look of any of the following: the container holding the links, the
heading(s) above the links, the link items themselves. The Simplified view of the Stylesheet Editor
lets you edit only some of the necessary styles; for the rest of the styles, you need to use the
Advanced view.
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How to Edit the Container
1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE Some of the necessary style properties can also be changed in the Simplified
view in the Stylesheet Editor.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. On the left side of the editor, select the MadCap|relationshipsProxy style.

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .
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7. Following are some of the more common tasks that you may want to perform:

BORDER PROPERTIES

By default, a 1-pixel black border is already set, which separates the relationship links from
the topic content above. 

a. If you are using the grouped view, expand the Border group. 

b. Locate and select the border property you want to change. Each side (bottom, left, right,
top) has separate properties that you can set for the color, style, and width (e.g., border-
bottom-style). You can set these properties individually, or you can set the primary
property for each side (e.g., border-bottom), which lets you specify the color, style, and
width in one place. If you plan to have the same settings for all sides, you can use the
main border property to set the color, style, and width the same. The border-radius
properties let you create curved edges on the border by providing horizontal and
vertical values. 

When you click next to a border property, a popup appears. Use the fields in the
popup to define additional properties such as color, width, style, and thickness, then
click OK.
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MARGIN PROPERTIES

By default, a 10-pixel top margin is already set. The margin is the space around the outside of
the container.

a. If you are using the group view, expand the Box group.

b. Locate and select the margin property that you want to change. Each side (bottom, left,
right, top) has separate properties that you can set (e.g., margin-bottom, margin-left).
However, if you plan to have the same settings for all four sides, you can simply use the
main margin property to set the values all the way around. When you click in the cell to
the right of one of the properties (e.g., margin, margin-bottom), a small popup displays.

i. Next to a margin property, click .

ii. Use the left side of the popup to enter a number for the amount of margin.

iii. Use the right side of the popup to select a unit of measurement (e.g., point, pixel,
centimeter) for the number you entered.

iv. Click OK.

PADDING PROPERTIES

By default, 20 pixels of padding are set on the left side of the container, and 10 pixels of
padding are set on the top side. The padding is the space between the content inside the
container and its outer edges.

a. If you are using the group view, expand the Box group.

b. Locate and select the padding property that you want to change. Each side (bottom,
left, right, top) has separate properties that you can set (e.g., padding-top, padding-left).
However, if you plan to have the same settings for all four sides, you can simply use the
main padding property to set the values all the way around. When you click in the cell to
the right of one of the properties (e.g., padding, padding-bottom), a small popup
displays.

i. Next to a padding property, click .

ii. Use the left side of the popup to enter a number for the amount of padding.

iii. Use the right side of the popup to select a unit of measurement (e.g., point, pixel,
centimeter) for the number you entered.

iv. Click OK.
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8. Click to save your work.

CHAPTER 13  215



How to Edit a Heading
1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the Stylesheet Editor, click in the drop-down field and select
.

4. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

5. In the Styles section of the editor, expand the MadCap|relationshipsHeading style. Then
select the appropriate style class under it:

n concept This class lets you change the look of the heading that is displayed above any
concept links (i.e., any topics found in the "concept" column of the relationships table).

n reference This class lets you change the look of the heading that is displayed above
any reference links (i.e., any topics found in the "reference" column of the relationships
table).

n task This class lets you change the look of the heading that is displayed above any task
links (i.e., any topics found in the "task" column of the relationships table).

NOTE If you want to apply a setting that is used for all three of the classes, you can
select the parent MadCap|relationshipsHeading style. Whatever you set for that style
will trickle down to the three classes, unless a different value is already specified on
that class.
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NOTE The three style classes mentioned above are designed to work in sync with
the column headings in the Relationship Table Editor. You can change the column
heading (i.e., link type) for any of these in the editor via the column properties dialog.
You can also create a custom column. But if you do this, make sure that you create a
corresponding style class in the stylesheet to control that column. For example, if
you create a custom column with a link type called "other," you should create a style
class in the stylesheet named "MadCap|relationshipsHeading.other." If you do not
create a unique style class for the custom column, it will use the settings from the
parent MadCap|relationshipsHeading style. Therefore, the heading label will say
"Related Information," instead of what you want it to say.

6. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

7. Following are some of the more common tasks that you may want to perform.

HEADING TEXT (LABEL)

For the "concept" links, the default text is "Related Information." For the "reference" links, the
default text is "Reference Materials." For the "task" links, the default text is "Related Tasks."

To the right of mc-label, replace the default text.

FONT COLOR

The default color is black.

a. If you are using the grouped view, expand the Font group.

b. To the right of color, click , and select a color. For advanced color options, click
and use the fields in the Color Picker dialog, or click to select a color already used
elsewhere on your screen. You can use the Color Picker to select a CSS variable.
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FONT SIZE

The default size is 14 points.

a. If you are using the grouped view, expand the Font group.

b. To the right of font-size, click , and complete the fields in the popup. Enter a number
in the field and use the down arrow in the lower-right corner to select a unit of
measurement.

c. Click OK.

NOTE You can also specify other style settings that can normally be done for fonts
or paragraphs.

8. Click to save your work.
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How to Edit Link Items
1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. In the Styles section of the editor, select the MadCap|relationshipsItem style.

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .
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7. Following are some of the more common tasks that you may want to perform.

LEADER ALIGNMENT (PRINT-BASED OUTPUT)

This determines how the page numbers are aligned at the end of the leader. The default
setting is right alignment.

To the right of mc-leader-align, click , and select an alignment setting (center, left, right).

LEADER FORMAT (PRINT-BASED OUTPUT)

This is the material that is shown between a topic name and the page number where it can be
found. The default setting is a series of dots.

To the right of mc-leader-format, type whatever you want to be shown as the leader (e.g.,
dash, underline). Whatever you type will be repeated until the end of the leader.

LEADER INDENT (PRINT-BASED OUTPUT)

This is the amount of space from the end of the list entry to the start of the leader.

a. To the right of mc-leader-indent, click .

b. Use the lower-left area of the popup to enter a number.

c. Use the lower-right area to select a unit of measurement.

d. Click OK.

LEADER OFFSET (PRINT-BASED OUTPUT)

This is the amount of space from the end of the leader to the page number following it.

a. To the right of mc-leader-offset, click .

b. Use the lower-left area of the popup to enter a number.

c. Use the lower-right area to select a unit of measurement.

d. Click OK.
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MARGIN

This the amount of space around each item. The default setting is a left margin of 24 points.

a. If you are using the group view, expand the Box group.

b. Locate and select the margin property that you want to change. Each side (bottom, left,
right, top) has separate properties that you can set (e.g., margin-bottom, margin-left).
However, if you plan to have the same settings for all four sides, you can simply use the
main margin property to set the values all the way around. When you click in the cell to
the right of one of the properties (e.g., margin, margin-bottom), a small popup displays.

i. To the right of a margin property, click .

ii. Use the left side of the popup to enter a number for the amount of margin.

iii. Use the right side of the popup to select a unit of measurement (e.g., point, pixel,
centimeter) for the number you entered.

iv. Click OK.

FONT COLOR

The default color is black. The following instructions show you how to change the font color
for print-based output. For online output, the color is based on the settings on the "a" style,
which controls the look of all text hyperlinks in your output. To change this, see "Editing Text
Hyperlinks" on page 237.

a. If you are using the grouped view, expand the Font group.

b. To the right of color, click , and select a color. For advanced color options, click
and use the fields in the Color Picker dialog, or click to select a color already used
elsewhere on your screen. You can use the Color Picker to select a CSS variable.
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FONT SIZE

The default size is 14 points.

a. If you are using the grouped view, expand the Font group.

b. To the right of font-size, click , and complete the fields in the popup. Enter a number
in the field and use the down arrow in the lower-right corner to select a unit of
measurement.

c. Click OK.

NOTE You can also specify other style settings that can normally be done for fonts
or paragraphs.

8. Click to save your work.
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How to Edit Page Numbers for Print Output
1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. In the Styles section of the editor, expand MadCap|xref and select the RelLinkPageNumber
style class.

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Use the properties area to the right to make changes (e.g., font color).

8. Click to save your work.

What’s Noteworthy?

NOTE Different browsers may treat margin and padding settings differently. For example,
Internet Explorer 8 and Firefox honor padding settings more than they honor margin
settings. If you were to set a left margin at, say, 1 inch, Internet Explorer 7 would show it
that way. However, in order to get the same results in Internet Explorer 8 or Firefox, you
would also need to set the left padding at 1 inch.
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Associating Relationship Tables With Targets
If you have created relationship tables in your project, you need to tell Flare which tables to use for
which targets.

How to Associate Relationship Tables With Targets
1. Open the target from the Project Organizer.

2. In the Target Editor, click the Relationship Table tab.

3. Click next to each relationship table that you want to use for that target so that it has a check
mark.

4. Click to save your work.
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CHAPTER 14

Shortcut Controls
Supported In:

A shortcut control in Microsoft HTML Help launches a program or window in an application by
passing Windows-based messages and parameters. For example, if a topic discusses a procedure
that involves a specific dialog window, you can provide a link that a user can click in the topic to
open the dialog in the program. Shortcut controls can make tasks easier for new users, and they
can speed up complex procedures for experienced users.

This chapter discusses the following:

Inserting Shortcut Controls 226

Editing Shortcut Controls 227
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Inserting Shortcut Controls
Inserting shortcut controls requires only a few simple steps.

Following are limitations of shortcut controls:

n A shortcut control can be used only with Microsoft HTML Help.

n The CHM file must be located on a local or network drive. The file cannot be accessed
through HTTP.

n The CHM file must be displayed in the Help Viewer. A shortcut control does not work in a file
that is displayed in an internet browser window.

How to Insert a Shortcut Control
1. Open the content file.

2. In the XML Editor, click in the topic where you want to insert the shortcut control.

3. Select Insert > Shortcut Control.

4. Enter the appropriate information in each of the fields. You may need to consult with your
developer for help on completing these fields.

n File path to the executable file… Enter the path and name of the program that (EXE file)
you are calling.

n Parameters to be sent… Enter any parameters you would like to send the program (e.g.,
the name of a file to open). Separate the parameters with commas.

n A message ID of a standard Windows message Select a standard Windows message
from the drop-down menu.

n WPARAM value Enter the WPARAM value.

n LPARAM value Enter the LPARAM value.

5. Click OK. The shortcut control is added to the topic.

6. Click to save your work.
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Editing Shortcut Controls
You can edit a shortcut control that you have inserted into a topic in a couple of different ways.

How to Change the Settings Associated With a
Shortcut Control
The first way to edit a shortcut control is to change the settings (e.g., executable file path,
parameters, message ID) associated with the control.

1. Open the content file.

2. In the XML Editor, right-click the shortcut control icon (if "markers" are set to be shown).

3. In the context menu, select Edit Shortcut Control. The Insert Shortcut Control dialog opens.

4. Adjust the settings in the fields as necessary. You may need to consult with your developer
for help on completing these fields:

n File path to the executable file… Enter the path and name of the program (EXE file) you
are calling.

n Parameters to be sent… Enter any parameters you would like to send the program (e.g.,
the name of a file to open). Separate the parameters with commas.

n A message ID of a standard Windows message Select a standard Windows message
from the drop-down menu.

n WPARAM value Enter the WPARAM value.

n LPARAM value Enter the LPARAM value.

5. Click OK. The Insert Shortcut Control dialog closes, and the link is now changed.

6. Click to save your work.
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Edit the Style of a Shortcut Control
The second way to edit a shortcut control is to edit the style (e.g., font, color) of the link. When you
edit the style for a shortcut control, the style changes for all shortcut controls in any topics in your
project. To do this, modify the property settings for the style called "MadCap|shortcut." For more
information see the online Help.
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CHAPTER 15

Text Hyperlinks
Supported In:

A text hyperlink is one of the most basic forms of a navigation link. It is simply a hyperlink applied to
text. When an end user clicks the hyperlink in the output, the location specified in the hyperlink
opens. The location can be another topic in the project (including a bookmark within that topic), a
topic in an imported HTML Help file, or a file outside of the project (such as a website on the
internet). In general, text hyperlinks are recommended for links that point to locations outside of
your project (e.g., to a website), whereas cross-references are recommended for links that point to
other locations within the project (e.g., from one topic to another).

This chapter discusses the following:

Inserting Text Hyperlinks 230

Editing Text Hyperlinks 237
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Inserting Text Hyperlinks
You can insert text hyperlinks in content files.

How to Insert a Text Hyperlink—Standard
Method

1. Open the content file.

2. Highlight the text that you want to use as the link (or "hotspot").

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Insert > Hyperlink.

n Keyboard Shortcut Press CTRL+K.

n Local Toolbar In the local toolbar of the XML Editor, click .

n Right-Click Right-click in the editor and select Insert > Hyperlink. This context menu
option is available only when your cursor is located in certain places in the editor (e.g.,
not in a drop-down effect).

The Insert Hyperlink dialog opens.

4. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based the option you choose, the section below gives you a list of selections
or additional fields to complete.

FILE IN PROJECT 

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.
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Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 11.

You can also select if you have selected a PDF file. See "Named Destinations" on page
155.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare will insert a new bookmark at that
destination in the file.

EXTERNAL FILE 

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click to display and select any bookmarks within the destination file, or if
you have selected a PDF file. See "Inserting Bookmarks" on page 11 and "Named
Destinations" on page 155.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 109.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).
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EMAIL 

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list
below).
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HTML HELP FILE 

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

n Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show Folders
button is selected, the area splits into two. The folder is shown on
the left side, and the files and subfolders within it are shown on the right.

n Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

5. (Optional) The Link text field displays the text that you highlighted in the topic, which will be
used as the hyperlink. Leave the text as it is, unless you decide you would like to change it. If
you want to change the link text, type the new text in the field. It will replace the previous text
in the topic. If you want to insert a variable in a field, you can click . The variable will appear
as syntax in the field, but in the output the variable definition will be shown.

6. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output. Again, you can insert a variable by clicking .

When you enter a screen tip, it is added as a <title> tag in the markup.

For more information see the online Help.
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7. (Optional) In the Alternate Text field, type a phrase that describes what the element is about.
This option should be used to increase accessibility for users who are unable to view an
element. Again, you can insert a variable by clicking .

8. (Optional) Next to the Style Class field, click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles (a.NameOfStyleClass) from
your stylesheet to the link. After you select a style class in the dialog, click OK. The Style Class
field displays the selected style. (If you do not specify a style class, Flare uses the parent "a"
style.)

9. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open.

n Page Default The destination file opens in the same window as the output window.

n Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current topic.

n Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

n Popup Window The destination file opens in a popup box on top of the current topic.

10. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through hyperlinks in a topic. So when a user presses the TAB key the first time in a topic,
the hyperlink with an index value of 1 will be selected first, the hyperlink with a value of 2 will
be selected next, and so on. If you want to skip a hyperlink, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTML5, Clean XHTML,
WebHelp, WebHelp Plus.

11. Click OK. The hyperlink is added to the topic.

12. Click to save your work.
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How to Insert a Text Hyperlink—Quick Link
Method

1. Open the content file.

2. In the XML Editor right-click at the location where you want to insert the hyperlink.

3. From the context menu select Insert > Quick Link.

4. Select the appropriate submenu, depending on the option that helps you find the destination
the fastest.

n Bookmarks Lets you select any bookmarks that you have already inserted into the
current file.

n Same Folder Lets you select any files that are contained in the same folder in the
Content Explorer.

n Open Documents Lets you select any other files that are also currently open in the
workspace.

5. From the next submenu choose the bookmark or file. The hyperlink is added to the topic.

6. Click to save your work.

CHAPTER 15  236



Editing Text Hyperlinks
You can edit text hyperlinks that you have inserted into a topic in at least three different ways: (1)
edit the destination and properties of the hyperlink, (2) edit the style of the hyperlink, and (3) unbind
(or remove) the hyperlink from the text.

How to Edit the Destination and Properties of a
Text Hyperlink
The first way to edit text hyperlinks is to change the destination and other properties (link text,
target frame, screen tip).

EXAMPLE You test the topic containing the text hyperlink and you notice that the wrong
destination topic is opening when you click the hyperlink. So you use the steps below to
associate the correct destination topic with the hyperlink.

1. Open the content file.

2. In the XML Editor, click inside the link.

3. At the top of the XML Editor, right-click the span bar representing the link. For example,
hyperlink span bars have an "a" label, and cross-reference span bars have a "MadCap:xref"
label. When you click on the link in the topic, the appropriate span bar at the top of the XML
Editor will change color to indicate that it goes with the link. If your span bars are not turned
on, click in the local toolbar of the XML Editor.

4. Select Edit Hyperlink. The Insert Hyperlink dialog opens.

5. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based the option you choose, the section below gives you a list of selections
or additional fields to complete.
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FILE IN PROJECT 

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 11.

You can also select if you have selected a PDF file. See "Named Destinations" on page
155.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare will insert a new bookmark at that
destination in the file.

EXTERNAL FILE 

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click to display and select any bookmarks within the destination file, or if
you have selected a PDF file. See "Inserting Bookmarks" on page 11 and "Named
Destinations" on page 155.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 109.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).
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EMAIL 

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list
below).
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HTML HELP FILE 

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

n Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show Folders
button is selected, the area splits into two. The folder is shown on
the left side, and the files and subfolders within it are shown on the right.

n Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

6. (Optional) The Link text field displays the text that you highlighted in the topic, which will be
used as the hyperlink. Leave the text as it is, unless you decide you would like to change it. If
you want to change the link text, type the new text in the field. It will replace the previous text
in the topic.

7. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output.

When you enter a screen tip, it is added as a <title> tag in the markup.

For more information see the online Help.

8. (Optional) In the Alternate Text field, type a phrase that describes what the element is about.
This option should be used to increase accessibility for users who are unable to view an
element. Again, you can insert a variable by clicking .
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9. (Optional) Next to the Style Class field, click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles (a.NameOfStyleClass) from
your stylesheet to the link. After you select a style class in the dialog, click OK. The Style Class
field displays the selected style. (If you do not specify a style class, Flare uses the parent "a"
style.)

10. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open.

n Page Default The destination file opens in the same window as the output window.

n Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

n New Window The destination file opens in a new browser window.

n Same Frame The destination file opens in the same window frame as the current topic.

n Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

n Popup Window The destination file opens in a popup box on top of the current topic.

11. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through hyperlinks in a topic. So when a user presses the TAB key the first time in a topic,
the hyperlink with an index value of 1 will be selected first, the hyperlink with a value of 2 will
be selected next, and so on. If you want to skip a hyperlink, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTML5, Clean XHTML,
WebHelp, WebHelp Plus.

12. Click OK. The hyperlink is changed in the topic. By default the hyperlink is displayed in blue,
underlined font. You can change the appearance of the link by modifying the style in the
Stylesheet Editor.

13. Click to save your work.
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How to Edit the Style of a Text Hyperlink
The second way to edit a text hyperlink is to edit the style (e.g., font, color) of the hyperlink. When
you edit the style for a text hyperlink, the style changes for all text hyperlinks in any topics in your
project.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. On the left side of the editor, find and select the a tag.

If you want to modify the way links look when they are in a certain state, you can select a
pseudo class under the "a" style. Link pseudo classes include the following:

n Active This class is used when the person activates the element (mouse is clicked).

n Focus This class is used if the element has the focus.

n Hover This class is used when the person hovers the mouse over the element.

n Link This class is used for links that have not yet been clicked.

n Visited This class is used for links that have already been clicked.
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EXAMPLE You want a text hyperlink to display in green when a user hovers over it.
Therefore, in your stylesheet you expand the a style and modify the hover pseudo
class, changing the font color to green.

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

9. Click to save your work.
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How to Unbind or Remove the Text Hyperlink
The third way to edit a text hyperlink is to unbind (or remove) the hyperlink effect. If you decide that
you no longer want the content to serve as a hyperlink, you can use the steps below to remove the
hyperlink, converting the content to regular text.

1. Open the content file.

2. In the XML Editor, click inside the link.

3. At the top of the XML Editor, right-click the span bar representing the link. For example,
hyperlink span bars have an "a" label, and cross-reference span bars have a "MadCap:xref"
label. When you click on the link in the topic, the appropriate span bar at the top of the XML
Editor will change color to indicate that it goes with the link. If your span bars are not turned
on, click in the local toolbar of the XML Editor.

4. From the context menu, select Unbind. The hyperlink effect is removed.

5. Click to save your work.
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CHAPTER 16

Text Popups
Supported In:

A text popup is a link that opens a popup box containing basic text that you provide.

This chapter discusses the following:

Inserting Text Popups 247

Editing Text Popups 248
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Inserting Text Popups
Inserting text popups requires only a few simple steps

How to Insert a Text Popup
1. Open the content file.

2. In the XML Editor, highlight the content that you want to use as the link (or "hotspot") to open
the popup.

3. Select Insert > Text Popup.

The Insert Text Popup dialog opens, with the text that you highlighted already shown in "The
Hotspot Text" field.

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

4. In The Popup Text field, type the content for the popup. Again, you can insert a variable by
clicking .

5. Click OK. The link for the text popup is added to the topic. You can change the appearance of
the link by modifying the MadCap|popupHead and MadCap|popupBody styles in the
Stylesheet Editor.

6. Click to save your work.
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Editing Text Popups
You can edit text popups that you have inserted into a topic in at least two different ways: (1) edit
the popup hotspot and text, and (2) edit the style of the text popup.

How to Edit the Popup Hotspot and Text
The first way to edit text popups is to change the popup hotspot and/or the text that users see
when the popup opens.

EXAMPLE You test the topic containing the text popup and you notice that a word is
misspelled in the popup text. You can use the following steps to correct the spelling in the
popup.

1. Open the content file.

2. In XML Editor, right-click anywhere in the text popup marker.

3. In the menu, select Edit Popup. The Insert Text Popup dialog opens.

4. Change the text for the hotspot or the popup itself.

5. Click OK. The changes are made to the text popup.

6. Click to save your work.
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How to Edit the Style of a Text Popup
You can edit the style (e.g., font, color) of a text popup hotspot or the popup body. When you do
this, the style changes for all text popups in any topics in your project.

EXAMPLE You want to change the font for your text popup hotspots to dark green with no
underline. The following steps show you how to accomplish this.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. On the left side of the editor, find and select the style called MadCap|popupHead (for the
hotspot) or MadCap|popupBody (for the body of the popup).

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

9. Click to save your work.
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CHAPTER 17

Togglers
Supported In:

A toggler is a feature that lets users click a hotspot to reveal one or more named elements in a
topic. A named element (also called the "toggler target") is a chunk of content that can reside
anywhere in the topic. When users click the toggler hotspot, the output reveals hidden content
elements. When users click the hotspot again, the content is hidden again.

CHAPTER 17  250



This chapter discusses the following:

Inserting Togglers 252

Editing Togglers 254

Deleting Togglers 257
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Inserting Togglers
Following are steps for inserting a toggler.

How to Insert a Toggler
1. Open the content file.

2. Click anywhere in the paragraph that you want to toggle (the content that will open when
users click the hotspot).

3. Select Home > Name.

4. Type a name for the toggled element (anything that will help you identify it).

5. Click OK. The named element is added, with a yellow flag next to it. The flag will not
display in the output. It is simply used to show you where a named element has been
inserted. You can hide or show this flag by selecting the option from the Show tags button

in the XML Editor local toolbar.

6. In the topic, highlight the text that you want to use as the toggler hotspot.

7. Select Insert > Toggler.

8. In the Toggler targets section, click the check box next to the toggler element that you
created.

9. (Optional) In the Toggler class section, select a style class to be associated with the toggler.
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10. Click OK. The toggler hotspot now has the toggler icon next to it in the XML Editor. The
icon will not display in the output. It is simply used to show you where a named element has
been inserted.

11. Click to save your work.

CHAPTER 17  253



Editing Togglers
You can edit togglers that you have inserted into a topic in at least three different ways: (1) edit the
content in the section that is "toggled," (2) edit the style of a toggler hotspot, and (3) associate the
hotspot with another toggler element and/or style class.

How to Edit the Toggler Content
The first way to edit drop-down text is to change the actual content in the section that gets
"toggled" when users click the hotspot.

1. Open the content file.

2. In the XML Editor, click in the area containing the toggler content. Then add, remove, or
replace content as necessary.

3. Click to save your work.

How to Edit the Style of a Toggler Hotspot
You can edit the style (e.g., font, color) of a toggler hotspot. When you do this, the style changes for
all toggler hotspots in any topics in your project.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. On the left side of the editor, find and select the style called MadCap|toggler (or a toggler
style class you have created within it).
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5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

Following are some of the more common properties that you might change.

n mc-closed-image This style, located in the Unclassified property group, lets you select
an image to be shown next to the toggler effect when it is in a closed state.

n mc-closed-image-alt-text This style, located in the Unclassified property group, lets you
set alternate text for the toggler effect when it is in a closed state.

n mc-open-image This style, located in the Unclassified property group, lets you select an
image to be shown next to the toggler effect when it is in an open state.

n mc-open-image-alt-text This style, located in the Unclassified property group, lets you
set alternate text for the toggler effect when it is in an open state.

n mc-image-spacing This style, located in the Unclassified property group, lets you set
the spacing around the image next to the toggler effect.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

9. Click to save your work.
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How to Associate a Hotspot With Another
Toggler Element
The third way to edit a toggler is to associate the hotspot with another toggler element and/or style
class.

EXAMPLE You might have multiple sections of content in a topic that are open and closed
via toggler hotspots. If you are using one hotspot to "toggle" one section of content, you
can easily associate that hotspot with an additional section of content, so that it "toggles"
both areas when a user clicks it.

1. Open the content file.

2. If you have not yet given a toggler element name to the content that you want to show and
hide, follow the steps for inserting a toggler.

3. In the XML Editor, right-click the icon at the beginning of the toggler hotspot.

4. In the menu, select Edit Toggler. The Insert Toggler dialog opens.

5. In the Toggler targets section, click the check box next to any toggler elements that you want
to associate with the hotspot. You can select as many toggler elements as needed.

6. In the Toggler class section, select a style class to be associated with the toggler.

7. Click OK.

8. Click to save your work.
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Deleting Togglers
If you have inserted a toggler into a topic and want to remove the toggler hotspot, use the following
steps.

How to Delete a Toggler
1. Open the content file.

2. Right-click the icon at the beginning of the toggler.

3. From the menu, select Delete. The toggler hotspot and its content are removed from the
topic.

4. Click to save your work.
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CHAPTER 18

Toolbars
Supported In:

NOTE eLearning toolbars are supported in HTML5 output only. They are not supported in
the other outputs listed above.

There are three types of toolbars that you can add to your online output—topic, web, and eLearning.
A topic toolbar displays buttons in a custom toolbar within the topic content, based on the insertion
of a Topic Toolbar proxy. A web toolbar displays buttons within the skin framework. An eLearning
toolbar is typically shown at the bottom of topics to guide individuals through an online eLearning
course. See "Topic Toolbars" on page 260, "Web Toolbars" on page 325, and "eLearning Toolbars"
on page 349.

This chapter discusses the following:

Toolbars and Skins 259

Topic Toolbars 260

Web Toolbars 325

eLearning Toolbars 349
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Toolbars and Skins
The kinds of toolbars (and sometimes the buttons) that are available depend on the type of skin you
are using.

Skin Type Topic Toolbar Web Toolbar eLearning Toolbar

HTML5 Top
Navigation1

HTML5 Side
Navigation1

HTML5 Skinless1

HTML5 Tripane2

Standard3

1Side and Top Navigation—as well as skinless outputs—do not use frames, like
other outputs do. Therefore, you must use a topic toolbar if you want to display
toolbar buttons.
2In an HTML5 Tripane skin, you can configure a web toolbar by using the Toolbar
tab.
3Although Pulse is supported in WebHelp and WebHelp Plus targets, you can add
Pulse-related buttons (e.g., Edit User Profile, Topic Ratings) only in a WebHelp
toolbar. You cannot add them in a topic toolbar.
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Topic Toolbars
Supported In:

A topic toolbar displays buttons in a custom toolbar within the topic content, based on the insertion
of a Topic Toolbar proxy. In addition to a Topic Toolbar proxy, you can use a skin component (for
HTML5) or a Standard skin (for WebHelp and HTML Help outputs). Choosing the buttons for the
toolbar can be done in the proxy, but it can also be done in the skin or skin component (proxy
selections have precedence).
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How to Create a Topic Toolbar
1. (Optional) Add a skin or skin component, depending on your output type:

n Topic Toolbars in HTML5 Skin Components

n Topic Toolbars in WebHelp Outputs

You can control the look of the items in the topic toolbar, and the background of the topic
toolbar, by opening the Styles tab of the Skin Editor and modifying the appropriate styles. By
default, the background is transparent so it will show whatever is behind it in the body of the
topic. When you change any of these styles, they affect settings for items in both regular web
toolbars and in topic toolbars.

2. (Optional) You can create and edit a Madcap|topicToolbarProxy style class to control the look
of the toolbar.

3. Place your cursor in a template page and select Insert > Proxy > Insert Topic Toolbar Proxy.
From the dialog, you can select a skin component, style class, and buttons.
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Topic Toolbar Buttons Supported
Although topic toolbars can be added in most online outputs, only certain buttons are supported in
the various outputs. The following table provides an overview.

The following table does not list Pulse-related toolbar buttons, such as Edit User Profile and Topic
Ratings. These kinds of buttons must be added either via the web toolbar (for HTML5 Tripane,
WebHelp, or WebHelp Plus outputs) or the Topic Toolbar skin component (for all HTML5 outputs).

HTML Help HTML5 WebHelp WebHelp Plus

Add Topic to
Favorites

Back

Collapse All

Current Topic
Index

Expand All

Forward

Home

Next Topic

Previous Topic

Print

Quick Search

Refresh
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HTML Help HTML5 WebHelp WebHelp Plus

Remove Search
Highlight

Select Browse
Sequence

Select
Community

Select Favorite

Select Glossary

Select Index

Select
Language

Select Search

Select Skin

Select TOC

Separator

Stop
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HTML Help HTML5 WebHelp WebHelp Plus

Hide Navigation

1Collapse All and Expand All are the same button for HTML5.

2This button is supported only for HTML5 output that is using a Tripane skin. It is not
supported for HTML5 output using a Top Navigation skin, or no skin.
3If you are using a Tripane skin, this button lets you navigate browse sequences. If you
are using a Top Navigation skin or no skin (or if you are using a Tripane skin without a
browse sequence), this button lets you browse table of contents entries.
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Examples
The Previous and Next buttons in HTML5 output using Side or Top Navigation skins (or no skin)
differ from those in other WebHelp and other output types (including HTML5 outputs using a
Tripane skin). In WebHelp and other output types, the Previous and Next buttons navigate between
topics in a browse sequence (if one is available); otherwise they navigate between topics in the
table of contents.

EXAMPLE — HTML5 Top Navigation (TOC)

You might want to include Previous and Next buttons in your online HTML5 Top Navigation
output when you use topics that are sequential, such as a tutorial or a long process
spanning many topics.

In this example, a user tutorial has several numbered topics that have been added to the
table of contents (TOC). We’ve added a menu proxy so that these TOC items display next to
the open topic.
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When users work through the tutorial, they start at Step 1 and then logically progress
through each topic using the Next button.
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If they need to go back to a previous topic in the TOC, it is easy for the user to click the
Previous button to find the topic.
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EXAMPLE — WebHelp (Browse Sequence)

Let's say you want to add Next and Previous buttons, as well as the Home button, at the
bottom of each topic in your WebHelp output. The buttons will use a browse sequence that
you’ve added to your output.

Therefore, you open your skin and select the Topic Toolbar tab. The default settings
already include the Next Topic, Current Topic Index, and Previous Topic items.
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In the Selected section, you select CurrentTopicIndex and click at the bottom of the tab.
This moves that item back to the Available section on the left.
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Next, in the Available section, you select the Home item and click to move it to the
Selected section.

CHAPTER 18  270



Now that the settings in the Skin Editor are completed, you can save your changes and
insert the Topic Toolbar proxy (alternatively, you could have inserted the proxy before
editing the skin). If you had wanted the custom toolbar to display in only a few topics, you
would probably insert the proxy directly into those topics. However, because you want the
toolbar to display at the bottom of every topic, the best way to accomplish this is to insert
the proxy into a template page.
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After making sure both the skin and the template page are associated with the WebHelp
target, you can generate the output.
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Suppose you have created your own arrow images and want to use them instead of the
images provided by Flare. You can simply select your image files in the Styles tab of the
Skin Editor.

Afterwards, the output might look something like this:

CHAPTER 18  273



Process for Topic Toolbars
Certain tasks must be completed in order when using this feature.

Editing HTML5 Topic Toolbar Skin Components
In Topic Toolbar skin components, you can use skin styles to control the look of a toolbar you add
via a proxy.
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How to Edit an HTML5 Topic Toolbar Skin Component

1. Open an HTML5 Topic Toolbar skin component.

2. Select the Setup tab, and choose the buttons you want to include in the toolbar, moving them
to the right side of the tab. You can also add custom buttons (see "Adding Custom Buttons to
a Toolbar" on page 294).

3. Select the Styles tab.

4. (Optional) If you are using responsive output, make sure you select the appropriate medium—
Web, Tablet, or Mobile—in the local toolbar before making changes to styles. 

5. On the left side of the editor, expand and select any of the following Toolbar style groups:

Toolbar This controls the look of the entire toolbar, such as its alignment and
margins.

Toolbar >
Button

This controls the look of individual buttons in the toolbar. If you set the
properties at the root level, then all the buttons are affected. If you want
specific values for a particular button, select the style group for that
button and then set the properties for it.

Toolbar >
Button
Separator

This controls the look of the separator between buttons.

Toolbar >
Button Drop-
down

This controls the look of the toolbar button drop-down menu. You can
also set properties for menu items, such as hover properties and fonts.
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6. Expand any of the nodes and complete the necessary fields. The properties and fields that
you see are different for each node. Following is a general list in alphabetical order:

ALIGNMENT

You can click in the Horizontal field and choose whether to position to the right or left side of
the display.

BACKGROUND

You can change any of the following to affect the background:

n Gradient This lets you change the background color using a progression effect. Select
the beginning gradient color in the first field, and then select a second gradient color in
the second field. You can use any of the following to enter or select a color.

You can type a hexadecimal number (e.g., #000000) directly in
this field. Alternatively, you can click the down arrow and choose
a color or make the background transparent.

This opens the Color Picker dialog, which lets you choose a color
in many ways. Note that you can select a CSS variable.

Adds a small bar above the cursor. As you move the cursor over
any area of your screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click,
that color is loaded into the Color Picker dialog.

n Color This lets you select a single color.

n Image This lets you select an image for the background. Click and use the dialog to
select an image file.

n Repeat Use this field to tell Flare whether the image should repeat or not.

NOTE The Image field has the highest precedence, which means that if you enter
settings in all of the Background fields, the image will win. Gradient has the next
highest precedence. If you want to use the Color field, you need to make sure the
Gradient fields are set to transparent and that there is no image selected.
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BORDER

You can change any of the following to affect the border on the element:

n Border Edge Fields (Top, Right, Bottom, Left) You can add a border line around any of
the edges of the element. You can use any of the following. The first three fields are
used to control the type and size of the border line. The last three fields are alternative
ways to choose a color for the border.

You can select a type of line for the border (e.g., solid, dashed,
dotted).

Type a number in the field or use the arrows to increase or
decrease it.

Click in this field and select a unit of measurement (e.g., pixels,
points, centimeters).

You can type a hexadecimal number (e.g., #000000) directly in
this field. Alternatively, you can click the down arrow and choose
a color.

This opens the Color Picker dialog, which lets you choose a color
in many ways. Note that you can select a CSS variable.

Adds a small bar above the cursor. As you move the cursor over
any area of your screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click,
that color is loaded into the Color Picker dialog.

n Border Radius Fields (Top Left, Top Right, Bottom Right, Bottom Left) If you want the
element to have rounded corners, you can enter values in any of these fields. In the first
field type a number or use the arrows. Then click in the second field and select the unit
of measurement (e.g., pixels, points, centimeters). The higher the number, the more of
a curve the corner will have.
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BOX SHADOW

You can change any of the following to affect the box shadow on the element:

n Horizontal Shadow Length This is the position of the horizontal shadow. Negative
values are allowed. In the first field type a number or use the arrows. Then click in the
second field and select the unit of measurement (e.g., pixels, points, centimeters).

n Vertical Shadow Length This is the position of the vertical shadow. Negative values are
allowed. In the first field type a number or use the arrows. Then click in the second field
and select the unit of measurement (e.g., pixels, points, centimeters).

n Shadow Blur Length This is the blur distance. In the first field type a number or use the
arrows. Then click in the second field and select the unit of measurement (e.g., pixels,
points, centimeters).

n Shadow Color This lets you select a color for the shadow. You can use any of the
following:

You can type a hexadecimal number (e.g., #000000) directly in
this field. Alternatively, you can click the down arrow and choose
a color or make the background transparent.

This opens the Color Picker dialog, which lets you choose a color
in many ways. Note that you can select a CSS variable.

Adds a small bar above the cursor. As you move the cursor over
any area of your screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click,
that color is loaded into the Color Picker dialog.

n Shadow Inset This changes the shadow from an outer shadow (outset) to an inner
shadow. Click in the field and select an option. If you select false the shadow will be
outset. If you select true the shadow will be inset.
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EVENT

You can enter a special JavaScript command that is triggered when an end user clicks a
button. For example, the following command opens the MadCap Software website when a
user clicks the button:

window.open("http://www.madcapsoftware.com");

FONT

You can change any of the following to affect the font:

n Color This lets you select a color for the font. You can use any of the following:

You can type a hexadecimal number (e.g., #000000) directly in
this field. Alternatively, you can click the down arrow and choose
a color.

This opens the Color Picker dialog, which lets you choose a color
in many ways. Note that you can select a CSS variable.

Adds a small bar above the cursor. As you move the cursor over
any area of your screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click,
that color is loaded into the Color Picker dialog.

n Family You can select or type a specific font family (e.g., Arial, Tahoma, Verdana).

n Size You can change the font size. In the first field type a number or use the arrows.
Then click in the second field and select the unit of measurement (e.g., pixels, points).

n Weight You can click in this field and make the font normal or bold.

n Style You can click in this field and make the font normal or italic.
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GENERAL

You can change the color for the element.

You can type a hexadecimal number (e.g., #000000) directly in this field.
Alternatively, you can click the down arrow and choose a color.

This opens the Color Picker dialog, which lets you choose a color in
many ways. Note that you can select a CSS variable.

Adds a small bar above the cursor. As you move the cursor over any
area of your screen, the color changes in the bar to reflect the color that
is directly behind the tip of the cursor. When you click, that color is
loaded into the Color Picker dialog.

HEIGHT

You enter a height for the element. In the first field type a number or use the arrows. Then
click in the second field and select the unit of measurement (e.g., pixels, points, centimeters).

ICON

You can click and select a different image for the toolbar button.

You can click the Display drop-down and choose one of the options:

n none The element will not be shown.

n block The element will be shown and adds a line break after it. For some elements this
option might be called flex, which reflects the flexbox technology associated with it.

You can change the height or width of the element. In the first field type a number or use the
arrows. Then click in the second field and select the unit of measurement (e.g., pixels, points,
centimeters).
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LAYOUT

You can click in the Display field and choose one of the options (some of these options might
not be available for certain styles):

n none The element will not be shown.

n block The element will be shown and adds a line break after it. For some elements this
option might be called flex, which reflects the flexbox technology associated with it.

n inline The element will be shown but does not add a line break after it, allowing it to be
positioned next to other elements.

n inline-block The element will be shown but does not add a line break after it, allowing it
to be positioned next to other elements. This is similar to inline; however, with this
option, a width and height can be set on the element, and top/bottom margin and
padding settings are respected.

MARGIN

You can change the margin for any of the sides on the element (Left, Right, Top, Bottom). In
the first field type a number or use the arrows. Then click in the second field and select the
unit of measurement (e.g., pixels, points, centimeters).

PADDING

You can change the padding for any of the sides on the element (Left, Right, Top, Bottom). In
the first field type a number or use the arrows. Then click in the second field and select the
unit of measurement (e.g., pixels, points, centimeters).

SIZE

You can change the height or width of the element. In the first field type a number or use the
arrows. Then click in the second field and select the unit of measurement (e.g., pixels, points,
centimeters).
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TEXT

You can click the Display drop-down and choose one of the options:

n none The element will not be shown.

n block The element will be shown and adds a line break after it. For some elements this
option might be called flex, which reflects the flexbox technology associated with it.

You can change any of the following to affect the font:

l Color This lets you select a color for the font. You can use any of the following:

You can type a hexadecimal number (e.g., #000000) directly in
this field. Alternatively, you can click the down arrow and
choose a color.

This opens the Color Picker dialog, which lets you choose a
color in many ways. Note that you can select a CSS variable.

Adds a small bar above the cursor. As you move the cursor
over any area of your screen, the color changes in the bar to
reflect the color that is directly behind the tip of the cursor.
When you click, that color is loaded into the Color Picker
dialog.

l Family You can select or type a specific font family (e.g., Arial, Tahoma, Verdana).

l Size You can change the font size. In the first field type a number or use the arrows.
Then click in the second field and select the unit of measurement (e.g., pixels,
points).

l Weight You can click in this field and make the font normal or bold.

l Style You can click in this field and make the font normal or italic.
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TEXT SHADOW

You can change any of the following to affect the text shadow on the element:

n Shadow Visibility You can click in this field and choose to make the shadow either
hidden or visible.

n Horizontal Shadow Length This is the position of the horizontal shadow. Negative
values are allowed. In the first field type a number or use the arrows. Then click in the
second field and select the unit of measurement (e.g., pixels, points, centimeters).

n Vertical Shadow Length This is the position of the vertical shadow. Negative values are
allowed. In the first field type a number or use the arrows. Then click in the second field
and select the unit of measurement (e.g., pixels, points, centimeters).

n Shadow Blur Length This is the blur distance. In the first field type a number or use the
arrows. Then click in the second field and select the unit of measurement (e.g., pixels,
points, centimeters).

n Shadow Color This lets you select a color for the shadow. You can use any of the
following:

You can type a hexadecimal number (e.g., #000000) directly in
this field. Alternatively, you can click the down arrow and choose
a color or make the background transparent.

This opens the Color Picker dialog, which lets you choose a color
in many ways. Note that you can select a CSS variable.

Adds a small bar above the cursor. As you move the cursor over
any area of your screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click,
that color is loaded into the Color Picker dialog.

7. Click to save your work.
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Editing Topic Toolbar Settings in a Standard Skin
Supported In:

In addition to the regular web toolbars that can be included in all most online outputs, you have
another option for including toolbars. This option lets you insert toolbars anywhere in any topics.
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How to Edit Topic Toolbar Settings in a Standard Skin

Following are steps for specifying toolbar settings in a Standard skin. You can select the buttons
either in these steps or when you insert the topic toolbar proxy.

1. Open a Standard skin.

2. Select the Topic Toolbar tab.

3. Select options to include specific features (buttons) in the toolbar. Items that will be included
in the toolbar are displayed in the Selected section on the right. Items that will not be included
in the toolbar are displayed in the Available section on the left. You can use the right arrow
button to move items from the Available section to the Selected section.

Following are descriptions of the various items.
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ADD TOPIC TO FAVORITES

Lets users add the active topic to the Favorites pane so that they can quickly access the topic
in the future.

BACK

Lets users open the topic that was viewed previously.

COLLAPSE ALL

Lets users collapse all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are expanded).
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CURRENT TOPIC INDEX

Lets users see the display for the current topic in the sequence. This is typically used in
conjunction with the "Next Topic" and "Previous Topic" buttons when the topic in question
exists in a browse sequence. Flare finds the current topic in a browse sequence and display
its position in relation to the rest of the topics in that sequence. (The root node is used to
determine the count; in other words, if there are "child" topics in the sequence structure under
the current topic, they will be included in the count.)

EXPAND ALL

Lets users expand all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are not yet expanded).

FORWARD

Lets users open the next topic in a previously viewed sequence.
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HOME

Lets users open a designated home page (such as your company's website)

NEXT TOPIC

Lets users open the next topic in the output. If you are using a browse sequence, Flare
attempts to find the current topic in a browse sequence and navigate to the next topic from
there. If you are using HTML5 Side Navigation, Top Navigation, or skinless output, or if you
are not using a browse sequence, Flare looks at the position of the current topic in your table
of contents (TOC) and opens the next topic after it.

PREVIOUS TOPIC

Lets users open the previous topic in the output. If you are using a browse sequence, Flare
attempts to find the current topic in a browse sequence and navigate to the previous topic
from there. If you are using HTML5 Side Navigation, Top Navigation, or skinless output, or if
you are not using a browse sequence, Flare looks at the position of the current topic in your
table of contents (TOC) and opens the previous topic before it.
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PRINT

Lets users open the Print dialog so that they can send the open topic to the printer.

QUICK SEARCH

Lets users initiate a search in the active topic for the word or phrase that has been typed in
the field next to the button.

REFRESH

Lets users update the content of the topic being viewed.

REMOVE HIGHLIGHT

After a user performs a quick search in a topic, the search text found in the topic is
highlighted. This button lets users turn the highlights off.
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SELECT BROWSE SEQUENCE

Lets users open the Browse Sequence feature.

SELECT COMMUNITY

Lets users access their Pulse community features, if the are using MadCap Pulse.

SELECT FAVORITES

Lets users open the Favorites feature.

SELECT GLOSSARY

Lets users open the Glossary feature.
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SELECT INDEX

Lets users open the Index feature.

SELECT SEARCH

Lets users open the Search feature.

SELECT TOC

Lets users open the TOC feature.

STOP

Lets users prevent a page from downloading file information.
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TOGGLE NAVIGATION PANE

Lets users toggle between hiding and showing the navigation pane in the output window.

4. (Optional) You can use the buttons at the bottom of the tab to perform additional tasks.

Opens the New Toolbar Button dialog, which lets you add a custom button to
the toolbar. After creating the custom button, select it and click to move it to
the Selected section.

Unless you specify otherwise, in the output the new button will display the text
for the name you gave it. However, you can change this by editing the control
type for the new button. To do this, you can select the Styles tab in the Skin
Editor, expand the Toolbar Item node, select one of the styles listed above,
expand the Type property group, and from the Control Type field select Button.
To choose an image for the button, expand the General property group on the
Styles tab and select image files in the Icon fields.

If you want to provide a command for the custom button (e.g., so that clicking
the button opens a website), you can select the Styles tab in the Skin Editor,
expand the Toolbar Item node, select one of the styles listed above, expand the
Type property group, and enter a command in the OnClick field. For example,
the following command opens the MadCap Software website when a user
clicks the button:

window.open("http://www.madcapsoftware.com");

Alternatively, you can use the JavaScript area on the Topic Toolbar tab to enter
a command for the button. See the next step.

Removes the selected custom button from the Available section.
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Moves the selected item up in the order in the Selected section. In the output,
buttons are displayed left to right according to the order in which they appear
on this tab, with the item at the top being the first button shown on the left in
the output.

Moves the selected item down in the order in the Selected section.

Removes the selected item(s) from the Selected section.

Adds a separator to the Selected section. A separator is the divider between the
toolbar buttons and the navigation pane.

Resets the toolbar to the default settings.

5. (Optional) If you want to include custom JavaScript in the toolbar, click Edit in the area to the
right. This opens the Toolbar JavaScript dialog, which you can use to enter or load custom
JavaScript for the toolbar.

For example, the following command opens the MadCap Software website when a user clicks
the button:

function MyFunction()
{
window.open("http://www.madcapsoftware.com");
}

6. Click to save your work.
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Adding Custom Buttons to a Toolbar
Supported In:

In addition to the toolbar button options provided by Flare, you can add your own custom buttons
with some associated JavaScript to serve various purposes. To work through a scenario for adding
custom buttons with JavaScript, see the Custom Toolbar Tutorial.

How to Add a Custom Toolbar Button

1. From the Project Organizer, open your Topic Toolbar skin component (if producing HTML5)
or your Standard skin (and select the Topic Toolbar tab, if producing another output type).

2. At the lower-left of the editor, click .

3. In the dialog, provide a name for the new button, then click OK.

4. On the left side of the editor, double-click the name of your custom button to move it to the
right. Then use the arrow keys at the bottom to adjust its placement in the list of buttons. The
higher a button is in the list, the further to the left it will be in the toolbar. The lower it is, the
further to the right it will be.

5. Add JavaScript for the button:

n If the button requires multiple lines of JavaScript, select the button name. Then, on the
lower-right of the editor, click Edit. Enter or paste your JavaScript Code, and click OK.

n If the button just requires one line of JavaScript for its event, select the Styles tab in the
editor. Expand the Toolbar Button node. Then expand the node with the name of your
custom button. Finally, expand the Event node and in the Click field, enter the
JavaScript.

NOTE The above is for a Topic Toolbar skin component. If you are working in a
Standard skin for a non-HTML5 output, the node and field labels are just a bit
different (e.g., Toolbar Item, Type, OnClick).
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6. Provide a background image to represent the button. Under the node with your button name,
expand the Background node, and complete the Image field.

NOTE If you are working in a Standard skin for a non-HTML5 output, the node and
field labels are just a bit different.

7. (Optional) Use any of the other nodes and fields on the Styles tab to make further design
changes for the custom button.

8. Click to save your work.
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Using a Style to Edit the Look of Topic Toolbars
Supported In:

You can use the Madcap|topicToolbarProxy style to change the look of the container holding
generated topic toolbars, although it is not always the preferred method, especially with HTML5
output, where modifying the skin component is more common. For more information about how
the style settings work with the different kinds of outputs that support topic toolbars, see the online
Help.

How to Use a Style to Edit the Look of Topic Toolbars

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE Some of the necessary style properties can also be changed in the Simplified
view in the Stylesheet Editor.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. On the left side of the editor, select MadCap|topicToolbarProxy.

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.
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6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

Here are some of the more common properties that you might change.

n Border below To change the border line that appears at the bottom of the topic toolbar,
expand the Borders property group. Then to the right of border-bottom, click , and in
the popup set the border width, unit of measurement, color, and/or style. Click OK. You
can also use the other cells in this property group to add borders above, to the left, or to
the right of the topic toolbar.

n Padding above To change the amount of empty space (padding) above the text within
the topic toolbar container, expand the Box property group. Then to the right of
padding-top, click , in the popup set the padding value, and click OK.

n Padding below To change the amount of empty space (padding) below the text within
the topic toolbar container, expand the Box property group. Then to the right of
padding-bottom, click , in the popup set the padding value, and click OK.

n Space above To change the amount of space above the topic toolbar container, expand
the Box property group. Then to the right of margin-top, click , in the popup set the
margin value, and click OK.

n Space below To change the amount of space below the topic toolbar container, expand
the Box property group. Then to the right of margin-bottom, click , in the popup, set
the margin value, and click OK.
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NOTE Different browsers may treat margin and padding settings differently. For
example, Internet Explorer 8 and Firefox honor padding settings more than they
honor margin settings. If you were to set a left margin at, say, 1 inch, Internet Explorer
7 would show it that way. However, in order to get the same results in Internet
Explorer 8 or Firefox, you would also need to set the left padding at 1 inch.

9. Click to save your work.
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Inserting and Editing a Topic Toolbar Proxy
Supported In:

You can use the Topic Toolbar proxy to generate a toolbar anywhere in your topics. This is an
alternative (or an additional option) to the web toolbar that can be included in some online outputs.

How to Insert a Topic Toolbar Proxy

1. Do one of the following:

n Open a topic where you want the toolbar to appear. This is a good method if you only
want the toolbar to be shown in one topic, or just a few topics.

n Open a template page that you will use when generating the target. This is the best
method if you want the toolbar to be shown on all topics in the output.

2. Place your cursor where you want the toolbar to be shown in the output (e.g., bottom or top
of the topic or template page). If you are working in a template page, you may need to press
the down arrow on your keyboard and then press ENTER at the correct location.

3. Select Insert > Proxy > Insert Topic Toolbar Proxy. The Topic Toolbar Proxy dialog opens.

4. (Optional) If you are working with HTML5 output, you can select a skin component in the Skin
File field. From the Topic Toolbar Skin Editor, you can select the buttons to be included in the
toolbar. Alternatively, you can select buttons from the Buttons field below.

If you do not select a skin component in this field, Flare uses the first one it finds in your
project (if one exists). Otherwise, Flare provides a default design.
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5. (Optional) In the Stylesheet class for proxy field, you can select a class to affect the look of
the entire toolbar.

You might create and use a proxy style class, for example, if you want to add a border around
the toolbar. If you do not select a class from this field, the generated toolbar will use the style
settings from the parent MadCap|topicToolbarProxy style. You have the option of creating a
class for this proxy style in the Stylesheet Editor. To do this, select the
MadCap|topicToolbarProxy style and in the local toolbar click Add Selector to create a class.
The class will then be available from this field.

6. (Optional) You can select buttons for the toolbar here, rather than doing so in the skin.
However, adding buttons in the skin might be preferable, especially since you can also add
custom buttons there (see "Adding Custom Buttons to a Toolbar" on page 294).

a. Click Select buttons.

b. From the Available section, select the buttons you want to include (select multiple
buttons by pressing the SHIFT or CTRL key and clicking a range or individual buttons,
respectively). Then click to move the button(s) to the Selected section.

ADD TOPIC TO FAVORITES

Lets users add the active topic to the Favorites pane so that they can quickly access
the topic in the future.

BACK

Lets users open the topic that was viewed previously.
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COLLAPSE ALL

Lets users collapse all elements such as togglers, drop-down effects, and expanding
text effects in a topic (if they are expanded).

CURRENT TOPIC INDEX

Lets users see the display for the current topic in the sequence. This is typically used in
conjunction with the "Next Topic" and "Previous Topic" buttons when the topic in
question exists in a browse sequence. Flare finds the current topic in a browse
sequence and display its position in relation to the rest of the topics in that sequence.
(The root node is used to determine the count; in other words, if there are "child" topics
in the sequence structure under the current topic, they will be included in the count.)

EXPAND ALL

Lets users expand all elements such as togglers, drop-down effects, and expanding
text effects in a topic (if they are not yet expanded).
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FORWARD

Lets users open the next topic in a previously viewed sequence.

HOME

Lets users open a designated home page (such as your company's website)

NEXT TOPIC

Lets users open the next topic in the output. If you are using a browse sequence, Flare
attempts to find the current topic in a browse sequence and navigate to the next topic
from there. If you are using HTML5 Side Navigation, Top Navigation, or skinless output,
or if you are not using a browse sequence, Flare looks at the position of the current
topic in your table of contents (TOC) and opens the next topic after it.
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PREVIOUS TOPIC

Lets users open the previous topic in the output. If you are using a browse sequence,
Flare attempts to find the current topic in a browse sequence and navigate to the
previous topic from there. If you are using HTML5 Side Navigation, Top Navigation, or
skinless output, or if you are not using a browse sequence, Flare looks at the position of
the current topic in your table of contents (TOC) and opens the previous topic before it.

PRINT

Lets users open the Print dialog so that they can send the open topic to the printer.

QUICK SEARCH

Lets users initiate a search in the active topic for the word or phrase that has been
typed in the field next to the button.
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REFRESH

Lets users update the content of the topic being viewed.

REMOVE HIGHLIGHT

After a user performs a quick search in a topic, the search text found in the topic is
highlighted. This button lets users turn the highlights off.

SELECT BROWSE SEQUENCE

Lets users open the Browse Sequence feature.

SELECT COMMUNITY

Lets users access their Pulse community features, if the are using MadCap Pulse.

CHAPTER 18  304



SELECT FAVORITES

Lets users open the Favorites feature.

SELECT GLOSSARY

Lets users open the Glossary feature.

SELECT INDEX

Lets users open the Index feature.
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SELECT LANGUAGE

Lets users switch between languages using a drop-down menu, if you have built
multilingual output.

EXAMPLE You want your users to be able to switch between US English,
Spanish, and Japanese Help in your HTML5 output.

Before you can build your output, you need to make sure that each of your
linked multilingual projects has the Select Language button is available in its
HTML5 toolbar, and that you've added the Topic Toolbar proxy to a template
page. If it the button isn't there, users won't be able to switch from one
language to another in your output.

Open the Project Organizer. In the Skins folder, open the Topic Toolbar skin

component. On the Setup tab, select the Select Language button, click to
add it to your skin, and then save your work.

Now you can prepare and build your multilingual output.

When you open the HTML5 output, it defaults to the US English Help because
that is your browser’s default setting.
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However, because you added the Select Language button to your Topic
Toolbar skin component, you can easily change the language setting using a
drop-down menu.

Now the Japanese project is listed before the Spanish project.

SELECT SEARCH

Lets users open the Search feature.
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SELECT SKIN

Lets users choose from multiple skins to change the display of the output.

EXAMPLE Your main Top Navigation skin has a black header background, but
you want users to be able to select a skin with a green header background and
a different logo, or even a third skin that does not have a header at all.
Therefore, you create the additional skins and edit them to look the way you
want. Then you add the Skins button in your Topic Toolbar skin component.

In the output, a user can click the button in the topic toolbar and choose one
of the options, which are based on the skin file name.
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If the user selects Green, the output might look something like this:

And if the user selects NoHeader, the output might look something like this:
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The name of the skin is reflected at the end of the URL in the browser.

SELECT TOC

Lets users open the TOC feature.
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SEPARATOR

This is the divider on the side of the row of buttons.

STOP

Lets users prevent a page from downloading file information.

TOGGLE NAVIGATION PANE

Lets users toggle between hiding and showing the navigation pane in the output
window.

c. Click OK when you are finished.

7. Click OK. The proxy is added.

8. Click to save your work.
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Editing a Topic Toolbar Proxy

After inserting a Topic Toolbar proxy, you can edit it. To do this, open the topic or template page
where the proxy is inserted, right-click on it, and select Edit Topic Toolbar Proxy.

What’s Noteworthy?

NOTE Although you can insert Topic Toolbar proxies in most of the online outputs,
choosing the buttons for the toolbar can be done in the skin for only some outputs. For
Microsoft HTML Help output, you can select buttons in the Topic Toolbar proxy only.

NOTE If you are generating an Eclipse Help target that uses a Topic Toolbar proxy, Flare
will automatically remove the proxy when building the output. This is because the Eclipse
development platform provides its own toolbar support. See the Platform Plug-in Developer
Guide from Eclipse at: help.eclipse.org
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Other Information for Topic Toolbars
In addition to the primary concepts, there is some additional information that might help you when
working with this feature.

Topic Toolbar Buttons Supported
Although topic toolbars can be added in most online outputs, only certain buttons are supported in
the various outputs. The following table provides an overview.

The following table does not list Pulse-related toolbar buttons, such as Edit User Profile and Topic
Ratings. These kinds of buttons must be added either via the web toolbar (for HTML5 Tripane,
WebHelp, or WebHelp Plus outputs) or the Topic Toolbar skin component (for all HTML5 outputs).

HTML Help HTML5 WebHelp WebHelp Plus

Add Topic to
Favorites

Back

Collapse All

Current Topic
Index

Expand All

Forward

Home

Next Topic

Previous Topic
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HTML Help HTML5 WebHelp WebHelp Plus

Print

Quick Search

Refresh

Remove Search
Highlight

Select Browse
Sequence

Select
Community

Select Favorite

Select Glossary

Select Index

Select
Language

Select Search

Select Skin

Select TOC

Separator
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HTML Help HTML5 WebHelp WebHelp Plus

Stop

Hide Navigation

1Collapse All and Expand All are the same button for HTML5.

2This button is supported only for HTML5 output that is using a Tripane skin. It is not
supported for HTML5 output using a Top Navigation skin, or no skin.
3If you are using a Tripane skin, this button lets you navigate browse sequences. If you
are using a Top Navigation skin or no skin (or if you are using a Tripane skin without a
browse sequence), this button lets you browse table of contents entries.
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Previous and Next Buttons
The Previous and Next buttons in HTML5 output using Side or Top Navigation skins (or no skin)
differ from those in other WebHelp and other output types (including HTML5 outputs using a
Tripane skin). In WebHelp and other output types, the Previous and Next buttons navigate between
topics in a browse sequence (if one is available); otherwise they navigate between topics in the
table of contents.

EXAMPLE — HTML5 Top Navigation (TOC)

You might want to include Previous and Next buttons in your online HTML5 Top Navigation
output when you use topics that are sequential, such as a tutorial or a long process
spanning many topics.

In this example, a user tutorial has several numbered topics that have been added to the
table of contents (TOC). We’ve added a menu proxy so that these TOC items display next to
the open topic.
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When users work through the tutorial, they start at Step 1 and then logically progress
through each topic using the Next button.
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If they need to go back to a previous topic in the TOC, it is easy for the user to click the
Previous button to find the topic.
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EXAMPLE — WebHelp (Browse Sequence)

Let's say you want to add Next and Previous buttons, as well as the Home button, at the
bottom of each topic in your WebHelp output. The buttons will use a browse sequence that
you’ve added to your output.

Therefore, you open your skin and select the Topic Toolbar tab. The default settings
already include the Next Topic, Current Topic Index, and Previous Topic items.
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In the Selected section, you select CurrentTopicIndex and click at the bottom of the tab.
This moves that item back to the Available section on the left.
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Next, in the Available section, you select the Home item and click to move it to the
Selected section.
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Now that the settings in the Skin Editor are completed, you can save your changes and
insert the Topic Toolbar proxy (alternatively, you could have inserted the proxy before
editing the skin). If you had wanted the custom toolbar to display in only a few topics, you
would probably insert the proxy directly into those topics. However, because you want the
toolbar to display at the bottom of every topic, the best way to accomplish this is to insert
the proxy into a template page.
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After making sure both the skin and the template page are associated with the WebHelp
target, you can generate the output.
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Suppose you have created your own arrow images and want to use them instead of the
images provided by Flare. You can simply select your image files in the Styles tab of the
Skin Editor.

Afterwards, the output might look something like this:
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Web Toolbars
Supported In:

Creating a web toolbar is simply a matter of adding and editing the appropriate skin, depending on
the output type. As long as that skin is associated with your target, end users will see the web
toolbar in the output.
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Web Toolbars in HTML5 Output
You can specify web toolbar settings for some online outputs. This includes determining which
buttons are displayed in the web toolbar. You can also add custom JavaScript for the toolbar.

How to Specify Custom Toolbar Settings for HTML5
Output

1. Open an HTML5 Tripane skin.

2. Select the Toolbar tab.

3. Select options to include specific features (buttons) in the toolbar. Items that will be included
in the toolbar are displayed in the Selected section on the right. Items that will not be included
in the toolbar are displayed in the Available section on the left. You can use the right arrow
button to move items from the Available section to the Selected section.

Following are descriptions of the various items.

CURRENT TOPIC INDEX

Lets users see the display for the current topic in the sequence. This is typically used in
conjunction with the "Next Topic" and "Previous Topic" buttons when the topic in question
exists in a browse sequence. Flare finds the current topic in a browse sequence and display
its position in relation to the rest of the topics in that sequence. (The root node is used to
determine the count; in other words, if there are "child" topics in the sequence structure under
the current topic, they will be included in the count.)
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EDIT USER PROFILE

Lets users edit their Pulse or Feedback registration profile settings.

EXPAND ALL

Lets users expand all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are not yet expanded).
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FILLER

Lets users add a filler item, which is used to specify where the empty space should go in the
toolbar.

NEXT TOPIC

Lets users open the next topic in the output. If you are using a browse sequence, Flare
attempts to find the current topic in a browse sequence and navigate to the next topic from
there. If you are using HTML5 Side Navigation, Top Navigation, or skinless output, or if you
are not using a browse sequence, Flare looks at the position of the current topic in your table
of contents (TOC) and opens the next topic after it.
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PREVIOUS TOPIC

Lets users open the previous topic in the output. If you are using a browse sequence, Flare
attempts to find the current topic in a browse sequence and navigate to the previous topic
from there. If you are using HTML5 Side Navigation, Top Navigation, or skinless output, or if
you are not using a browse sequence, Flare looks at the position of the current topic in your
table of contents (TOC) and opens the previous topic before it.

PRINT

Lets users open the Print dialog so that they can send the open topic to the printer.
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REMOVE HIGHLIGHT

After a user performs a quick search in a topic, the search text found in the topic is
highlighted. This button lets users turn the highlights off.

TOPIC RATINGS

Lets users submit ratings for a topic (if you have incorporated your output with MadCap
Pulse or Feedback).

4. (Optional) You can use the buttons at the bottom of the tab to perform additional tasks.

Opens the New Toolbar Button dialog, which lets you add a custom button to
the toolbar. After creating the custom button, select it and click to move it to
the Selected section.

If you want to provide a command for the custom button (e.g., so that clicking
the button opens a website), you can select the Styles tab in the Skin Editor,
select one of the styles listed above, expand the Event property group, and enter
a command in the Click field. For example, the following command opens the
MadCap Software website when a user clicks the button:

window.open("http://www.madcapsoftware.com");

Alternatively, you can use the JavaScript area on the Toolbar tab to enter a
command for the button. See the next step.
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Removes the selected custom button from the Available section.

Moves the selected item up in the order in the Selected section. In the output,
buttons are displayed left to right according to the order in which they appear
on this tab, with the item at the top being the first button shown on the left in
the output.

Moves the selected item down in the order in the Selected section.

Removes the selected item(s) from the Selected section.

Adds a separator to the Selected section. A separator is the divider between the
toolbar buttons and the navigation pane.

Resets the toolbar to the default settings.

5. (Optional) If you want to include custom JavaScript in the toolbar, click Edit in the area to the
right. This opens the Toolbar JavaScript dialog, which you can use to enter or load custom
JavaScript for the toolbar.

For example, the following command opens the MadCap Software website when a user clicks
the button:

function MyFunction()
{
window.open("http://www.madcapsoftware.com");
}

6. Click to save your work.
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Web Toolbars in HTML Help Output
If you incorporate MadCap Feedback into your Flare project and generate Microsoft HTML Help
output, a web toolbar is automatically added to the top of each topic in the CHM file. However, this
toolbar is not only for MadCap Feedback. Even if you are not using Feedback in your project, you
can add the web toolbar to your Microsoft HTML Help output.

In addition to submitting topic ratings and comments, the default buttons in the web toolbar let
users expand or collapse Dynamic HTML effects (e.g., drop-down text, expanding text), search, go
to the next or previous topic, and more. You can change the buttons included in the web toolbar,
removing ones you do not want and adding others.

How to Specify Custom Toolbar Settings for HTML
Help Output
After adding the web toolbar for Microsoft HTML Help output, complete the following steps.

1. Open a Standard skin.

2. Select the WebHelp Toolbar tab.

3. Select options to include specific features (buttons) in the toolbar. Items that will be included
in the toolbar are displayed in the Selected section on the right. Items that will not be included
in the toolbar are displayed in the Available section on the left. You can use the right arrow
button to move items from the Available section to the Selected section.

Following are descriptions of the various items.

BACK

Lets users open the topic that was viewed previously.
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COLLAPSE ALL

Lets users collapse all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are expanded).

CURRENT TOPIC INDEX

Lets users see the display for the current topic in the sequence. This is typically used in
conjunction with the "Next Topic" and "Previous Topic" buttons when the topic in question
exists in a browse sequence. Flare finds the current topic in a browse sequence and display
its position in relation to the rest of the topics in that sequence. (The root node is used to
determine the count; in other words, if there are "child" topics in the sequence structure under
the current topic, they will be included in the count.)

EDIT USER PROFILE

Lets users edit their Pulse or Feedback registration profile settings.
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EXPAND ALL

Lets users expand all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are not yet expanded).

FORWARD

Lets users open the next topic in a previously viewed sequence.

HOME

Lets users open a designated home page (such as your company's website)

NEXT TOPIC

Lets users open the next topic in the output. If you are using a browse sequence, Flare
attempts to find the current topic in a browse sequence and navigate to the next topic from
there. If you are using HTML5 Side Navigation, Top Navigation, or skinless output, or if you
are not using a browse sequence, Flare looks at the position of the current topic in your table
of contents (TOC) and opens the next topic after it.
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PREVIOUS TOPIC

Lets users open the previous topic in the output. If you are using a browse sequence, Flare
attempts to find the current topic in a browse sequence and navigate to the previous topic
from there. If you are using HTML5 Side Navigation, Top Navigation, or skinless output, or if
you are not using a browse sequence, Flare looks at the position of the current topic in your
table of contents (TOC) and opens the previous topic before it.

PRINT

Lets users open the Print dialog so that they can send the open topic to the printer.

QUICK SEARCH

Lets users initiate a search in the active topic for the word or phrase that has been typed in
the field next to the button.

CHAPTER 18  335



REFRESH

Lets users update the content of the topic being viewed.

REMOVE HIGHLIGHT

After a user performs a quick search in a topic, the search text found in the topic is
highlighted. This button lets users turn the highlights off.

STOP

Lets users prevent a page from downloading file information.

TOPIC RATINGS

Lets users submit ratings for a topic (if you have incorporated your output with MadCap
Pulse or Feedback).
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4. (Optional) You can use the buttons at the bottom of the tab to perform additional tasks.

Opens the New Toolbar Button dialog, which lets you add a custom button to
the toolbar. After creating the custom button, select it and click to move it to
the Selected section.

Unless you specify otherwise, in the output the new button will display the text
for the name you gave it. However, you can change this by editing the control
type for the new button. To do this, you can select the Styles tab in the Skin
Editor, expand the Toolbar Item node, select one of the styles listed above,
expand the Type property group, and from the Control Type field select Button.
To choose an image for the button, expand the General property group on the
Styles tab and select image files in the Icon fields.

If you want to provide a command for the custom button (e.g., so that clicking
the button opens a website), you can select the Styles tab in the Skin Editor,
expand the Toolbar Item node, select one of the styles listed above, expand the
Type property group, and enter a command in the OnClick field. For example,
the following command opens the MadCap Software website when a user
clicks the button:

window.open("http://www.madcapsoftware.com");

Alternatively, you can use the JavaScript area on the WebHelp Toolbar tab to
enter a command for the button. See the next step.

Removes the selected custom button from the Available section.

Moves the selected item up in the order in the Selected section. In the output,
buttons are displayed left to right according to the order in which they appear
on this tab, with the item at the top being the first button shown on the left in
the output.

Moves the selected item down in the order in the Selected section.

Removes the selected item(s) from the Selected section.

CHAPTER 18  337



Adds a separator to the Selected section. A separator is the divider between the
toolbar buttons and the navigation pane.

Resets the toolbar to the default settings.

5. (Optional) If you want to include custom JavaScript in the toolbar, click Edit in the area to the
right. This opens the Toolbar JavaScript dialog, which you can use to enter or load custom
JavaScript for the toolbar.

For example, the following command opens the MadCap Software website when a user clicks
the button:

function MyFunction()
{
window.open("http://www.madcapsoftware.com");
}

6. Click to save your work.

NOTE You can also specify which buttons should be included in the navigation toolbar at
the top of the CHM window.

NOTE You can also add a web toolbar that is displayed within topic content. This can be
done with the help of a topic toolbar proxy.
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Topic Toolbars in WebHelp Outputs
Supported In:

IMPORTANT WebHelp and WebHelp Plus are deprecated in Flare, which means that they
are slated to be removed in a future version.

In addition to the regular web toolbars that can be included in all most online outputs, you have
another option for including toolbars. This option lets you insert toolbars anywhere in any topics.
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How to Specify Topic Toolbar Settings in a Standard
Skin

1. Open a Standard skin.

2. Select the Topic Toolbar tab.

3. Select options to include specific features (buttons) in the toolbar. Items that will be included
in the toolbar are displayed in the Selected section on the right. Items that will not be included
in the toolbar are displayed in the Available section on the left. You can use the right arrow
button to move items from the Available section to the Selected section.

Following are descriptions of the various items.
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ADD TOPIC TO FAVORITES

Lets users add the active topic to the Favorites pane so that they can quickly access the topic
in the future.

BACK

Lets users open the topic that was viewed previously.

COLLAPSE ALL

Lets users collapse all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are expanded).
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CURRENT TOPIC INDEX

Lets users see the display for the current topic in the sequence. This is typically used in
conjunction with the "Next Topic" and "Previous Topic" buttons when the topic in question
exists in a browse sequence. Flare finds the current topic in a browse sequence and display
its position in relation to the rest of the topics in that sequence. (The root node is used to
determine the count; in other words, if there are "child" topics in the sequence structure under
the current topic, they will be included in the count.)

EXPAND ALL

Lets users expand all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are not yet expanded).

FORWARD

Lets users open the next topic in a previously viewed sequence.
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HOME

Lets users open a designated home page (such as your company's website)

NEXT TOPIC

Lets users open the next topic in the output. If you are using a browse sequence, Flare
attempts to find the current topic in a browse sequence and navigate to the next topic from
there. If you are using HTML5 Side Navigation, Top Navigation, or skinless output, or if you
are not using a browse sequence, Flare looks at the position of the current topic in your table
of contents (TOC) and opens the next topic after it.

PREVIOUS TOPIC

Lets users open the previous topic in the output. If you are using a browse sequence, Flare
attempts to find the current topic in a browse sequence and navigate to the previous topic
from there. If you are using HTML5 Side Navigation, Top Navigation, or skinless output, or if
you are not using a browse sequence, Flare looks at the position of the current topic in your
table of contents (TOC) and opens the previous topic before it.
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PRINT

Lets users open the Print dialog so that they can send the open topic to the printer.

QUICK SEARCH

Lets users initiate a search in the active topic for the word or phrase that has been typed in
the field next to the button.

REFRESH

Lets users update the content of the topic being viewed.

REMOVE HIGHLIGHT

After a user performs a quick search in a topic, the search text found in the topic is
highlighted. This button lets users turn the highlights off.
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SELECT BROWSE SEQUENCE

Lets users open the Browse Sequence feature.

SELECT COMMUNITY

Lets users access their Pulse community features, if the are using MadCap Pulse.

SELECT FAVORITES

Lets users open the Favorites feature.

SELECT GLOSSARY

Lets users open the Glossary feature.
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SELECT INDEX

Lets users open the Index feature.

SELECT SEARCH

Lets users open the Search feature.

SELECT TOC

Lets users open the TOC feature.

STOP

Lets users prevent a page from downloading file information.
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TOGGLE NAVIGATION PANE

Lets users toggle between hiding and showing the navigation pane in the output window.

4. (Optional) You can use the buttons at the bottom of the tab to perform additional tasks.

Opens the New Toolbar Button dialog, which lets you add a custom button to
the toolbar. After creating the custom button, select it and click to move it to
the Selected section.

Unless you specify otherwise, in the output the new button will display the text
for the name you gave it. However, you can change this by editing the control
type for the new button. To do this, you can select the Styles tab in the Skin
Editor, expand the Toolbar Item node, select one of the styles listed above,
expand the Type property group, and from the Control Type field select Button.
To choose an image for the button, expand the General property group on the
Styles tab and select image files in the Icon fields.

If you want to provide a command for the custom button (e.g., so that clicking
the button opens a website), you can select the Styles tab in the Skin Editor,
expand the Toolbar Item node, select one of the styles listed above, expand the
Type property group, and enter a command in the OnClick field. For example,
the following command opens the MadCap Software website when a user
clicks the button:

window.open("http://www.madcapsoftware.com");

Alternatively, you can use the JavaScript area on the Topic Toolbar tab to enter
a command for the button. See the next step.

Removes the selected custom button from the Available section.
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Moves the selected item up in the order in the Selected section. In the output,
buttons are displayed left to right according to the order in which they appear
on this tab, with the item at the top being the first button shown on the left in
the output.

Moves the selected item down in the order in the Selected section.

Removes the selected item(s) from the Selected section.

Adds a separator to the Selected section. A separator is the divider between the
toolbar buttons and the navigation pane.

Resets the toolbar to the default settings.

5. (Optional) If you want to include custom JavaScript in the toolbar, click Edit in the area to the
right. This opens the Toolbar JavaScript dialog, which you can use to enter or load custom
JavaScript for the toolbar.

For example, the following command opens the MadCap Software website when a user clicks
the button:

function MyFunction()
{
window.open("http://www.madcapsoftware.com");
}

6. Click to save your work.
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eLearning Toolbars
An eLearning course should be easy to follow from beginning to end. The eLearning Toolbar proxy
lets you include intuitive navigation buttons and controls in your course. These might be a Next and
Previous button, or a progress bar. When you build HTML5 output, the proxy content is replaced
with the generated navigation tools.

How to Add the eLearning Toolbar Proxy to a
Template Page
To get the navigation tools to display in the output, the eLearning Toolbar proxy needs to be added
to a template page. The proxy is a placeholder to generate the eLearning toolbar in the output. The
proxy will show up in all the topics where the template page is applied.

1. From the Content Explorer, expand Resources > TemplatePages. This is the default location
for template pages. However, you might keep yours in a different location. Open the template
page applicable to the course topics (e.g., Other-Topics.flmsp).

2. Place your cursor at the location in the template page where you want to add a proxy (e.g.,
after other proxies).

NOTE Most template pages include a Topic Body proxy. If the Topic Body proxy is
not included, insert it from the Insert ribbon, Proxy > Body Proxy. This proxy is
required as it is the body content placeholder for each of the topics used in the
output.
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3. From the eLearning ribbon, select eLearning Toolbar Proxy. Alternatively, from the Insert
ribbon, select the Proxy drop-down, and choose eLearning Toolbar Proxy.

4. In the eLearning Toolbar Proxy dialog, from the Skin File drop-down, you can select a
customized eLearning Toolbar skin component. If you leave the default setting, the first
eLearning Toolbar skin component in the project will be used. Click OK.

NOTE If you have not created a skin component to associate with the proxy, you can
always come back to the inserted proxy later and edit it once the skin component is
created.

5. Click to save your work.

What’s Next?
Now that the proxy is in place, you need to select which navigation tools you want to include in your
output. This is done in the eLearning skin component.
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Adding an eLearning Toolbar Skin Component
The eLearning skin component contains information that dictates the general appearance for the
course. You can choose which navigation buttons and controls to use, and customize how they
display in the output.

How to Add the eLearning Toolbar Skin
1. From the Project Organizer, right-click the Skins folder, and select Add Skin.

2. From the Add File dialog, expand Factory Templates, and select HTML5 Component –
eLearning Toolbar. Give it a file name (e.g., eLearning), and click Add.
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3. In the Skin Editor, from the Setup tab, determine which toolbar buttons you want to display in
your test. By default, the toolbar buttons are: PreviousTopic, NextTopic, and ProgressBar.

You can use the local toolbar to add, delete, and reorder the toolbar buttons.

4. Click to save your work.
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CHAPTER 19

Topic Popups
Supported In:

NOTE This feature is supported in HTML5 Tripane and skinless output, but not in HTML5
Side Navigation or Top Navigation output.

A topic popup is a text hyperlink that opens a topic or external file (such as a website) in a popup
box.

This chapter discusses the following:

Inserting Topic Popups 354

Editing Topic Popups 358

Customizing the Size of Topic Popups 365
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Inserting Topic Popups
Inserting topic popups requires only a few simple steps

How to Insert a Topic Popup
1. Open the content file.

2. In the XML Editor, highlight the text that you want to use as the link (or "hotspot") for the topic
popup.

3. Select Insert > Hyperlink > Topic Popup.

The Insert Topic Popup dialog opens. The Target Frame field at the bottom of the dialog
already has Popup Window selected.

4. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based on the option you choose, the section below gives you a list of
selections or additional fields to complete.

FILE IN PROJECT 

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

CHAPTER 19  354



If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 11.

You can also select if you have selected a PDF file. See "Named Destinations" on page
155.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click to display and select any bookmarks within the destination file, or if
you have selected a PDF file. See "Inserting Bookmarks" on page 11 and "Named
Destinations" on page 155.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 109.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.
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WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).

HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

n Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show Folders
button is selected, the area splits into two. The folder is shown on
the left side, and the files and subfolders within it are shown on the right.

n Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

5. (Optional) The Link Text field displays the text that you highlighted in the topic, which will be
used as the hyperlink. Leave the text as it is, unless you decide you would like to change it. If
you want to change the link text, type the new text in the field. It will replace the previous text
in the topic.
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6. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output.

7. (Optional) Next to the Style Class or Style ID field click . This opens the Select Class dialog,
which lets you apply a CSS style or a style ID to a link. Generic classes and IDs are also
available for selection in this dialog. You can change the appearance of the link in the
Stylesheet Editor. After you select a style class in the dialog, click OK. If you selected a class,
it appears in the Style Class field, and if you selected an ID, it appears in the Style ID field. (If
you do not specify a style class, Flare uses the parent "a.Popup" style class.)

8. In the Target Frame field, leave Popup Window as the selection.

9. Click OK. The hyperlink for the topic popup is added to the topic. You can change the
appearance of the link by modifying the a.Popup style in the Stylesheet Editor. This includes
the ability to change the size of the popup. See "Editing Topic Popups" on the next page and
"Customizing the Size of Topic Popups" on page 365.

10. Click to save your work.
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Editing Topic Popups
You can edit topic popups that you have inserted into a topic in at least three different ways: (1) edit
the destination and properties of the topic popup, (2) edit the style of the topic popup, and (3)
unbind (or remove) the hyperlink from the topic popup.

How to Edit the Destination and Properties of a
Topic Popup
The first way to edit topic popups is to change the destination and other properties (link text, target
frame, screen tip).

EXAMPLE You test the topic containing the popup and you notice that the wrong
destination topic is opening when you click the hyperlink. So you use the steps below to
associate the correct destination topic with the hyperlink.

1. Open the content file.

2. In the XML Editor, click inside the link.

3. At the top of the XML Editor, right-click the span bar representing the link. For example,
hyperlink span bars have an "a" label, and cross-reference span bars have a "MadCap:xref"
label. When you click on the link in the topic, the appropriate span bar at the top of the XML
Editor will change color to indicate that it goes with the link. If your span bars are not turned
on, click in the local toolbar of the XML Editor.

4. Select Edit Hyperlink. The Insert Topic Popup dialog opens.

5. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based the option you choose, the section below gives you a list of selections
or additional fields to complete.
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FILE IN PROJECT 

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 11.

You can also select if you have selected a PDF file. See "Named Destinations" on page
155.
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EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click to display and select any bookmarks within the destination file, or if
you have selected a PDF file. See "Inserting Bookmarks" on page 11 and "Named
Destinations" on page 155.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 109.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

n Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show Folders
button is selected, the area splits into two. The folder is shown on
the left side, and the files and subfolders within it are shown on the right.

n Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click . In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

6. (Optional) The Link text field displays the text that you highlighted in the topic, to be used as
the hyperlink. Leave the text as it is, unless you decide to change it. If you want to change the
link text, type the new text in the field.

7. (Optional) In the Screen Tip field, you can type a phrase to appear when the end user hovers
over the hyperlink in the output.

8. (Optional) Next to the Style Class field, click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles from your stylesheet to the
link. After you select a style class, click OK. (If you do not specify a style class, Flare uses the
"a.Popup" style class.)

9. In the Target Frame field, leave Popup Window as the selection.

10. Click OK. The hyperlink for the topic popup is added. By default it has a blue, underlined font.
You can change its appearance by editing the style.

11. Click to save your work.
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How to Edit the Style of a Topic Popup Hyperlink
You can edit the style (e.g., font, color) of the hyperlink for a topic popup. When you do this, the style
changes for all topic popups in any topics in your project.

EXAMPLE You want to change the font for your topic popups to dark green with no
underline. The following steps show you how to accomplish this.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. On the left side of the editor, find and select the a.Popup tag.
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5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

9. Click to save your work.
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How to Unbind or Remove the Topic Popup
Hyperlink
The third way to edit a topic popup is to unbind (or remove) the hyperlink effect. If you decide that
you no longer want the content to serve as a hyperlink, you can use the steps below to remove the
hyperlink, converting the content to regular text.

1. Open the content file.

2. In the XML Editor, click inside the link.

3. At the top of the XML Editor, right-click the span bar representing the link. For example,
hyperlink span bars have an "a" label, and cross-reference span bars have a "MadCap:xref"
label. When you click on the link in the topic, the appropriate span bar at the top of the XML
Editor will change color to indicate that it goes with the link. If your span bars are not turned
on, click in the local toolbar of the XML Editor.

4. Select Unbind. The hyperlink effect is removed.

5. Click to save your work.
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Customizing the Size of Topic Popups
If you insert a topic popup link, the popup displays in a default window size in the output (after the
link is clicked). However, you can adjust the style to specify a custom size for the popup box. You
can do this by selecting the a.Popup style class and changing the values for the mc-popup-width
and mc-popup-height properties (located in the Unclassified property group).

How to Customize the Size of Topic Popups
1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. In the Styles section on the left side of the editor, find and select the a.Popup style class.

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. From the Properties section, click to the right of mc-popup-width or mc-popup-height.
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7. In the top-right corner of the popup (next to "Automatic"), click the down arrow and select
Length.

8. In the lower-left field, enter a number.

9. In the lower-right field, click the down arrow and select a unit of measurement.

10. In the popup box, click OK.

11. Click to save your work.
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CHAPTER 20

Hotspots and Dynamic Effects
Supported In:

A hotspot is the part of an element that you click to make it do something (e.g., open another topic,
open a popup, expand text). For some navigation features—such as cross-references and
hyperlinks—the entire element is a hotspot. For dynamic effects—drop-down text, expanding text,
togglers, and popups—only part of the effect is a hotspot. For features such as this, you can use
styles to change the hotspot portion of the element.

Hotspot Styles

MadCap|dropDownHotspot

Modifies the specific text that you select in the first paragraph of a drop-down effect to serve as the
link for opening the drop-down body. If you do not select specific text in the first paragraph to serve
as the hotspot, the entire first paragraph is used as the hotspot.

MadCap|expandingHead

Modifies the hotspot portion of an expanding text effect.

MadCap|popupHead

Modifies the hotspot portion of a popup text effect.

MadCap|toggler

Modifies the hotspot portion of a toggler.
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CHAPTER 21

Viewing and Fixing Links
In Flare there are many ways that you can link one file with another, thus creating a dependency.
Link dependencies are created when you perform tasks such as: inserting a text hyperlink, inserting
an image, applying a stylesheet to a topic, and more. The Link Viewer window pane lets you see
what other files a particular file is linked to and from.

Whenever you want to view links to and from a file, you simply need to open the Link Viewer window
pane and give focus to the file in question. Following are two ways to do this:

n Select View > Link Viewer. The Link Viewer window pane opens by default on the right side of
the workspace. Next, open a file (e.g., topic, stylesheet, table of contents). As long as that file
has focus (e.g., click in it), the related links are shown in the Link Viewer window pane.

n In one of the window panes containing files (e.g., Content Explorer, Project Organizer, File List
window pane), right-click on a file and from the context menu select View Links. If it's not
already open, the Link Viewer window pane opens by default on the right side of the
workspace, showing the related links.

NOTE Whenever you switch focus to another file (i.e., open it and click on it), the links in the
Link Viewer window pane change accordingly.

This chapter discusses the following:

Incoming Links From Other Files 370

Outgoing Links to Other Files 371

Targets Linked to a File 372

Lock Window Pane 373
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Refresh 373

Go to Previous and Next 373

View Broken Links 374

Viewing Broken Links 375

Viewing Broken Bookmarks 377
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Incoming Links From Other Files
This shows links from other files to the active file.

EXAMPLE You have a topic called "Getting Started" and in another topic you have inserted
a hyperlink to it. Unfortunately, you cannot remember exactly which topic. Furthermore,
you've made changes to the Getting Started topic, so you want to see if any other topics
linking to it also require modifications as a result. Therefore, you open the Link Viewer
window pane. You then open the Getting Started topic. Because that topic is the file
containing focus, the Link Viewer window pane provides a list of all the files with links to it.
Not only can you see a list of files with links to the Getting Started topic, but you can
double-click each file to open it and work on it.
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Outgoing Links to Other Files
This shows links to other files from the active file.

EXAMPLE You have a topic called "Getting Started," which contains a snippet, which you
want to edit. One way to edit the snippet file is to go look for it in the Content Explorer and
double-click it. That method can take a lot of time if you have hundreds of snippets.
Another method is to right-click on the snippet within the topic and select Open Snippet
File. But another quick method is to use the Link Viewer window pane, which not only lets
you open the snippet quickly, but also see the file name of the snippet and other linked files
at a glance. Therefore, you open the Link Viewer window pane. You then open the Getting
Started topic. Because that topic is the file containing focus (i.e., it's the most recent file
you've opened or clicked in), the Link Viewer window pane provides you with a list of all the
other files linked from it.
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Targets Linked to a File
You can see which targets are associated with the file that has focus. This is useful, for example,
because it lets you know which outputs will be affected when you make changes to that file. The
link to the target might be direct (e.g., the active file is a topic that is included in the table of
contents for a target) or indirect (e.g., the active file is a snippet that has been inserted into a topic
that is included in the table of contents for a target).

EXAMPLE You have a topic called "Getting Started" and you need to make many changes
to it. After you are finished making your changes, you need to make sure your work looks
correct in each output. Unfortunately, you cannot remember which of your outputs (i.e.,
targets) includes that topic. Therefore, you open the Link Viewer window pane. You then
open the Getting Started topic. Because that topic is the file containing focus (i.e., it's the
most recent file you've opened or clicked in), the Link Viewer window pane provides you
with a list of all the targets that will include the topic when output is generated. You can
then keep the Link Viewer open as a reference while you generate and view each of those
targets.
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Lock Window Pane
Normally when you click in a different file, giving it focus, the links for that file are shown in the Link
Viewer window pane. However, there may be times when you want a previous set of links to
continue to show in the Link Viewer, even when you click in other files. In that case, you can lock the
Link Viewer by clicking the Lock button in the local toolbar. To unlock the window pane, click the
button again.

Refresh
You can click in the local toolbar to refresh the Link Viewer window pane at any time. This
ensures you are seeing the most up-to-date links for the active file.

EXAMPLE You are using the Link Viewer window pane to see the links for a topic. While
doing this, suppose you decide to delete one of the targets in your project, and that target is
linked to the topic file. After the file is deleted, it still is shown in the Link Viewer window
pane. But if you click the Refresh button, the window pane no longer shows that file link.

Go to Previous and Next
If you have been viewing links for multiple files, the Link Viewer window pane remembers those files
and their links. You can click the Previous or Next buttons in the local toolbar to see file links
that you have already viewed.
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View Broken Links
If the active file contains broken links, this will be indicated by a broken link icon in the Link Viewer
window pane.

EXAMPLE The active file contains a hyperlink to another file, but the link is broken. In that
case, you will see something like this in the Link Viewer window pane:
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Viewing Broken Links
You can view a list of files in your project where a broken link is located, including which file it is
trying to find, the link text, the link tag, and other information. Also, you can open the file where the
broken link is located. The broken link is highlighted so that you can easily fix it. 

How to View and Fix Broken Links
1. From the Analysis ribbon, click the Summary button.

2. If you see a row indicating broken links in red, double-click it.

3. In the grid listing all broken links, double-click one.

4. In the file that opens, the broken link is highlighted.

5. Edit the broken link or remove it.

6. Click to save your work.
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How to Fix Links Directly in the Broken Links
Window Pane

1. In the Broken Links window pane, click the row that you want to correct, then click . The Fix
Broken Links dialog opens.

2. In the Fix Broken Links dialog, do one of the following.

n Click or right-click a file and from the context menu, select Select file for linking. This
option opens a dialog, from which you can select a new link.

n Click or right-click a file and from the context menu, select Scan for Potential Links.
This option scans the project for potential matches to the broken link. When this option
is selected, the Search for Similar Files dialog opens, which lists the similar files that
the analysis tool has found. You can then select a file from that list.

The name of the file you select to fix the broken link will be displayed in the File field at the
bottom of the Fix Broken Links dialog.

3. Click Apply.
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Viewing Broken Bookmarks
You can view a list of files with broken bookmarks, including the bookmark destination that the link
is trying to find, the link text, the link tag, and other information. Also, you can open the file where
the broken link is located so that you can fix it. 

How to View and Fix Broken Bookmarks
1. Open a content file (e.g., topic).

2. Select Analysis > Links > Broken Bookmarks.

The Broken Bookmarks window pane opens. The area at the bottom of the window pane
displays all files that contain bookmark links to the open file that are broken.

3. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

n File Displays the name of the file where the broken link occurs.

n Folder Displays the folder where the file is found.

n Link Displays the link that is broken (e.g., the path and name of the topic in question).

n Type Displays the type of broken link (e.g., missing file).

n Link Text Displays the text in the source topic that is being used as the link.

n Link Tag Displays the style used for the link. For example, if a regular text hyperlink is
used, you will see "a" in this column.

n Extension Displays the file extension that the link is not finding (e.g., .htm, .jpg).

4. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.

5. Double-click the row that you want to correct. The file opens in the appropriate editor or
dialog. For example, if the link appears in a topic, the XML Editor opens with the broken link
highlighted.

6. Redirect the link as necessary (e.g., right-click on the link and select Edit Hyperlink or Edit
Cross-Reference).
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

Tutorials
Getting Started Tutorial

Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

MadCap Central Integration
Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide
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